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ÚVOD

INSTALACE
Windows

Instalace
Spuštění	MuseScore
Odinstalování

Mac	OS	X
Instalace
Odinstalování

Linux
Fedora

Podívejte	se	také	na

VYTVOŘENÍ	NOVÉHO	NOTOVÉHO	ZÁPISU
Zahajovací	středisko
Vytvoření	nového	notového	zápisu
Název,	skladatel	a	další	informace
Nástroje	a	hlasy
Přidání	notové	osnovy	k	nástroji
Výběr	předznamenání	a	tempa
Druh	taktu,	předtaktí	a	počet	taktů
Úpravy	notového	zápisu	po	jeho	vytvoření
Předlohy
Podívejte	se	také	na
Vnější	odkazy

NASTAVENÍ	JAZYKA	A	AKTUALIZACE	PŘEKLADŮ
Změna	jazyka
Aktualizace	překladu
Podívejte	se	také	na

KONTROLA	AKTUALIZACÍ
Automatické	zjištění	možnosti	aktualizace
Zkontrolování	aktualizace
Podívejte	se	také	na

ZÁKLADY

VKLÁDÁNÍ	NOT
Jednoduché	vkládání	not

Krok	1:	Začáteční	poloha
Krok	2:	Režim	vkládání	not
Krok	3:	Délka	noty	(nebo	pomlky)
Krok	4:	Zadání	výšky	tónu
Jiné	klávesové	zkratky

Zařízení	MIDI
Barvení	not	mimo	zobrazený	rozsah	tónů
Malé	noty
Vlastnosti	not
Změna	výšek	not	(bez	změny	rytmu)
Podívejte	se	také	na
Vnější	odkazy

VE	ZNĚJÍCÍ	VÝŠCE
Podívejte	se	také	na

KOPÍROVÁNÍ	A	VKLÁDÁNÍ
Kopírování
Vkládání
Rychlé	zopakování
Filtr	výběru
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Podívejte	se	také	na
Vnější	odkazy

REŽIM	ÚPRAV
Podívejte	se	také	na

OPERACE	S	TAKTY
Připojení
Vložení
Smazání
Vlastnosti

Notové	osnovy
Doba	trvání	taktu
Jiné

Číslování
Rozdělení	a	spojení
Podívejte	se	také	na

PALETY
Přidání	symbolů	do	not
Pokročilé	a	jednoduché	palety
Jiné	hudební	symboly
Upravení	palety
Podívejte	se	také	na

NASTAVENÍ
Obecné
Povrch
Vkládání	not
Noty
Vstup/Výstup
Zavedení
Vyvedení
Zkratky
Aktualizace
Podívejte	se	také	na

UKLÁDÁNÍ	A	TISK
Nabídka	Soubor

Formáty	v	nabídce	'Uložit',	'Uložit	jako...',	'Uložit	kopii...',	'Uložit	výběr...'	a	'Uložit	na	internet...'
Formáty	v	nabídce	'Vyvést'	a	'Vyvést	výtahy	hlasů'
Tisk

Podívejte	se	také	na

VÝBĚROVÉ	REŽIMY
Výběr	jednoho	předmětu
Výběr	rozsahu
Výběr	různých	nikoli	po	sobě	jdoucích	předmětů
Výběr	všech	stejných	prvků
Jak	se	používají
Podívejte	se	také	na

ZPĚT	A	ZNOVU

POHLEDY
Pohled	na	stranu/Souvislý	pohled

Pohled	na	stranu
Souvislý	pohled

Zvětšení
Ukázání	více	než	jednoho	notového	zápisu
Celá	obrazovka
Pohyb	v	notách
Podívejte	se	také	na
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SOUBOROVÝ	FORMÁT
Vlastní	formát	MuseScore

Formát	MuseScore	(*.mscz)
Nezabalený	formát	MuseScore	(*.mscx)

Záložní	soubory	MuseScore
Záložní	soubor	MuseScore	(*.mscz,	nebo	*.mscx,)

Tisk	a	čtení	(pouze	vyvedení)
PDF	(*.pdf)
PNG	(*.png)
SVG	(*.svg)

Poslech	(pouze	vyvedení)
WAV	audio	(*.wav)
FLAC	audio	(*.flac)
Ogg	Vorbis	(*.ogg)
MP3	(*.mp3)

Sdílení	s	dalšími	hudebními	programy
MusicXML	(*.xml)
Komprimovaný	MusicXML	(*.mxl)
MIDI	(*.mid,	*.midi,	*.kar)
MuseData	(*.md)	(pouze	zavedení)
Capella	(*.cap,	*.capx)	(pouze	zavedení)
Bagpipe	Music	Writer	(*.bww)	(pouze	zavedení)
BB	(*.mgu,	*.sgu)	(pouze	zavedení)
Overture	(*.ove)	(pouze	zavedení)
Guitar	Pro	(*.GTP,	*.GP3,	*.GP4,	*.GP5,	*.GPX)	(pouze	zavedení)

Podívejte	se	také	na

SDÍLENÍ	NOT	PO	INTERNETU
Vytvoření	účtu
Sdílení	notového	zápisu	přímo	z	MuseScore
Nahrání	notového	zápisu	na	MuseScore.com
Upravení	notového	zápisu	na	MuseScore.com
Podívejte	se	také	na

NOTOVÝ	ZÁPIS

POSUVKY
Přepočítání	posuvek
Podívejte	se	také	na
Vnější	odkazy

ARPEGGIO	A	GLISSANDO
Vnější	odkazy

TAKTOVÉ	ČÁRY
Změna	typu	taktové	čáry
Vytvoření	systému
Podívejte	se	také	na

TRÁMCE
Podívejte	se	také	na

ZÁVORKY
Smazání
Přidání
Změnění
Upravení
Vodorovný	posun

NÁDECHY	A	PŘESTÁVKY

KLÍČE
Přidání
Odstranění

NOTOVÝ	ZÁPIS	BUBNŮ
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Zařízení	MIDI
Klávesnice	počítače
Myš
Bicí	sada
Vnější	odkazy

OZDOBY
Pokyny
Vnější	odkazy

SVORKY

PŘEDZNAMENÁNÍ
Nahrazení	stávajícího	předznamenání
Přidání	nového	předznamenání
Odstranění	předznamenání
Upozornění	na	změnu	předznamenání
Odrážky	při	změně	předznamenání
Předznamenání	a	vícetaktové	pomlky
Upozornění	na	změnu	předznamenání	a	zalomení	úseku
Vlastní	předznamenání

LINKY
Změna	délky
Podívejte	se	také	na

POMLKY
Celotaktová	pomlka
Vícetaktová	pomlka

Poučení
Omezení

Zalomení	vícetaktových	pomlk

OPAKOVÁNÍ
Přehrávání
Symboly	opakování	a	text
Skoky
Podívejte	se	také	na
Vnější	odkazy

LEGATO
První	způsob
Druhý	způsob
Třetí	způsob
Úpravy
Tečkovaná/čárkovaná	čára
Podívejte	se	také	na

LIGATURA
První	způsob
Druhý	způsob
Spojené	akordy
Obrácení	ligatury

TAKTOVÁ	OZNAČENÍ
Vytvoření	vlastního	taktového	označení
Změna	výchozích	trámců
Smazání	taktového	označení
Úpravy	součtových	meter
Doby	trvání	rozdílné	od	taktového	označení:	Předtaktí	a	kadence
Místní	taktová	označení
Změny	taktového	označení	a	jiné	předměty
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Podívejte	se	také	na

TRANSPOZICE
Chromatická	transpozice	k	tónině
Chromatická	transpozice	o	interval
Stupnicová	(diatonická)	transpozice
Transponující	nástroje
Podívejte	se	také	na

TREMOLO

NEPRAVIDELNÉ	RYTMICKÉ	SKUPINY
Pokyny
Režim	vkládání	not
Vlastnosti
Styl
Podívejte	se	také	na
Vnější	odkazy

HLASY
Kdy	jsou	potřeba	hlasy
Pokyny
Skryté	pomlky	(držitel	místa)
Výměna	hlasů	not
Podívejte	se	také	na
Vnější	odkazy

VOLTA
Text
Přehrávání
Vnější	odkazy

ZVUK	A	PŘEHRÁVÁNÍ

ZAVEDENÍ	MIDI
Dostupné	činnosti

ZMĚNA	NÁSTROJE	UPROSTŘED	NOTOVÉ	OSNOVY
Vložení	změny	nástroje	uprostřed	notové	osnovy

REŽIM	PŘEHRÁVÁNÍ
Přehrávací	panel
Počítání
Přehrávání	metronomu
Smyčka

ZVUKOVÁ	BANKA
Přehled
Seznam	zvukových	bank

Specializované	zvukové	banky
Komprese
Nastavení	MuseScore
Řešení	potíží
Podívejte	se	také	na

SWING
Zřízení	swingu
Nastavení	swingu
Vypnutí	swingu
Vlastnosti	textu
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105

TEMPO
Označení	tempa
Přehrávací	panel
Podívejte	se	také	na

DYNAMIKA
Označení	dynamiky

Upravení	hlasitosti	přehrávání	pro	označení	dynamiky
Přehrávací	panel
Vnější	odkazy

ZMĚNA	A	ÚPRAVY	ZVUKU
Směšovač

Ztlumení	a	sólo
Kruhové	stupnice
Zvuk

Změna	nástroje
Změna	tónu	v	díle
Podívejte	se	také	na

TEXT

POHYB	ZNAČEK	A	TEXTU	OSNOVY	ZALOŽENÝ	NA	MŘÍŽCE

ORIENTAČNÍ	ZNAČKY
Vytvoření	orientačních	značek
Vlastnosti
Automatická	další	orientační	značka
Hledání	orientační	značky
Podívejte	se	také	na

ÚPRAVY	TEXTU
Symboly	a	zvláštní	znaky
Podívejte	se	také	na

STYL	TEXTU
Vlastnosti	textu:
Typy	textu:
Vytvoření	nového	stylu	textu
Volby	pro	použití
Volba	pro	opětovné	nastavení	stylu
Podívejte	se	také	na

ZNAČKY	AKORDŮ
Skladba	značek	akordů
Styl	značek	akordů

Vzhled
Psaní	not
Umísťování

Podívejte	se	také	na

PRSTOKLAD
Podívejte	se	také	na

TEXT	PÍSNĚ
Zvláštní	znaky
Podívejte	se	také	na
Vnější	odkazy

FORMÁTOVÁNÍ

ROZVRŽENÍ	A	FORMÁTOVÁNÍ
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130

130

130
130
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131
131
132
132
133

Cesty,	jak	ovlivnit	rozvržení
Rozvržení	→	Nastavení	strany...
Rozvržení	→	Zvětšit	natažení,	Zmenšit	natažení
Styl	→	Obecné...	→	Notový	zápis
Styl	→	Obecné...	→	Strana
Styl	→	Obecné...	→	Záhlaví,	zápatí,	čísla
Styl	→	Obecné...	→	Osnova
Styl	→	Obecné...	→	Takt
Styl	→	Obecné...	→	Taktové	čáry
Paleta	→	Breaks	&	Spacers
Styl	→	Obecné...	→	Noty
Styl	→	Obecné..	→	Klíče
Styl	→	Obecné...	→	Arpeggia
Styl	→	Obecné...	→	Trámce
Styl	→	Obecné...	→	Legata/Ligatury
Styl	→	Obecné...	→	Velikosti
Styl	→	Obecné...	→	Svorky,	volta,	oktáva
Styl	→	Obecné...	→	Pedál,	trylek
Styl	→	Obecné...	→	Značky	akordů,	nákresy	hmatníku
Styl	→	Obecné...	→	Číslovaný	bas
Styl	→	Obecné...	→	Artikulace,	ozdoby
Styl	→	Obecné...	→	Posuvky
Styl	→	Obecné...	→	Rytmické	notové	skupiny
Edit	spacing	between	individual	notes
Tlačítko	Použít	a	OK
Apply	to	all	parts	in	one	go
Save	and	Load	style
See	also
External	links

ZALOMENÍ	A	ODSTUP
Přidání	zalomení	nebo	vymezení	odstupu
Smazání	zalomení	nebo	vymezení	odstupu
Zalomení	úseku
Podívejte	se	také	na

RÁMEČKY
Vodorovný
Svislý
Vytvoření	rámečku
Smazání	rámečku
Upravení	rámečku
Podívejte	se	také	na
Vnější	odkazy

OBRÁZKY
Podívejte	se	také	na

ZACHYTÁVÁNÍ	OBRÁZKŮ
Podívejte	se	také	na

POKROČILÁ	TÉMATA

ALBUM
Print	Album
Join	Scores

FUNKCE	PRO	STAROU	HUDBU
Unbarred	notation
Mensurstrich
Ambitus
Mensural	time	signatures
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146
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148
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149
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149

150
150

See	also

HLAVNÍ	PALETA
See	also

INFORMACE	O	NOTOVÉM	ZÁPISU
Preexisting	meta	tags
Modify	a	meta	tag
Add	a	new	meta	tag
Header/Footer
See	also

NAHRAZENÍ	VÝŠEK	TÓNŮ	BEZ	ZMĚNY	RYTMŮ
See	also

NÁKRES	HMATNÍKU
Adding	a	Fretboard	diagram,	with	barré

POMŮCKY
Přidat/Odstranit	zalomení	notových	systémů
Rozdělit	hlasy/Sloučit	hlasy

Rozdělit	hlasy
Sloučit	hlasy

Vyplnit	lomítky
Zapnout/Vypnout	rytmickou	notaci
Seřadit	orientační	značky
Podívejte	se	také	na

PŘÍDAVNÉ	MODULY
Installation

Windows
Mac	OS	X
Linux

Enable/disable	plugins
Create/edit/run	plugins
Plugins	installed	by	default

ABC	Import
Break	Every	X	Measures
Notes	→	Color	Notes
Create	Score
helloQml
Notes	→	Note	Names
panel
random
random2
run
scorelist
ScoreView
Walk
Tools

SPRÁVCE	A	VLASTNOSTI	PŘEDMĚTŮ
Inspector

Categories
Properties	(accessed	via	right-click)

Measure	properties
Staff	properties

See	also

TABULATURA
Creation

With	the	'New	Score'	wizard
By	changing	staff	type

Changing	instrument	string	data	(tuning)
Configuring	a	tablature

Multiple	staves
Inputting	new	notes
Editing	existing	notes
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165
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165
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168
168
169
169

170

170

171

171
171

171
171

Summary	of	keys
External	links

TRÁMCE	PŘES	OSNOVY
Podívejte	se	také	na

VLASTNOSTI	NOTOVÝCH	OSNOV
Background
How	to	get	there

Common	items
Standard	and	Percussion	staff	specific	items
Tablature	staff	specific	items

Fret	marks
Note	values
Preview

VLASTNÍ	PALETA
Palette	menu
See	also

VYTAŽENÍ	HLASŮ	SKLADBY
Setting	up	the	parts

Setup	all	parts	in	one	go
Exporting	the	parts
Saving

ZPŘÍSTUPNĚNÍ
Introduction
Initial	setup
Finding	your	way	around
The	score	window
Score	reading

Moving	forwards	or	backwards	in	time
Moving	between	notes	at	a	given	point	in	time
Filtering	score	reading

Score	playback
Score	editing
Customization

ČÍSLOVANÝ	BAS
Adding	a	new	figured	bass	indication
Text	format

Digits
Accidentals
Combined	shapes
Parentheses
Continuation	lines
Duration

Editing	existing	figured	basses
Style
Proper	syntax
Summary	of	keys

NOVÉ	VLASTNOSTI	V	MUSESCORE	2.0

PODÍVEJTE	SE	TAKÉ	NA

PODPORA

NAHLÁŠENÍ	CHYBY	NEBO	ŽÁDOST	O	PODPORU
See	also

NAVRÁCENÍ	K	TOVÁRNÍMU	NASTAVENÍ
Instructions	for	Windows
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177
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177
180

180
181
181
182

Instructions	for	Mac	OS	X
Instructions	for	Linux	(please	adapt	for	flavors	other	than	Ubuntu)
See	also

PŘEKLAD
Software	translation
Website	and	handbook	translation
See	also

ZNÁMÉ	POTÍŽE	S	VYBAVENÍM
Hardware	incompatibilities
Software	incompatibilities

AVG	Internet	Security	hangs	MuseScore
Font	problem	on	Mac	OS	X
Font	problem	on	Linux
Save	As	dialog	empty	on	Linux

DODATEK

KLÁVESOVÉ	ZKRATKY
Navigation
Note	input

Duration
Voices
Pitch
Interval

Direction
Articulations
Text	entry
Lyrics	entry
Display
See	also

ZNÁMÁ	OMEZENÍ	MUSESCORE	2.0
Basics

Save	Selection
Local	Time	Signatures

Note	input
Tablature	staff	linked	with	Standard	staff

Sound	and	playback
Instrument	change
Mixer

Layout
Header	&	Footer

SLOVNÍČEK
External	links

VOLBY	PRO	PŘÍKAZOVÝ	ŘÁDEK
Qt	Toolkit	Options
See	also
External	links
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Publikováno z MuseScore (https://musescore.org)

Tato příručka je pro MuseScore verze 2.0 a vyšší. Je udržována společenstvím MuseScore. Možnosti
přispění.

Úvod
Tato kapitola vám pomůže s instalací a spuštěním MuseScore. Kapitola vám také pomůže s
vytvořením nového notového zápisu.

Instalace

This translation is outdated, see the English version for a reference: Installation

MuseScore pracuje na mnoha různých počítačových systémech včetně Windows, Mac OS a Linuxu.

Windows

Instalace

Instalátor pro Windows získáte na stránce Stažení stránek MuseScore. Klepněte na odkaz pro
započetí stahování. Váš prohlížeč potvrdí, že chcete stahovat tento soubor. Klepněte na Uložit
soubor.

Po skončení stahování na soubor dvakrát klepněte pro zahájení instalace. Ve Windows se může
otevřít bezpečnostní okno žádající vás před spuštěním programu o potvrzení. Klepněte na Spustit,
chcete-li pokračovat. Krátce nato uvidíte:

následováno

12
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a pak

Pokud zde nebo později klepnete na Zrušit, uvidíte:

Pokud místo toho pro pokračování klepnete na Další, průvodce instalací zobrazí podmínky licence
svobodného software.
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Ujistěte se, chcete-li pokračovat, že je zaškrtnut souhlas s podmínkami licenčního ujednání, a pro
pokračování klepněte na Další. V dalším kroku dojde k potvrzení umístění, do kterého se má
MuseScore instalovat.

Pokud instalujete novější verzi MuseScore, ale chcete mít ve svém počítači i starší verzi, musíte
změnit složku (verze 2.0 a 1.x mohou být současně spolu a jedna druhou nepřepíše, takže v jejich
případě není třeba žádných změn). Jinak klepněte na Další pro pokračování.
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Klepněte na Instalovat pro pokračování.

Dejte průvodci instalací několik minut, aby nainstaloval nutné soubory a nastavení. Uvidíte

pak
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a konečně

Když je to hotovo, klepněte na Dokončit pro opuštění instalátoru. Pokud chcete, můžete nyní smazat
stažený instalační soubor.

Spuštění MuseScore

Pro spuštění MuseScore vyberte v nabídce Start → Všechny programy → MuseScore 2 → MuseScore 2.

Odinstalování

Na 32-bitových Windows odinstalaci provedete

    cd C:\Program Files\MuseScore
    Uninstall.exe /S

a na 64-bitových Windows pomocí
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    cd C:\Program Files (x86)\MuseScore
    Uninstall.exe /S

Mac OS X

Instalace

DMG soubor najdete na stránce Stažení stránek MuseScore. Klepněte na odkaz pro zahájení
stahování.

1. Táhněte ikonu MuseScore a upusťte ji na ikonu složky s programy. Pokud nejste přihlášen jako
správce systému, Mac OS X po vás bude požadovat heslo: Klepněte na Autentizovat a zadejte
své heslo, aby se mohlo pokračovat.

2. Nyní můžete MuseScore spustit přes nabídku s programy nebo, Spotlight, nebo Launchpad.

Odinstalování

Stačí, abyste MuseScore smazali ve složce s programy.

Linux

Podívejte se, prosím, na stránku Stažení , kde se nacházejí pokyny pro instalaci MuseScore v Linuxu.
Balíčky jsou poskytovány pro distribuce Debian, Ubuntu, Fedora a PCLinuxOS. Jiné distribuce,
například Mageia nebo openSUSE nebo Kubuntu, mohou vyžadovat sestavení programu ze
zdrojových souborů, mohou poskytovat balíčky vlastní, ať už v poslední verzi, nebo ve verzi starší, a
podobně. Na pokyny pro instalaci v distribuci Fedora se podívejte níže.

Fedora

1. Zaveďte klíč GPG:

su
rpm --import http://prereleases.musescore.org/linux/Fedora/RPM-GPG-KEY-Seve

2. Jděte na stránku Stažení stránek MuseScore. Klepněte na odkaz pro stažení do Fedory a
vyberte správný balíček rpm pro vaši architekturu.
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3. V závislosti na vaší architektuře použijte v režimu správce systému první nebo druhý příkaz pro
instalaci MuseScore

pro architekturu i386

su
yum localinstall musescore-X.Y-1.fc10.i386.rpm

pro architekturu x86_64

su
yum localinstall musescore-X.Y-1.fc10.x86_64.rpm

Pokud máte potíže se zvukem, podívejte se na Fedora 11 a zvuk

Podívejte se také na

Jak v MuseScore změnit jazyk
Jak MuseScore nainstalovat ve Windows bez správcovských práv
Jak MuseScore ve Windows spustit jako správce

Do you have an unanswered question? Post it in the forum.

Vytvoření nového notového zápisu
Ihned po spuštění MuseScore uvidíte Zahajovací středisko.

Zahajovací středisko

Můžete vybírat mezi volbami jako

Vytvoření nového notového zápisu (pomocí obrázku se znaménkem plus)
Otevřít předtím otevřený notový zápis (při prvním spuštění MuseScore otevřít návodný notový
zápis "Začínáme")
Otevřít stávající notový zápis ze souborového systému počítače
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Vidět notový zápis dne "ve středu pozornosti"
Hledat noty na musecore.com
Odkaz na mobilní aplikaci
Odkaz na sledování MuseScore na společenských sítích

Vytvoření nového notového zápisu

K vytvoření nového notového zápisu, když je zahajovací středisko otevřeno, vyberte Soubor → Nový...
nebo použijte klávesovou zkratku Ctrl+N (Mac: Cmd+N). Tím se spustí průvodce novým notovým
zápisem.

Název, skladatel a další informace

Zadejte název, skladatele a jakékoli další informace, jak je to ukázáno výše, klepněte na Další > a
uvidíte:
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Zde můžete zvolit předlohu, z níž se nový notový zápis vytvoří. Předlohy jsou mnohem podrobněji
rozebírány níže, ale pro teď vyberte "Vybrat nástroje", čímž přejdete k dalšímu kroku.

Nástroje a hlasy
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Okno s nástroji je rozděleno do dvou sloupců. První (levý) sloupec uvádí nástroje nebo hlasové party,
ze kterých si máte vybrat. Druhý (pravý) sloupec je zpočátku prázdný, ale brzy bude obsahovat
seznam nástrojů pro váš nový notový zápis.

Seznam nástrojů v prvním sloupci je roztříděn do skupin nástrojů. Pro zobrazení úplného seznamu
nástrojů v každé skupině na tuto dvakrát klepněte. Vyberte nástroj a klepněte na Přidat. Zvolený
nástroj se nyní objeví ve druhém sloupci. V případě že je to potřeba, můžete přidat více nástrojů nebo
hlasových partů.

Výchozí záznam je "Běžné nástroje", ale můžete vybírat i z jiných včetně "Jazzových nástrojů" a
"Staré hudby".

Také můžete napsat název nástroje do vyhledávacího pole, abyste jej vyfiltrovali ze "Všech nástrojů".

Typ osnovy je obvykle standardní (5 linek), ale některé nástroje mohou používat jiné druhy
(bubny/bicí, vybrnkávaná struna).

Pořadí nástrojů ve druhém sloupci určuje pořadí, v jakém se objeví v notovém zápisu. Pro změnu
pořadí klepněte na název nástroje a použijte pro jejich přesun výše nebo níže tlačítek Nahoru nebo
Dolů. Až budete hotovi, klepněte na Další >.

Přidání notové osnovy k nástroji

Volba Přidat se používá k vytvoření systému osnov, v němž jeden nástroj (jako klavír, harfa nebo
kytara atd.) používá více než jeden notový řádek.

Označte řádek osnovy ve vybraném seznamu nástrojů ve sloupci napravo (např. Osnova 1, viz
obrázek výše) a klepněte buď na Přidat notovou osnovu  nebo na Přidat zrcadlenou notovou osnovu .
První do zvýrazněného hlasu přidá náležitý řádek nepropojené osnovy (nezrcadlené); druhý přidá
příslušný řádek propojené osnovy (zrcadlené). Rozdíl je v tom, že obsah nepropojených osnov v
systému osnov lze měnit bez ovlivnění jiného prvku, avšak změny v propojené (zrcadlené) osnově
jsou automaticky přenášeny do jiné osnovy (např. dvojice zrcadlená osnova kytary/TAB — viz
Tabulatura).

Odstupy v systému osnov se dají ovládat přes nastavení Vzdálenost mezi spojenými osnovami.

Výběr předznamenání a tempa
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Průvodce se ptá na dvě věci: Počáteční předznamenání a tempo notového zápisu. Vyberte
předznamenání, jaké potřebujete, a klepněte na Další >, aby se pokračovalo dál. Počáteční tempo
zde lze nastavit také.

Druh taktu, předtaktí a počet taktů
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Zde můžete nastavit počáteční taktové označení. Pokud vaše dílo začíná předtaktím, potom
zaškrtněte okénko Předtaktí a upravte taktové označení předtaktí tak, aby vyjadřovalo skutečnou dobu
trvání prvního taktu (nastavení známé z nabídky souvisejících činností jako 'Vlastnosti taktu' jako
skutečná doba trvání).

Zde můžete zadat počet taktů, ale je možné je přidávat i později.

Klepněte na Dokončit pro vytvoření vašeho nového notového zápisu.

Úpravy notového zápisu po jeho vytvoření

Kterékoli nastavení zadané v průvodci novým notovým zápisem můžete změnit, a to i poté, co jste
začali s prací na notovém zápisu.

Pro přidání nebo smazání taktů nebo vytvoření předtaktí viz operace s takty

Pro změnu jakéhokoli textu viz úpravy textu. Pro přidání chybějícího názvu (nebo jiné textové
položky) použijte nabídku Přidání → Text → Název (nebo jiná textová položka)

Pro přidání, smazání nebo změnu pořadí nástrojů použijte nabídku Úpravy → Nástroje....

Předlohy

První obrazovka průvodce novým notovým zápisem obsahuje volbu Vytvořit nový notový zápis z
předlohy (viz část této kapitoly Název, skladatel a další informace výše, kde najdete podrobnosti). Pro
vytvoření notového zápisu pomocí tohoto postupu vyberte předlohu, kterou chcete použít.

Další obrazovka ukazuje seznam předloh. Vyberte předlohu a klepněte na Další >. Pokračujte a
dokončete průvodce novým notovým zápisem jako obvykle.
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Soubory s předlohami jsou běžné soubory MuseScore uložené ve složce s předlohami (systémová a
soukromá). Můžete vytvořit své vlastní předlohy, když uložíte soubory MuseScore do těchto umístění.

V operačním systému Windows je složka s předlohami obvykle uložena v C:\Program
Files\MuseScore 2\templates nebo v 64-bitové verzi v C:\Program Files (x86)\MuseScore
2\templates.

V operačním systému Linux se podívejte do /usr/share/mscore-xxx, pokud jste program nainstalovali
pomocí správce balíčků. Pokud jste v Linuxu program sestavili překladem zdrojových souborů, pak se
podívejte do /usr/local/share/mscore-xxx (xxx je používaná verze).

V operačním systému Mac od firmy Apple se podívejte do /Applications/MuseScore
2.app/Contents/Resources/templates.

Umístění svých soukromých předloh můžete nastavit v Úpravy → Nastavení... → General, MuseScore
bude ukazovat předlohy z obou umístění, systémového a neveřejného.

Podívejte se také na

Předznamenání
Taktová označení
Klíče
Tempo
Vlastnosti notových osnov

Vnější odkazy

Videonávod: MuseScore ve chvilce: Lekce 1 - Vytvoření notového zápisu

Create_new_score-Add_linked_staff_cs.png
Create_new_score-Add-instruments_cs.png
Create_new_score-Key_signature_cs.png
Create_new_score-Select_template_cs.png
Create_new_score-Time_signature_cs.png
Create_new_score-Title_cs.png
Start_center_cs.png

Do you have an unanswered question? Post it in the forum.

Nastavení jazyka a aktualizace překladů
MuseScore bude nainstalováno a bude pracovat s jazykem vašeho "systému" (používán pro většinu
programů a obecně závisející na nastaveních počítače pro zemi a jazyk, nebo účet).

Změna jazyka

1. Jděte do Úpravy → Nastavení... (Mac: MuseScore → Nastavení...)

2. Na kartě Obecné je část Jazyk:
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Jazyk můžete měnit a také aktualizovat pomocí tlačítka Aktualizovat překlady. Objeví se nové okno,
kde se váš jazyk ukáže nahoře - viz níže.

Jak je ukázáno, budete muset MuseScore ukončit a otevřít znovu, aby se změny a aktualizace
projevily.

Aktualizace překladu

Překlad lze, jak je vysvětleno výše, přes dialog Nastavení aktualizovat, ale je tu další způsob:

1. Jděte do Nápověda → Správce zdrojů

2. Klepněte na tlačítko Aktualizovat
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I zde budete MuseScore muset ukončit a otevřít znovu, aby se aktualizace projevila.

Podívejte se také na

Překlad

Resource_Manager-Resources_cs.png
Preferences-General_cs.png

Do you have an unanswered question? Post it in the forum.

Kontrola aktualizací
Jsou dva způsoby, jak ověřit dostupnost aktualizací.

Automatické zjištění možnosti aktualizace

1. Jděte do Úpravy → Nastavení... (Mac: MuseScore → Nastavení...)
2. Vyberte kartu Aktualizace

3. Podívat se po nové verzi MuseScore
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Nyní MuseScore provede kontrolu aktualizací při každém spuštění a v případě potřeby vás upozorní.

Zkontrolování aktualizace

1. Vyberte Nápověda → Zkontrolovat aktualizace

2. Objeví se dialog se stavem aktualizace: buď "Není dostupná žádná nová verze" nebo "Je
dostupná nová verze programu MuseScore:" Následuje odkaz k jejímu stažení.

Podívejte se také na

Nastavení: Aktualizace

Preferences-Updates_cs.png
Check_for_update_cs.png

Do you have an unanswered question? Post it in the forum.
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Základy
Předchozí kapitola Úvod vás provází instalací a procesem vytvoření nového notového zápisu. Kapitola
Základy dává přehled o MuseScore a popisuje obecné postupy práce s notovým zápisem.

Vkládání not

Jednoduché vkládání not

Přidávání not a pomlk do osnovy vyžaduje čtyři základní kroky:

1. Vyberte začáteční polohu pro vložení noty
2. Vyberte režim vkládání not
3. Vyberte délku noty (nebo pomlky), kterou chcete vložit
4. Zadejte výšku tónu (nebo pomlku) pomocí klávesnice, myši nebo kláves (zařízení MIDI -

keyboard)

Pro přidání not, které se svým časem překrývají, ale začínají nebo končí v různou dobu, viz hlasy.
Pro přidání akordů pokračujte ve čtení zde.

Krok 1: Začáteční poloha

Nejprve v notovém zápisu zvolte notu nebo pomlku jako vaši začáteční polohu pro vložení noty.
Vložení noty v MuseScore nahradí stávající noty nebo pomlky v taktu vašimi novými notami (to
znamená, že noty spíše přepíše než vloží). Nové takty však můžete vložit na jakémkoli místě (viz
operace s takty: Vložit), nebo použijte kopírování a vkládání pro přesun skupiny not.

Krok 2: Režim vkládání not

Tlačítko "N" v nástrojovém panelu pro vkládání not ukazuje, zda jste v režimu vkládání not nebo
nejste. Pro vstoupení nebo opuštění režimu vkládání not můžete na tlačítko klepnout, nebo můžete
použít klávesovou zkratku N. Pro opuštění režimu vkládání not také můžete stisknout klávesu Esc.

Krok 3: Délka noty (nebo pomlky)

Po vstoupení do režimu vkládání not vyberte dobu trvání noty, již potřebujete v nástrojovém panelu
pro vkládání not nebo použijte odpovídající klávesovou zkratku.
Všimněte si, že pokud máte nepravidelné rozdělení rytmu (jako například 3 osminové noty v čase
dvou osmin), podívejte se na rytmickou notovou skupinu

Klávesovými zkratkami pro zvolení doby trvání noty jsou:

1: Čtyřiašedesátinová nota
2: Dvaatřicetinová nota
3: Šestnáctinová nota
4: Osminová nota
5: Čtvrťová nota
6: Půlová nota
7: Celá nota (semibreve)
8: Dvoucelá (breve)
9: Longa
0: Pomlka
.: Tečka mění dobu trvání vybrané noty na tečkovanou notu/pomlku

Krok 4: Zadání výšky tónu

U všech nástrojů (kromě bicích, kde výška tónu není) můžete výšky tónů přidat pomocí myši přímým
klepnutím v notové osnově (pokyny zvláštní pro bicí viz notový zápis bubnů). Je však možné, že vám
bude zadávání not pomocí kláves (MIDI keyboard) (viz dále), nebo klávesnice počítače připadat
rychlejší. Následující příklady se vztahují k používání běžné klávesnice k počítači.

Zadejte výšky tónů stisknutím odpovídajících kláves na vaší klávesnici: C D E F G A B C
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0 (Nulou) vytvoříte pomlku: např. C D 0 E. Všimněte si, že doba trvání noty, kterou jste zvolili (čtvrťové
noty v příkladu) určuje i dobu trvání pomlky (čtvrťová pomlka).

Během vkládání not MuseScore automaticky postupuje v notovém zápisu dál. Pokud toto nechcete,
nýbrž chcete k naposledy zadané notě přidat další notu, aby vznikl akord, stiskněte a podržte klávesu
Shift, a pak zadejte název noty: C D Shift+F Shift+A E F

Pro vytvoření akordů s notami o různé době trvání viz hlasy.

Pokud chcete vytvořit tečkovanou notu, stiskněte .. Například 5 . C 4 D E F G A

Když na klávesnici zadáváte notu, MuseScore ji umístí co možná nejblíže k předchozí zadané notě
(nahoru nebo dolů). Při zadávání akordů jsou ovšem nové noty přidávány nad předchozí notu
(zezdola nahoru).
Když to vede k tomu, že nějaká nota skončí ve špatné oktávě, můžete ji posunout o oktávu nahoru
nebo dolů pomocí následujících klávesových zkratek:

Ctrl+↑ (Mac: ⌘+↑): Zvýší výšku tónu noty o jednu oktávu.
Ctrl+↓ (Mac: ⌘+↓): Sníží výšku tónu noty o jednu oktávu.

Jiné klávesové zkratky

Další užitečné klávesových zkratky pro úpravy dostupné v režimu vkládání not:

↑ (šipka nahoru): Zvýší výšku tónu noty o půltón (použije křížek ♯).
↓ (šipka dolů): Sníží výšku tónu noty o půltón (použije béčko ♭).
Alt+Shift+↑: Zvýší výšku tónu noty o půltón podle tóniny
Alt+Shift+↓: Sníží výšku tónu noty o půltón podle tóniny
J: Změní notu na její enharmonický ekvivalent
R: Zdvojí naposledy zadanou notu
Q: Zmenší na polovinu dobu trvání naposledy zadané noty
W: Zdvojí dobu trvání naposledy zadané noty
Backspace: Vrátí vložení naposledy zadané noty zpět
X: Obrátí směr nožičky noty
Shift+X: Přesune hlavičku noty na druhou stranu nožičky

Zařízení MIDI

Výšky tónů také můžete zadávat pomocí kláves (zařízení MIDI, keyboard).

1. Připojte MIDI zařízení k počítači a zařízení zapněte
2. Spusťte MuseScore (toto se musí udělat po zapnutí kláves)
3. Vytvořte nový notový zápis
4. Klepněte na pomlku (vyberte ji) v prvním taktu, abyste označili místo, kde chcete, aby vkládání

not začalo
5. Stiskněte N pro vstoupení do režimu vkládání not
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6. Vyberte dobu trvání noty, například 5 pro čtvrťové noty (viz výše)
7. Stiskněte klávesu na vašem zařízení MIDI, do vašeho notového zápisu je přidána odpovídající

výška tónu

Nota by nyní měla být přidána do vašeho notového zápisu.

Poznámka: Pomocí zařízení MIDI můžete najednou přidat jeden tón nebo akord. Tento způsob
zadávání not (někdy nazývaný krokové zadávání: "step-time entry") je rychlý a spolehlivý. Některé
notační programy se pokouší vykládat zadávání ve skutečném čase: "real-time entry", při němž hraje
hudebník skupinu not a program se snaží vytvořit notový zápis. Výsledky tohoto postupu jsou však
často nespolehlivé, i když je hráčem schopný hudebník, který používá drahý program. MuseScore se
zaměřuje na spolehlivější způsoby zadávání not, jak jsou popsány výše.

Pokud máte ke svému počítači připojeno více zařízení MIDI, může se stát, že budete potřebovat
MuseScore říct, které z nich je zařízením MIDI pro zadávání not pomocí kláves. Použijte k tomu
nabídku Úpravy → Nastavení... (Mac: MuseScore → Nastavení...). V dialogu Nastavení, který se nyní
otevře, klepněte na kartu Vstup/Výstup a vyberte své zadávací zařízení v části označené jako
"PortAudio".

Barvení not mimo zobrazený rozsah tónů

Noty uvnitř hratelného rozsahu nástroje nebo hlasového partu jsou kresleny černě, zatímco noty
jdoucí za normální rozsah jsou obarveny na červeno. U některých nástrojů závisí rozsah na
schopnostech hudebníka (smyčce, dechy nebo hlas). U těchto nástrojů se noty překračující rozsah
amatéra objevují v barvě tmavě žluté a noty mimo typický rozsah profesionála v barvě červené.

Barvy jsou čistě informativní a jsou vidět na obrazovce počítače, ale na výtiscích not nejsou. Pro
zakázání barvení not vyberte nabídku Úpravy → Nastavení... (Mac: MuseScore → Nastavení...),
klepněte na kartu Vkládání not, a zrušte zaškrtnutí "Barvit noty mimo použitelný rozsah výšky tónu"

Malé noty

1. Vyberte notu(y), která má mít malou velikost
2. Ve správci můžete měnit velikost jednotlivých not a akordů zaškrtnutím (zrušením zaškrtnutí)

okénka Malý/Malá (buď v okně správce pro akord nebo pro notu)
Všechny rozměry pro malé velikosti (i ty neobvyklé) můžete změnit v Styl → Obecné → Velikosti

Poznámka: Ve správci zmenší volba Malá v okně pro 'noty' pouze velikost hlavičky noty; akordy,
nožičky, trámce a praporky jsou zmenšeny celé.

Vlastnosti not

Podívejte se na Rozvržení a formátování, zvláště části věnované notám, posuvkám a
nepravidelným rytmickým skupinám
Podívejte se na Správce a vlastnosti předmětů na vlastnosti noty nebo výběru not

Změna výšek not (bez změny rytmu)

Pokud je jen jedna nota, je nejlepší ji vybrat buď myší nebo klávesnicí.
Pokud je not více a rytmus se nemění, můžete použít buď transpozici (pokud je interval přesně
stejný), nebo režim přepočítání posuvek.

Podívejte se na Nahrazení výšek tónů bez změny rytmů
Podívejte se na Transpozice

Pokud se vám zdají posuvky divné, můžete zkusit Přepočítat posuvky (podívejte se na Posuvky:
Přepočítání posuvek).

Podívejte se také na

Notový zápis bubnů
Nastavení
Rytmické notové skupiny
Hlasy
Jak zadat akord
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Jak zadat pomlku
Jak natáhnout nožičku přes dvě osnovy

Vnější odkazy

Videonávod: MuseScore ve chvilce: Lekce 3 - Vkládání not
Videonávod: MuseScore ve chvilce: Lekce 4 - Zadávání pomocí klávesnice MIDI
Videonávod: MuseScore ve chvilce: Lekce 5 - Další způsoby zadávání

Do you have an unanswered question? Post it in the forum.

Ve znějící výšce
Ve znějící výšce dovoluje přepínání mezi notami, které se v notových řádcích objevují tak, jak znějí,
nebo jak byly napsány pro transponující nástroje. Přitom se může změnit tónina (předznamenání)
a/nebo klíče, aby se přizpůsobily transponujícím nástrojům.

Poznámka: Pokud notový zápis obsahuje transponující nástroje, před tiskem se ujistěte, že výtahy
hlasů nejsou v režimu koncertního ladění.

Podívejte se také na

Transpozice: Transponující nástroje
Posuvky: Přepočítání posuvek

Do you have an unanswered question? Post it in the forum.

Kopírování a vkládání
Kopírování a vkládání je užitečným nástrojem pro opakující se noty nebo pro posunutí části not o
dobu nebo o takt.

Kopírování

1. Klepněte na první notu ve vašem výběru
2. Shift+Klepněte na poslední notu ve vašem výběru. Vámi vybraná oblast je zvýrazněna

obdélníkem
3. V nabídce zvolte Úpravy → Kopírovat nebo stiskněte Ctrl+C (Mac: ⌘+C)

Vkládání

1. Klepněte na notu nebo na takt, kde chcete, aby vámi vložený výběr začínal
2. V nabídce zvolte Úpravy → Vložit nebo stiskněte Ctrl+V (Mac: ⌘+V)

Rychlé zopakování

1. Vyberte notu nebo takt
2. Stiskněte R a MuseScore zdvojí vybraný předmět

Filtr výběru

Je možné filtr použít před kopírováním výběru, k přesnému vybrání toho, co se bude kopírovat a
následně vkládat.

1. Povolte filtr výběru pomocí F6 (Mac: fn+F6) nebo Pohled → Filtr výběru
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Filtr výběru vypadá takto:
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Karta s výběrovým filtrem se ve výchozím nastavení objeví pod paletami. Je možné zrušit její ukotvení
a udělat z ní plovoucí okno, a pokud je přímo přetažena na palety, nebo na správce, obojí je potom
dostupné přes kartu dole.

1. Zrušte výběr věcí, jež nechcete kopírovat
Příklad: Artikulace a legata nejsou vybrány.

2. Kopírujte a vložte jako předtím
(v příkladu zkopírujete takty 4 a 5 a vložíte je do taktů 12 a 13)

3. Prohlédněte si výsledek—legata nebyla zkopírována:
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Podívejte se také na

Pokud chcete noty změnit, aniž by se měnil rytmus, můžete spojit transpozici nebo nahrazení výšek
tónů bez změny rytmů s kopírováním a vkládáním.

Vnější odkazy

Videonávod: Text písně, kopírování a dynamika

Do you have an unanswered question? Post it in the forum.

Režim úprav
Mnohé prvky v notovém zápisu lze upravovat v režimu úprav:

Dvojí klepnutí: Začne režim úprav
Esc: Ukončí režim úprav

Některé prvky v režimu úprav ukazují úchopy, které lze přesouvat tažením myší nebo klávesovými
příkazy.

Legato v režimu úprav:

Dostupné klávesové příkazy:

←: Přesune úchop o jednu mezeru doleva (vzdálenost mezi dvěma notovými linkami)
→: Přesune úchop o jednu mezeru doprava
↑: Přesune úchop o jednu mezeru nahoru
↓: Přesune úchop o jednu mezeru dolů
Ctrl+← (Mac: ⌘+←): Přesune úchop o 0,1 mezery doleva
Ctrl+→ (Mac: ⌘+→): Přesune úchop o 0,1 mezery doprava
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Ctrl+↑ (Mac: ⌘+↑): Přesune úchop o 0,1 mezery nahoru
Ctrl+↓ (Mac: ⌘+↓): Přesune úchop o 0,1 mezery dolů
Alt+←: Přesune úchop o 0,01 mezery doleva
Alt+→: Přesune úchop o 0,01 mezery doprava
Alt+↑: Přesune úchop o 0,01 mezery nahoru
Alt+↓: Přesune úchop o 0,01 mezery dolů
Shift+←: Přesune ukotvení úchopu doleva
Shift+→: Přesune ukotvení úchopu doprava
Tab: Jde na další úchop

Pokud potřebujete posunout prvky notového zápisu ručně, dvakrát na ně klepněte a použijte směrové
šipky.

Podívejte se také na

Úpravy textu
Legato
Závorky
Linky
Trámce
Svorky

Do you have an unanswered question? Post it in the forum.

Operace s takty

Připojení

Pro přidání taktu na konec notového zápisu stiskněte Ctrl+B (Mac: ⌘+B), nebo vyberte v nabídce
Přidání → Takty → Připojit takt. Pro přidání více taktů stiskněte Alt+Shift+B (Mac: ⌘+Shift+B)
nebo použijte nabídku Přidání → Takty → Připojit takty....

Vložení

Pro vložení prázdného taktu do notového zápisu vyberte takt, potom stiskněte Ins nebo použijte
nabídku Přidání → Takty → Vložit takt pro vložení nového prázdného taktu před vybraný. Pro
vložení více taktů stiskněte Ctrl+Ins (pro Mac není žádná zkratka) nebo použijte nabídku Přidání →
Takty → Vložit takty....

Smazání

Nejprve vyberte takt, a potom stiskněte Ctrl+Del (Mac: ⌘+Fn+Del).

Vlastnosti

Pro úpravu vlastností taktu klepněte pravým tlačítkem myši na prázdnou část taktu a vyberte
Vlastnosti taktu...:
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Notové osnovy

Vlastnost Viditelná vám umožňuje ukázat a skrýt noty a linky notových osnov vybraného taktu.
Vlastnost Bez nožiček vám umožňuje ukázat a skrýt všechny nožičky not vybraného taktu, takže
jsou ve vybrané oblasti neviditelné. U not, jež mají normálně nožičku, jako jsou půlové a čtvrťové
noty, se ukazuje, když je označena jako bez nožičky, jen hlavička noty.

Doba trvání taktu

Jmenovitá doba trvání je taktové označení zobrazené v notovém zápisu.
Skutečnou dobu trvání taktu můžete změnit na cokoli bez ohledu na taktové označení zobrazené
v notovém zápisu.
Obvykle jsou jmenovitá a skutečná doba trvání taktu stejné. Nicméně například předtaktí může
mít kratší skutečnou dobu trvání.

Na obrázku níže má předtaktí se čtvrťovou notou jmenovitou dobu trvání taktu 4/4, ale skutečnou dobu
trvání má 1/4. Oba dva následující takty uprostřed mají jak jmenovitou tak skutečnou dobu trvání 4/4.
Poslední takt obsahuje jen jednu tečkovanou půlovou notu a má skutečnou dobu trvání 3/4:

Jiné

Takt nepočítat 
Použijte Takt nepočítat na nepravidelné takty, to jest na ty, které by se neměly počítat v počítání
taktů celého notového zápisu. Obyčejně je označeno jako Takt nepočítat předtaktí.

Přidat k číslu taktu 
Také můžete použít volbu Přidat k číslu taktu pro ovlivnění číslování taktů. Zde můžete zadat
kladná nebo záporná čísla. Všimněte si, prosím, že tato změna působí na číslování všech
následujících taktů. Hodnota -1 má týž účinek, jako když je takt označen za nepravidelný.

Protažení rozvržení 
Tímto můžete zvětšit nebo zmenšit velikost vodorovného odstupu mezi jednotlivými prvky
notového zápisu (noty, pomlky atd.).
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Počítadlo opakování 
Pokud je takt koncem opakování, můžete zde stanovit, kolikrát má být zopakován.

Zalomit vícetaktové pomlky 
Tato vlastnost oddělí vícetaktovou pomlku na začátku vybraného taktu. Tato volba by se měla
zaškrtnout předtím, než zapnete volbu Vytvořit vícetaktové pomlky v nabídce Styl → Upravit
obecný styl..., na kartě Noty.
Vícetaktové pomlky jsou rozděleny automaticky na důležitých místech, jako jsou zkušební
značky, změna taktu, dvojité taktové čáry, nepravidelné takty atd. Výchozí nastavení pro notové
zápisy je vypnuto, pro jednotlivé hlasy je zapnuto.

Číslování

MuseScore automaticky čísluje první takt horního notového řádku každé osnovy (vyjma první osnovy,
přesněji: kromě taktu s číslem 1), ale jsou možné další volby pro číslování. V hlavní nabídce zvolte
Styl → Upravit obecný styl... , V levém panelu vyberte Záhlaví, zápatí a čísla. Ve spodní části
objevivší se nabídky pravého panelu naleznete Čísla taktů.

Zaškrtněte okénko vedle čísel taktů, abyste zapnuli automatické číslování taktů.

Zaškrtněte Ukázat první, pokud chcete, aby byl první takt očíslován.

Zaškrtněte Všechny osnovy, pokud chcete, aby byla čísla u všech osnov, jinak se čísla taktů ukáží jen
u horní notové osnovy každé osnovy.

Zaškrtněte Každá osnova, aby se čísla taktů ukázala u každé notové osnovy. Potom dostane první
takt každé notové osnovy číslo. Nebo zaškrtněte Interval a zadejte velikost intervalu. Když například
zadáte interval o hodnotě 1, je očíslován každý takt. Když jako interval zvolíte 5, je očíslován každý
pátý takt.

Rozdělení a spojení

Možná byste chtěli vytvořit delší nebo kratší takt. Počet taktů a taktové označení můžete změnit ve
vlastnostech taktu. Ale je ještě další možnost, jak rozdělit nebo spojit takty. Trámce se přitom
přizpůsobí automaticky.

Spojení

1. Vyberte takty, které chcete spojit
2. Úpravy → Takt → Spojit takty

Poznámka: Pokud vyberete jen jednu osnovu, budou spojeny všechny takty v každé notové osnově
nebo systému.

 

Rozdělení

1. Vyberte notu (nebo akord)
2. Úpravy → Takt → Rozdělit takty

Poznámka: Pokud vyberete jen jednu notu z jedné osnovy, bude na stejném místě rozdělena každá
notová osnova systému.

Podívejte se také na
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Jak smazat takty
Jak takt roztáhnout přes více osnov
Jak dostat noty bez taktového označení (a klíče)

Do you have an unanswered question? Post it in the forum.

Palety
Ukázat nebo skrýt palety můžete pomocí nabídky Pohled → Palety (nebo použijte klávesovou zkratku
F9).

Přidání symbolů do not

Symboly z palety můžete na prvky notového zápisu přetahovat pomocí myši.

Dvojité klepnutí na symbol na paletě má tentýž účinek jako jeho přetažení na každý vybraný prvek
notového zápisu.

Tímto způsobem se kupříkladu dá v jednom pracovním úkonu rychle vytvořit značka pro tenuto na
celé skupině předtím označených not:

1. Označte noty
2. Dvakrát klepněte na symbol tenuta na paletě Artikulace a ozdoby

Pokročilé a jednoduché palety

Když na své pracovní ploše potřebujete další symboly/palety, potom můžete v nabídce Úpravy pod

Nonexistent node nid: 39841.
dostupné symboly/palety změnit, příp. vytvořit nové.

Jiné hudební symboly

Jiné hudební symboly lze nalézt v hlavní paletě.

Upravení palety

Na to, jak do palety přidat jiné hudební symboly, se podívejte ve vlastních paletách.

Podívejte se také na

Vlastní palety
Nonexistent node nid: 39841.
Hlavní paleta

Do you have an unanswered question? Post it in the forum.

Nastavení
V MuseScore můžete vytvořit přes přednastavení pracovní plochu s osobním stylem a/nebo
přednastavenými složkami.
Klepněte na Úpravy → Nastavení... (Mac: MuseScore → Nastavení...):

Objeví se následující okno s různými kartami, kterými se budete pohybovat:

Některé změny mohou k tomu, aby začaly účinkovat, vyžadovat opětovné spuštění (ukončení a
opětovné otevření) MuseScore. Poví vám to oznamovací okno, když klepnete buď na Použít nebo na
OK.

Vrácení všech nastavení na výchozí hodnoty vrátí MuseScore zpět do stavu, jaký mělo, když jste je
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čerstvě nainstaloval.
Zrušit vrátí zpět všechny právě provedené změny.

Obecné

Zde můžete nastavit:

Váš počáteční notový zápis
Výchozí složku, ve které se budou hledat notové zápisy, zvukové banky, předlohy a tak dále
Načasování automatického ukládání
Jazyk pro MuseScore (překlady mohou být odtud aktualizovány také)
Styl oken MuseScore a velikost ikon
Okna, která se objeví při spuštění (přehrávací panel, pohyb v notách, spojení MuseScore).
Aktualizace překladů jazyků lze také dělat přes Nápověda → Správce zdrojů

Povrch
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Použijte povrch k nastavení vámi upřednostňované barvy a složení povrchu pozadí a papíru.

Pod Různé se stará vyhlazování obrazu (ve výchozím nastavení zapnuto) o to, aby úhlopříčné čáry a
okraje tvarů vypadaly hladčeji (méně roztřepené). Poloměr odchytu při výběr prvků  řídí odstup, který
může mít myš od předmětu, a tento pořád ještě odpovídá na činnosti myši. Menší hodnoty vyžadují
větší přesnost a dělají obtížnějším klepnutí na malé předměty. Vyšší hodnoty jsou méně přesné, je
přitom ale těžší, když předměty leží blízko sebe, zasáhnout požadovaný bod a neklepnout nezáměrně
na jiný předmět. Vyberte hodnotu, která vám bude při práci vyhovovat.

Vkládání not
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Na této kartě je možné nastavit způsob vkládání not a vzdálené ovládání MIDI. Jsou tu následující
možnosti nastavení:

Zadávání not přes MIDI
Povolení přehrávání při zadávání not
Doba trvání přehrávání
Barvení not mimo použitelný rozsah tónů
Nastavení vzdáleného ovládání MIDI

Noty
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Nastavení notového zápisu zahrnuje

Výchozí soubory se seznamy nástrojů (dva mohou být vybrány)
Výchozí styl pro notový zápis a výtahy hlasů
Výchozí zvětšení

Vstup/Výstup
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Vstup/Výstup (I/O). Zde můžete nastavit přípojku zvuku, přes kterou MuseScore směřuje přehrávání
zvuku, případně přijímá signály MIDI.

Zavedení
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Tato nastavení určují, jak jsou zaváděny soubory z jiných zdrojů:

Vestavěný styl MuseScore nebo jiný styl dle vaší volby
Znakové sady Guitar Pro a Overture
Volby rozložení MusicXML
Nejkratší nota v souborech MIDI

Vyvedení
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Tato nastavení určují, jak jsou soubory MuseScore vyváděny:

Rozlišení obrázků PNG/SVG (v DPI) a zda se má použít průhledné pozadí
Zda se mají rozvést opakování v souborech MIDI k vyvedení
Vzorkovací kmitočet digitálního zvuku
Zda se má vyvést rozvržení a jak do MusicXML vyvést zalomení osnovy a stran

Zkratky
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Je zde uvedena každá činnost proveditelná s MuseScore společně s příslušnou klávesovou zkratkou,
pokud tato existuje. Pomocí tlačítka Stanovit... můžete určit novou klávesovou zkratku pro novou
činnost. Ke stanovení zkratky můžete použít až čtyři klávesy.
Také můžete vše vrátit znovu do výchozího stavu, nebo odstranit všechny přednastavené či jen
smazat vybranou zkratku.

(Upozornění: Některé klávesové zkratky včetně některých výchozích, nepracují se všemi
klávesnicemi. Jednoduše je vyzkoušejte.)

Aktualizace
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Zde se nastavuje, zda má MuseScore při spuštění automaticky pátrat po aktualizacích.

Aktualizace je také možné hledat ručně pod Nápověda → Zkontrolovat aktualizace

Podívejte se také na

Klávesové zkratky
Nastavení jazyka a aktualizace překladů
Kontrola aktualizací

Preferences_Window_tabs_cs.png
Preferences-Canvas_cs.png
Preferences-Export_cs.png
Preferences-General_cs.png
Preferences-Import_cs.png
Preferences-IO_cs.png
Preferences-Note_Input_cs.png
Preferences-Score_cs.png
Preferences-Shortcuts_cs.png
Preferences-Update_cs.png

Do you have an unanswered question? Post it in the forum.

Ukládání a tisk
Ukládání a vyvádění bylo rozděleno do dvou nabídek: 'Uložit' a 'Uložit jako' (stejně tak 'Uložit kopii' a
'Uložit výběr'). Týká se to jak vlastního formátu MuseScore (.mscz a .mscx) tak i cizích formátů
MusicXML, MIDI, různých obrázkových a zvukových formátů ('Vyvést' a 'Vyvést výtahy hlasů'). Příkaz
'Tisk' váš notový zápis pošle přímo připojené tiskárně.
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Nabídka Soubor

Dostupné jsou následující příkazy: 'Uložit', 'Uložit jako...', 'Uložit kopii...', 'Uložit výběr...', 'Uložit na
internet...', 'Vyvést...', 'Vyvést výtahy hlasů...' a 'Tisk'

Formáty v nabídce 'Uložit', 'Uložit jako...', 'Uložit kopii...', 'Uložit výběr...' a 'Uložit na internet...'

Formáty v nabídce 'Vyvést' a 'Vyvést výtahy hlasů'
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Poznámka: Nekomprimovaný formát MuseScore je dostupný jak v 'Uložit' tak ve 'Vyvést'.

Tisk

V závislosti na tiskárně máte různé volby. Obecně k tomu patří:
* Formát strany
* Tisk všeho, výběru
* Tisk nynější strany nebo více stran
* Počet kopií a porovnání
Pokud máte nainstalovánu tiskárnu PDF, můžete s její pomocí rovněž provést přímé 'vyvedení do
PDF.

Podívejte se také na

Souborový formát
Vytažení hlasů skladby

Do you have an unanswered question? Post it in the forum.

Výběrové režimy
Je více různých výběrových režimů (způsobů výběru předmětů).

Výběr jednoho předmětu

Jednoduše na předmět klepněte.

Výběr rozsahu

1. Vyberte první prvek (klepněte na něj)
2. Stiskněte Shift
3. Vyberte poslední prvek (klepněte na něj)

Všechny vybrané předměty se nyní objeví uvnitř modrého obdélníku.

Poznámka 1: Některé prvky lze vybrat jako rozsah: noty, pomlky, artikulace ...
Poznámka 2: Podívejte se také na Kopírování a vkládání: Filtr výběru, jak vybrat jen některé předměty
v rozsahu.

Výběr různých nikoli po sobě jdoucích předmětů

1. Vyberte první prvek (klepněte na něj)
2. Stiskněte Ctrl a podržte klávesu stisknutou
3. Vyberte jiné prvky (klepněte na ně)
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Poznámka 1 výše platí i zde.

Výběr všech stejných prvků

1. Vyberte prvek
2. Klepnutí pravým tlačítkem myši → Vybrat >

3. Je možné vybrat z více možností

Všechny podobné prvky: v celém notovém zápisu
Všechny podobné prvky ve stejné notové osnově: pouze v téže notové osnově
Všechny podobné prvky ve vybraném rozsahu: jen když je zapnut →výběr rozsahu, jsou
vybrány podobné prvky pouze uvnitř tohoto výběru
Více...

Příklad: Vybráno béčko (posuvka)

Můžete zapnout následující možnosti výběru (a spojit):

Stejný podtyp: V tomto příkladu budou vybrána pouze béčka (♭), nikoli však křížky (♯), a
také ne odrážky (♮); některé prvky mají podtyp (např. artikulace, posuvky...)
Stejná notová osnova: Pouze prvky ve stejné notové osnově
Stejný hlas: Pouze prvky ve stejném hlasu
Stejný systém: Pouze prvky ve stejném systému
Stejný výběr: Pokud je zapnut výběr, pouze prvky v tomto výběru

Lze udělat další různé činnosti (jen jedna možnost volby): Přidat do výběru,odečíst z výběru,
nahradit výběr a hledat ve výběru.

Jak se používají

Kopírování a vkládání
Režim úprav pro současný posun předmětů
Správce a vlastnosti předmětů

Podívejte se také na

Základy, zejm. Vkládání not
Notový zápis, zejm. Posuvky
Text, zejm. Úpravy textu a Pohyb značek a textu osnovy založený na mřížce

Do you have an unanswered question? Post it in the forum.

Zpět a znovu
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MuseScore může vrátit zpět libovolný počet kroků a zase je provést znovu.

Standardními klávesovými zkratkami jsou tyto:

Zpět Ctrl+Z (Mac: ⌘+Z)
Znovu Ctrl+Shift+Z nebo Ctrl+Y (Mac: ⌘+Shift+Z)

Nebo použijte tlačítka v nástrojovém panelu:

Do you have an unanswered question? Post it in the forum.

Pohledy
Jsou různé druhy zobrazení not na obrazovce.

Kromě pohledu na stranu/souvislého pohledu se dají všechny ostatní druhy najít v hlavní nabídce
Pohled.

Pohled na stranu/Souvislý pohled

V nastavení Pohled na stranu jsou noty zobrazeny tak, jak by se objevily, když by byly vytištěny (nebo
vyvedeny jako PDF nebo jako obrázkový soubor). V souvislém pohledu jsou noty ukázány jako
pokračující osnova (bez zalomení osnovy).

Všimněte si, že při přepínání mezi pohledem na stranu a souvislým pohledem je notový zápis pro
nový pohled přeformátován a ruční úpravy mohou vyžadovat opětovné nahrání pohledu.

Přepínat mezi oběma druhy pohledu můžete zde:

Pohled na stranu

V pohledu na stranu je notový zápis ukázán jako jedna nebo více stran o určité velikosti s okraji, podle
přednastaveného nastavení tisku. Vidíte všechny notové osnovy (řádky not) a všechna zalomení stran
včetně těch, která byla přidána ručně, a těch, jež byla automaticky vypočítána programem. (Ručně
vložená zalomení mohou být například velice nápomocná, když jde o to mít v orchestrálních hlasech
dobře umístěny stránkové zlomy.)

Souvislý pohled

V souvislém pohledu jsou noty ukázány jako jedna probíhající nezalomená osnova. Když počáteční
bod neleží ve viditelné oblasti okna, objeví se v náhradu na doplnění okno, v němž jsou zobrazena
čísla taktů, názvy nástrojů, klíče, taktová označení a předznamenání (tónina).

Před vytištěním not jděte, prosím, do pohledu na stranu a ověřte zalomení notových osnov a stran.

Poznámka: V souvislém pohledu může MuseScore noty předvést rychleji, protože rozvržení zde je
jednodušší než v pohledu na stranu.
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Zvětšení

V pohledu na stranu nebo v souvislém pohledu můžete měnit úroveň zvětšení dle libosti (Pozor: Toto
nastavení nemá naprosto žádný účinek na tisk).

Ve skládací nabídce jsou k zobrazení notového zápisu na výběr různé stupně zvětšení v procentních
hodnotách, stejně tak jako zobrazení na šířku strany, na celou stranu a na dvě strany, což jsou
rozměry ve vztahu k velikosti okna.

V nabídce pohled naleznete volby Přiblížit a Oddálit a jejich klávesové zkratky. Právě tak se dá
obraz zvětšovat a zmenšovat otáčením kolečka myši dopředu a dozadu za současného držení
klávesy Ctrl (Mac: Cmd).

Ukázání více než jednoho notového zápisu

Současně může být ukázáno více dokumentů vedle sebe

nebo na sobě
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Můžete za pomoci myši táhnout zábranou ležící mezi oběma notovými zápisy a upravit velikost místa
v okně věnovanou každému z nich.

Celá obrazovka

Režim na celou obrazovku zvětšuje MuseScore, aby vyplnilo celou oblast obrazovky, takže je vidět
více notového obsahu.

Pohyb v notách
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Pokud máte dlouhý notový zápis a chcete vidět, kde právě jste, nebo chcete přejít na určitou stránku,
použijte panel s náhledy stran (miniatury), který je vsunut při spodním konci notového zápisu jako
dlouhé, úzké okno, v němž jsou jednotlivé strany naznačeny v malém rozměru. Malý modrý pravoúhlý
rám ukazuje okamžitou polohu v notovém zápisu, která je vidět v hlavním okně.

NOT FOUND: Navigator_en.png

Na jiné místo v notách můžete přímo přijít tím způsobem, že tento modrý pravoúhelník buď přitáhnete
do požadované polohy, nebo tažením posuvníku, nebo když rovnou klepnete na příslušnou stranu.

Pro zapnutí/vypnutí okna s náhledy stran jděte do nabídky Pohled a vyberte Miniatury, nebo použijte
klávesovou zkratku F12 (Mac: fn+F12).

Podívejte se také na

Ukládání a tisk
Souborový formát
Rozvržení a formátování

Do you have an unanswered question? Post it in the forum.

Souborový formát
MuseScore podporuje hodně souborových formátů, které vám dovolují sdílet a zveřejňovat noty ve
formátu, který nejlépe vyhovuje vašim potřebám.
Soubory zavedete přes nabídku Soubor → Otevřít... a vyvedete přes nabídku Soubor → Vyvést....
Při použití níže uvedených formátů můžete své notové zápisy uložit a sdílet na internetu na
MuseScore.com přes Soubor → Uložit na internet... . Podívejte se na Sdílení not po internetu.

Vlastní formát MuseScore

Tyto formáty MuseScore vytváří
* přes nabídku Soubor → Uložit

* po klepnutí na tlačítko pro uložení 
* klávesovou zkratkou (Ctrl+S)
* pomocí dialogu Soubor → Uložit jako....

Formát MuseScore (*.mscz)

MSCZ je standardní souborový formát MuseScore a doporučuje se při většině užití.

Notový zápis uložený v tomto formátu zabírá velmi málo prostoru na disku, ale uchovává všechny
nezbytné informace. Formát je ZIPem zabalenou verzí souborového formátu .mscx a zahrnuje
obrázky.

Nezabalený formát MuseScore (*.mscx)

MSCX je nekomprimovanou verzí souborového formátu MuseScore.

Notový zápis uložený v tomto formátu neztratí žádnou informaci kromě obrázků a doporučuje se,
pokud potřebujete formát souboru upravit ručně v textovém editoru.

Předchozí verze MuseScore používaly souborový formát s příponou *.msc. Přípona *.msc však stojí ve
střetu se souborovou příponou používanou Microsoft Windows a je blokována některými poskytovateli
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elektronické pošty. Nová souborová přípona MSCX nahrazuje starou souborovou příponu MSC kvůli
potížím, jež byly nastíněny výše.

Formáty MSCZ a MSCX MuseScore 2.0 nemohou být přečteny verzí MuseScore 1.3 a staršími. Rada:
Nejprve vyveďte soubory uložené v těchto starších verzích do formátu →XML nebo →MXL, který
potom zase načtěte v MuseScore 2.0.

Poznámka k písmům: MuseScore nevkládá písma do souboru, kromě rodin písem FreeSerif,
FreeSerifBold, FreeSerifItalic, FreeSerifBoldItalic a FreeSans. Pokud chcete soubor MuseScore sdílet
s dalšími stranami, zvolte pro svůj text písmo, jež mají ostatní nainstalováno. Když počítač písmo
stanovené v souboru nemá, MuseScore namísto něj použije záložní písmo. Záložní písmo bude
samozřejmě vypadat jinak.

Záložní soubory MuseScore

Záložní soubor MuseScore (*.mscz, nebo *.mscx,)

Záložní soubory jsou vytvářeny automaticky a jsou ukládány v téže souborové složce jako váš
normální soubor MuseScore. Záložní soubor přidává na začátek názvu souboru tečku (.) a čárku (,)
na konec (má-li například váš normální soubor název "bez názvu.mscz", potom je záložní kopie
pojmenována ".bez názvu.mscz,").

Záložní kopie obsahuje předchozí uloženou verzi souboru MuseScore a může se stát důležitou v
případě, že se vaše normální kopie poškodí, nebo se potřebujete podívat na o něco starší verzi
vašeho notového zápisu.

Pro otevření záložní souboru MuseScore je potřeba soubor přejmenovat odstraněním tečky a čárky.
Protože je uložen v téže souborové složce jako váš normální soubor MuseScore, je rovněž potřeba
dát mu jedinečný souborový název (můžete například změnit souborový název ".bez názvu.mscz," na
"bez názvu-záloha1.mscz").

Abyste záložní soubory MuseScore viděli, bude potřeba systémové nastavení změnit na "Ukázat
skryté soubory". Podívejte se také na How to recover a backup copy of a score (MuseScore 2.x).
Připomenutí uživatelům Windows: Po přejmenování takového záložního souboru byste souboru měli
znovu nastavit vlastnost Skrytý.

Tisk a čtení (pouze vyvedení)

PDF (*.pdf)

Portable Document Format (PDF) je ideální pro sdílení vašich not s ostatními, kteří je nepotřebují
upravovat. Většina uživatelů počítačů již ve svém počítači má prohlížeč souborů PDF, takže nebudou
k tomu, aby uviděli váš notový zápis, potřebovat instalovat nějaký další program navíc.

PNG (*.png)

Portable Network Graphics (PNG) je bitmapový obrázkový formát široce podporovaný programy
běžícími ve Windows, Mac OS a Linuxu.

Tento obrázkový formát je velmi oblíbený na internetových stránkách. MuseScore ukládá
vícestránkové notové zápisy do souborů PNG pro každou stranu. MuseScore vytváří obrázky tak, jak
by byly vidět jako výsledek tisku. Na kartě pro vyvedení pod Úpravy → Nastavení... (Mac: MuseScore
→ Nastavení...) můžete nastavit rozlišení a zda se má použít průhledné pozadí.
Pokud chcete vytvořit obrázky, které ukazují jen část notového zápisu, s nebo bez prvků, které jsou
vidět jen na obrazovce (například rámečky, neviditelné noty a obarvení not mimo tónový rozsah),
použijte, prosím, funkci pro snímek obrazovky

SVG (*.svg)

Scalable Vector Graphics (SVG) dokáže otevřít většina prohlížečů internetových stránek (kromě
prohlížeče Internet Explorer před verzí 9) a většina programu na práci s vektorovou grafikou. Většina
programů pro práci s SVG však nepodporuje vložená písma, takže se kvůli správnému zobrazení
těchto souborů musí nainstalovat odpovídající písma MuseScore.

Poslech (pouze vyvedení)
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WAV audio (*.wav)

WAV (Waveform Audio Format) je nekomprimovaný zvukový formát.

Byl vyvinut firmami Microsoft a IBM, široce jej ale podporují programy pro Windows, Mac OS a Linux.
Je to ideální formát pro tvorbu CD, protože během ukládání souboru není ztracena zvuková kvalita.
Velké velikosti souborů však ztěžují sdílení pomocí elektronické pošty nebo přes internet.

FLAC audio (*.flac)

Free Lossless Audio Codec (FLAC) je komprimovaný zvukový formát.

Soubory FLAC jsou oproti nestlačenému zvuku zhruba poloviční a mají stejně tak dobrou jakost.
Windows a Mac OS pro FLAC vestavěnou podporu nemají, ale programy jako VLC media player umí
soubory FLAC přehrát na jakémkoli operačním systému.

Ogg Vorbis (*.ogg)

Ogg Vorbis je zamýšlen jako patentově svobodná náhrada za oblíbený zvukový formát MP3.

Tak jako soubory MP3, jsou soubory Ogg Vorbis poměrně malé (často desetina nestlačeného zvuku),
ale nějaká zvuková kvalita je přece jen ztracena. Windows a Mac OS pro Ogg Vorbis vestavěnou
podporu nemají, ale programy jako VLC media player a Firefox umí soubory Ogg Vorbis přehrát na
jakémkoli operačním systému.

MP3 (*.mp3)

Soubory MP3 jsou poměrně malé (často desetina nestlačeného zvuku), ale nějaká zvuková kvalita je
přece jen ztracena.

Aby bylo možné vytvářet soubory MP3, je potřeba, aby byla nainstalována dodatečná knihovna,
lame_enc.dll (Windows) nebo libmp3lame.dylib (Mac) a umístění knihovny bylo sděleno MuseScore.
Dostanete ji na http://lame.buanzo.org/.

Někteří uživatelé OS X se mohou setkat s tím, že MuseScore při nahrávání knihovny MP3 narazí na
chybu. Potíž může spočívat v tom, že se jedná o knihovnu 32-bitovou. Sestavená 64-bitová verze,
která pracuje s MuseScore je dostupná na http://www.thalictrum.com/en/products/lame.html (všimněte
si, že soubor je, aby jej MuseScore rozpoznalo, potřeba přejmenovat na libmp3lame.dylib).

Sdílení s dalšími hudebními programy

MusicXML (*.xml)

MusicXML je obecný standard pro vytahování not.

Je podporován většinou z dnes dostupných notačních programů, jako jsou Sibelius, Finale a dalších
více než 100. Je to doporučený formát pro výměnu notových zápisů mezi různými programy na sazbu
not.

Komprimovaný MusicXML (*.mxl)

Komprimovaný MusicXML vytváří menší soubory než běžný formát MusicXML.

Je to novější standard a není tolik rozšířen jako nekomprimovaná verze.

MIDI (*.mid, *.midi, *.kar)

Musical Instrument Digital Interface (MIDI) je formát široce podporovaný sekvencery a programy na
sazbu not.

Soubory MIDI byly nicméně v první řadě vyvinuty pro čtení a přehrávání not ne pro jejich sazbu, a
proto neobsahují údaje o formátování, volbě posuvek pro výšku tónů, rozdělení hlasů, ozdobách,
artikulacích, opakováních nebo předznamenáních. Když chcete soubory sdílet mezi různými
notačními programy, použijte MusicXML. Pokud je vše, co vás zajímá, přehrávání, použijte MIDI.
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MuseData (*.md) (pouze zavedení)

MuseData je formát vyvíjený Walterem B. Hewlettem od roku 1983 jako raný prostředek sdílení
hudební notace mezi programy.

Od té doby byl zastíněn formátem MusicXML, ale na internetu je stále ještě dostupných několik tisíc
notových zápisů v tomto formátu.

Capella (*.cap, *.capx) (pouze zavedení)

Soubory CAP a CAPX jsou vytvářeny notačním programem "Capella".

MuseScore zavádí verzi 2000 (3.0) nebo novější docela přesně (2.x nepracuje, a formát *.all z verze
1.x není podporován vůbec).

Bagpipe Music Writer (*.bww) (pouze zavedení)

Soubory BWW jsou vytvářeny specializovaným notačním programem "Bagpipe Music Writer".

BB (*.mgu, *.sgu) (pouze zavedení)

Soubory BB jsou vytvářeny programem pro aranžování hudby "Band-in-a-Box".

MuseScore obsahuje pokusnou podporu pro zavedení BB.

Overture (*.ove) (pouze zavedení)

Soubory OVE vytváří notační program "Overture".

Tento formát je oblíbený zejména v čínském prostředí (Čína, Hong Kong a Tchaiwan).

MuseScore nyní obsahuje pokusnou podporu pro zavedení OVE.

Guitar Pro (*.GTP, *.GP3, *.GP4, *.GP5, *.GPX) (pouze zavedení)

Podívejte se také na

Ukládání a tisk

Do you have an unanswered question? Post it in the forum.

Sdílení not po internetu
Jděte na musescore.com/sheetmusic, kde si prohlédněte další notové zápisy z MuseScore.

Můžete své notové zápisy uložit a sdílet je po internetu na MuseScore.com. Můžete si vybrat uložení
svého notového zápisu pro soukromý přístup z jakéhokoli počítače, nebo notový zápis sdílet veřejně s
přáteli nebo členy skupiny, aby si jej mohli prohlížet nebo stáhnout.. MuseScore.com vám dovolí
notové zápisy prohlížet a přehrávat ve vašem prohlížeči internetových stránek, a dokonce vám
umožní notový zápis seřídit s videem na YouTube. Pro použití mimo prostředí prohlížeče
internetových stránek můžete notový zápis stáhnout v mnoha formátech (včetně PDF, MIDI, MP3,
MusicXML, a původním souboru MuseScore).

Vytvoření účtu

1. Navštivte MuseScore.com a klepněte na "Vytvořit nový účet". Zvolte uživatelské jméno, zadejte
platnou adresu elektronické pošty a stiskněte Vytvořit nový účet.

2. Počkejte několik minut na elektronický dopis od podpory MuseScore.com. Pokud žádný dopis
nepřišel, prověřte svou složku s nevyžádanou poštou.

3. Klepněte na odkaz v e-mailu a navštivte svůj uživatelský profil, kde změňte své heslo.

Sdílení notového zápisu přímo z MuseScore
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Notový zápis můžete do úložiště na internetu uložit přímo přes nabídku Soubor → Uložit na
internet....

Pokud ještě nemáte účet u MuseScore, nejprve jeden vytvořte klepnutím na odkaz Vytvořit účet. To
otevře program prohlížeče a přivede vás na https://musescore.com/user/register

Poté zadejte vaši adresu elektronické pošty nebo uživatelské jméno účtu u MuseScore a heslo. Když
jste se úspěšně přihlásil, budete moci zadat informace o vašem notovém zápisu.
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1. Název je název vašeho díla/notového zápisu.
2. Popis se objeví pod ním.
3. Soukromí lze nastavit na veřejné (každému viditelné), nebo soukromé (pouze vám) - nicméně

tajné odkazy lze dodatečně vytvořit.
4. Vyberte povolení. Použitím licence Creative Commons dovolujete jiným lidem používání vašich

not za určitých podmínek (s určitými omezeními).
5. Můžete přidat značky, aby se vaše notové zápisy na MuseScore.com daly lehčeji rozeznat. tyto

jsou oddělny klávesou čárka.
6. V případě že jste svůj notový zápis na internetu uložil již dříve, je tato starší verze automaticky

nahrazena novou. Když zrušíte zaškrtnutí u Aktualizovat stávající notový zápis, nový notový
zápis bude na internetu uložen, aniž by byla stará verze přepsána.

Nahrání notového zápisu na MuseScore.com

Také můžete notový zápis nahrát přímo na MuseScore.com.

1. Klepněte na odkaz pro nahrání na MuseScore.com.
2. Máte stejné volby jako u nabídky Uložit na internet.
3. Máte také přístup k více informacím, jako je žánr.

Poznámka: V případě že dosáhnete omezení nahrání 5 notových zápisů, stále ještě můžete notový
zápis nahrát přímo z MuseScore, ale jen posledních pět je vidět. Pokud chcete nahrávat neomezeně
mnoho viditelných notových zápisů, než je tento počet, povyšte nejprve na Pro Account first.
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Upravení notového zápisu na MuseScore.com

Pokud chcete na MuseScore.com provádět ve vašem notovém zápisu změny, upravte soubor
MuseScore ve svém vlastním počítači a následujte kroky níže.

1. Jděte na stránku s notovým zápisem na MuseScore.com.
2. Klepněte na odkaz pro úpravy.
3. Ve formuláři můžete změnit soubor s notovým zápisem, také můžete změnit všechny informace

o notovém zápisu, jako jsou název, popis atd.

Podívejte se také na

Jak smazat notový zápis uložený na MuseScore.com

Do you have an unanswered question? Post it in the forum.

Notový zápis
V předchozí kapitole "Základy" jste se naučili, jak vkládat noty a pracovat s paletou. Kapitola Notový
zápis popisuje podrobně různé druhy notového zápisu včetně pokročilejšího notového zápisu.

Podívejte se také na Pokročilá témata

Posuvky
Posuvky lze nastavit nebo změnit přetažením symbolu posuvky z palety s posuvkami na notu v
notovém zápisu.

Pokud vám jde jen o změnu výšky tónu noty, stačí vybrat notu a stisknout:

↑: Zvýší výšku tónu noty o jeden půltón (nota je předznamenána křížkem).
↓: Sníží výšku tónu noty o jeden půltón (nota je předznamenána béčkem).
Ctrl+↑ (Mac: Cmd+↑): Zvýší výšku tónu noty o jednu oktávu.
Ctrl+↓ (Mac: Cmd+↓): Sníží výšku tónu noty o jednu oktávu.
J: Změní notu enharmonicky.

Stávající posuvku můžete změnit na upomínkovou posuvku (uzavřena v závorkách). Přetáhněte
symbol kulaté závorky z palety s posuvkami na stávající posuvku (ne na hlavičku noty). Pro odstranění
závorek vyberte posuvku a stiskněte Del.

Pokud později změníte směrovými šipkami výšku tónu, budou ruční nastavení posuvky odstraněna.

Přepočítání posuvek

Funkce nabídky Noty → Přepočítat posuvky se pokusí odhadnout správné posuvky pro celý notový
zápis.

Podívejte se také na

Předznamenání: Změnit

Vnější odkazy

Posuvka na Wikipedii

Do you have an unanswered question? Post it in the forum.

Arpeggio a glissando
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Arpeggia se nastavují přetažením symbolu arpeggia z palety Arpeggio a glissando na hlavičku noty
akordu.

Pro změnu délky arpeggia na arpeggio dvakrát klepněte a odpovídající úchop táhněte nahoru nebo
dolů.

Glissanda se nastavují přetažením symbolu glissanda z palety Arpeggio a glissando na první ze dvou
po sobě jdoucích not na téže osnově.

Úprava nebo smazání textu glissanda se dělá klepnutím pravým tlačítkem myši na ně a zvolením
položky Vlastnosti glissanda v nabídce. Pokud není mezi dvěma notami dostatek místa, MuseScore
text nebude zobrazovat.

Vnější odkazy

Arpeggio na Wikipedii
Glissando na Wikipedii

Do you have an unanswered question? Post it in the forum.

Taktové čáry

Změna typu taktové čáry

Taktové čáry se mění přetažením symbolu taktové čáry z palety s taktovými čarami na taktovou čáru v
notovém zápisu.

Pro skrytí taktové čáry vyberte čáru a stiskněte V, nebo zrušte zaškrtnutí Viditelná ve správci, což
může být povoleno z nabídky Pohled nebo stisknutím F8 (Mac: fn+F8).

Vytvoření systému
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Pro rozšíření taktové čáry přes více osnov dvakrát na taktovou čáru klepněte, aby ji bylo možné
upravit (viz režim úprav).

Klepněte na modrý čtvereček a táhněte jej dolů k další osnově.

Procházející taktová čára zůstane trvalá, když režim úprav opět opustíte. Jiné taktové čáry se potom
rovněž změní.

Podívejte se také na

Operace s takty

Do you have an unanswered question? Post it in the forum.

Trámce
Trámce jsou nastaveny automaticky, ale automatické nastavení je možné ručně zrušit. Přetáhněte
symbol trámce z palety s trámci na notu, u které se má změnit chování jejího trámce.

Také můžete nejprve vybrat notu, a potom dvakrát klepnout na odpovídající symbol v paletě s trámci.

 Trámec začíná na této notě.

 Trámec nekončí na této notě.

 Tato nota nedostane žádný trámec.

 Na této notě začíná šestnáctinový trámec.

 Na této notě začíná dvaatřicetinový trámec.

 Zpět do automatického režimu: Režim vybraný MuseScore při vkládání noty, v závislosti na
současném taktovém označení.

62

https://musescore.org/cs/forum


 Na této notě začíná vějířovitě rozčleněný trámec (pomalejší).

 Na této notě začíná vějířovitě rozčleněný trámec (rychlejší).

Pro změnu úhlu trámce nebo vzdálenosti trámce k hlavičkám not (tedy délky nožiček) na trámec
dvakrát klepněte. Tím se přejde do režimu úprav a je vybrán pravý koncový úchop. Klávesami šipek
nahoru/dolů lze nyní úhel měnit. Výběrem levého koncového úchopu a za použití kláves šipek
nahoru/dolů lze nožičky not prodloužit případně zkrátit. Až budete s úpravami hotovi, stiskněte Esc pro
opuštění režimu úprav.

Pro přesunutí trámce z umístění nad notovou hlavičkou dolů pod ni, anebo obráceně, obraťte směr
nožiček pomocí tlačítka, které je v druhém pruhu nástrojových panelů (před ukazateli hlasů), jež
ukazuje notovou hlavičku s nožičkami připojenými nad a pod ní, nebo použijte klávesu X.

Podívejte se také na

Trámce přes osnovy
Režim úprav
Vkládání not
Jak přidat trámec přes pomlku
Jak umístit trámec mezi noty

Do you have an unanswered question? Post it in the forum.

Závorky

Smazání

Vyberte závorku a stiskněte Del

Přidání

Přetáhněte symbol závorky z palety se závorkami na prázdné místo v prvním taktu osnovy.

Změnění

Přetáhněte symbol závorky z palety se závorkami na závorku v notovém zápisu.

Upravení

Dvakrát klepněte na závorku pro vstoupení do režimu úprav. V režimu úprav můžete tažením změnit
výšku závorky, aby se závorka roztáhla na více notových osnov osnovy.

Vodorovný posun

Pokud závorku potřebujete posunout doleva nebo doprava, dvakrát klepněte na závorku pro vstoupení
do režimu úprav a stiskněte Shift+← nebo Shift+→.

Do you have an unanswered question? Post it in the forum.

Nádechy a přestávky
Pro umístění symbolu pro nádech jej přetáhněte z palety s nádechy a přestávkami na notu v notovém
zápisu. Symbol pro nádech je umístěn za notou.
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Symbol pro nádech v notovém zápisu:

Caesury se umísťují stejným způsobem.

Do you have an unanswered question? Post it in the forum.

Klíče
Klíče se vytváří nebo mění přetažením symbolu klíče z palety s klíči na takt nebo jiný klíč. Použijte F9
(Mac: ⌥+⌘+K) pro ukázání nebo skrytí palety.

Poznámka: Některé klíče jsou dostupné jen v hlavní paletě.

Přidání

Přetáhněte klíč z palety s klíči na prázdné místo v taktu. Tím se na začátku taktu vytvoří klíč.

Přetáhněte klíč na notu pro vytvoření klíče uvnitř taktu. Klíče, které nestojí v prvním taktu na začátku
osnovy, se kreslí menší. Příkladem je notový zápis klavíru, v němž horní osnova začíná houslovým
klíčem, ale tento se pak hned mění na basový klíč, a pak se po jedné notě a jedné pomlce vrací opět
zpět na houslový klíč.

Poznámka: Když je klíč umístěn na notu (a zvláště na první notu), zůstává zachováno tam přítomné
'upozornění na změnu klíče'.
Když chcete vidět, zda se změna klíče myší ukotví ve správné poloze, zda se použije na notu nebo na
takt, dejte pozor na změnu barvy hlavičky noty. Notová hlavička, před kterou se má vložit změna klíče,
zčervená.
Také můžete nejprve vybrat notu nebo takt, a potom v paletě na klíč dvakrát klepnout, abyste zajistili,
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že se změna nachází na správné notě.

Odstranění

Vyberte klíč a stiskněte Del.

Poznámky:

Změna klíče nemění výšku tónu následující noty. Namísto toho se noty posunou tak, aby
zachovaly výšku tónu. Odpovídají novému klíči.
Zvláštní nebo zřídka používané klíče nejsou v paletě ve výchozím nastavení ukázány, nýbrž se
místo toho nachází ve výše uvedené hlavní paletě.

Do you have an unanswered question? Post it in the forum.

Notový zápis bubnů

This translation is outdated, see the English version for a reference: Drum notation

Příklad notového zápisu bubnů:

Notový zápis bubnů často obsahuje současně se vyskytující noty s nožičkami nahoru a dolů. Pokud
nejste obeznámen s vytvářením a úpravami více hlasů v jedné osnově, potom se pro přehled
podívejte na hlasy. Níže se podívejte na pokyny, jež jsou zvláštní pro notový zápis bubnů.

Zařízení MIDI

Nejjednodušším způsobem, jak do vašeho notového zápisu přidat notový zápis bubnů, vede přes
klávesnici zařízení MIDI (keyboard). Většina těchto zařízení MIDI má značky pro bicí nad
odpovídajícími klávesami. Pokud stisknete klávesu pro hajtku, je MuseScore vložena do notového
zápisu správná nota. Přitom se MuseScore automaticky stará o hodící se směr notové nožičky a
odpovídající typ notové hlavičky.

Klávesnice počítače

Ve výchozím nastavení je ke klávesovým zkratkám přiřazeno sedm bubnových zvuků (A-G) a
přemapovat na jiné nástroje bicích můžete jen těchto sedm klávesových zkratek (nebo změnit jiné
vlastnosti obsahu palety bubnů) přes tlačítko Upravit bicí sadu nástroje pro vkládání bicích (viz
→níže).
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Pokud si přejete ve stejné poloze zadat novou notu bicích, jako je stávající nota - například pokud jste
chtěl, aby zněly velký buben a hajtka současně - a novou notu jste zadal přes klávesnici počítače,
budete při zadávání nové noty potřebovat podržet Shift, aby nedošlo k přepsání stávající noty. Toto je
stejný postup, jaký se používá při zadávání akordů pro naladěné nástroje pod MuseScore.

Myš

Zadávání myší pro noty bez absolutních výšek tónů nepracuje tak, jak to známe u jiných nástrojů. Zde
jsou proto odpovídající zvláštní kroky:

1. Vyberte notu nebo pomlku v taktu osnovy bicích
2. Stiskněte N pro přechod do režimu vkládání not

Všimněte si, prosím, že nástroje pro vkládání bicích se objeví, až když tento krok dokončíte:

3. Vyberte dobu trvání noty z nástrojového panelu pro vkládání not
4. Vyberte typ noty (například velký buben nebo malý buben) z nástroje pro vkládání bicích
5. Klepněte na takt v osnově bicích pro přidání noty do notového zápisu

Bicí sada

Bicí sady jsou uloženy jako soubory .drm, ale vlastní úpravy je možné uložit a nahrát do jiných.

Vnější odkazy

Videonávod: MuseScore ve chvilce: Lekce 7 - Tabulatura a notový zápis bubnů
Bicí [video]
Upravování palety bicích v MuseScore 1.1 [video]
Ukládání změn v bicích sadách v MuseScore 1.1 [video]
Průvodce notovým zápisem bubnů a bicích nástrojů
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Do you have an unanswered question? Post it in the forum.

Ozdoby
Krátké ozdoby (Acciaccatura) se zapisují jako malé noty s přeškrtnutou nožičkou. Dlouhé ozdoby
(Appoggiatura) nejsou přeškrtnuty. Obě ozdoby jsou umístěny před hlavní notu, která má obvyklou
velikost.

Pokyny

Noty ozdob se vytvářejí přetažením symbolu ozdoby z palety s ozdobam na hlavní notu v notovém
zápisu. Ozdobu je rovněž možné vytvořit výběrem notové hlavičky a dvojím klepnutím na symbol
ozdoby z palety s ozdobami.

Pro vytvoření více než jedné ozdoby přetáhněte po sobě jdoucí ozdoby na hlavičku noty.

Pro přidání akordu ozdob zadejte první ozdobu a vyberte ji. Potom použijte Shift+ názvy not (C, D, E
atd.)

Pokud chcete změnit dobu trvání předtím vytvořené ozdoby, označte ji klepnutím na ni, a vyberte
dobu trvání v nástrojovém panelu nebo zadejte jednu z kláves 1 ... 9 (viz vkládání not).

Ozdoby po notě (např. ukončení trylku) musí být umístěny ručně pomocí klávesy Ctrl + klávesy šipek.

Vnější odkazy

Ozdoba na Wikipedii
Appoggiatura na Wikipedii
Acciaccatura na Wikipedii

Do you have an unanswered question? Post it in the forum.

Svorky
Svorky jsou jako předměty linky. Pro vytvoření svorky nejprve vyberte notu pro označení začátečního
bodu.

<: Vytvoří svorku crescenda
>: Vytvoří svorku diminuenda (decrescendo)

Svorky také můžete vytvořit přetažením symbolu svorky z palety s linkami na hlavičku noty.

1. < vytvoří svorku crescenda:

2. Dvojité klepnutí přepne do režimu úprav.
Potom vyberte (klepněte na) koncový bod k posunutí:
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3. Shift+→ posune kotvu vybraného koncového bodu:

4. → a Ctrl→ posune vybraný koncový bod:

Do you have an unanswered question? Post it in the forum.

Předznamenání
Předznamenání se vytváří nebo mění přetažením symbolu předznamenání z palety s
předznamenáními na takt nebo stávající předznamenání.

F9 (Mac: fn+F9) přepne okno palety.

Nahrazení stávajícího předznamenání

Přetáhněte předznamenání z palety přímo na označení předznamenání v notovém zápisu. Pokud
předznamenání chcete změnit jen pro jednu notovou osnovu notového zápisu (což může být
například v současné hudbě), stiskněte při tažení předznamenání na osnovu ke změnění Ctrl (Mac:
⌘).

Přidání nového předznamenání

Přetáhněte předznamenání z palety na prázdné místo taktu. To předznamenání umístí na začátek
taktu. Pokud chcete nové předznamenání přidat jen pro jednu notovou osnovu notového zápisu (což
může být například v současné hudbě), stiskněte při tažení předznamenání na tuto osnovu Ctrl (Mac:
⌘).

Odstranění předznamenání

Klepněte na stávající předznamenání a stiskněte Del, nebo přetáhněte prázdné předznamenání z
palety (v pokročilé ploše, zcela vpravo dole v paletě) na odpovídající takt.

Upozornění na změnu předznamenání

Ve Správci je pro vybrané předznamenání volba Ukázat upozornění na změnu. Dotatečně se v
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nabídce Styl → Obecné... → Strana nachází volba Vytvořit upozornění na změnu předznamenání.
Jsou tu volby, přes které můžete nastavit, kdy a jak se předznamenání používají. Ve Správci můžete
změnit jen právě vybraný prvek, zatímco změny ve vlastnostech stylu účinkují na celý notový zápis.

Odrážky při změně předznamenání

Můžete vybrat, zda se mají za určitých okolností, když se mění předznamenání, ukazovat odrážky.
Pod Styl → Obecné... → Posuvky jsou uvedeny volby:

NOT FOUND: Key_signature-Naturals_en.png

Můžete použít změny, nebo klepnout na OK. Když pracujete v jednotlivém (propojeném) hlase a ne v
hlavním notovém zápisu, můžete změnu odpovídajícím tlačítkem rozšířit na všechny ostatní hlasy.

V tomto případě jsou při změně tóniny ukazovány odrážky.

Předznamenání a vícetaktové pomlky

Vícetaktové pomlky jsou přerušeny, pokud dojde ke změně předznamenání.

Podívejte se na vícetaktovou pomlku

Upozornění na změnu předznamenání a zalomení úseku

Upozornění na změnu předznamenání se nebude ukazovat krátce před zalomením úseku.
Podívejte se na Break or spacer: Section break

Vlastní předznamenání

Stiskněte Shift+K k ukázání celkové palety/tónin.

69

https://musescore.org/sites/musescore.org/files/Multimeasure_rest_key_and_time_signature.png
https://musescore.org/sites/musescore.org/files/Multimeasure_rest_key_and_time_signature.png


Můžete zde dokonce vybrat předznamenání (křížky, béčka) o velikosti čtvrtiny tónu atd.

Uvědomte si ale, že v současnosti není přehrávání vlastních předznamenání podporováno.

Do you have an unanswered question? Post it in the forum.

Linky
Paleta s linkami pracuje stejně jako ostatní palety, způsobem táhni a pusť. Pro přetažení prvků z
palety použijte myš. Upusťte ji na notový zápis tam, kde si to přejete. Jako u všech palet závisí to,
které a kolik položek je viditelných, na používané

Nonexistent node nid: 39841.
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. Zde je obsah palety v pokročilé pracovní ploše:

Změna délky

Pokud délku prvku linky měníte pomocí myši, potom se poloha kotvy nemění, což znamená, že linka
se orientuje na tutéž notu. Pro posun začátečního a koncového bodu linky se vám doporučuje
následující postup.

1. Pokud jste v režimu vkládání not, stiskněte Esc pro opuštění vkládání not
2. Dvakrát klepněte na linku, kterou chcete změnit
3. Posuňte úchopy pomocí následujících zkratek

Shift+→ pro posunutí kotvy doprava o jednu notu (nebo takt)
Shift+← pro posunutí kotvy doleva o jednu notu (nebo takt)

4. Pokud délku potřebujete změnit viditelně beze změny not nebo taktů, k nimž je linka ukotvena,
použijte následující zkratky :

→ pro posunutí úchopu doprava o jednu jednotku
← pro posunutí úchopu doleva o jednu jednotku

Podívejte se také na

Svorky
Volta (opakování)
Funkce pro starou hudbu, tónový rozsah)

Do you have an unanswered question? Post it in the forum.

Pomlky

Celotaktová pomlka

Když takt neobsahuje žádné noty, použije se celotaktová pomlka.
Celotaktová pomlka vypadá jako celá pomlka (semibrevis), kromě toho že celotaktová pomlka je stále
vystředěna uprostřed taktu a že místo toho, aby vždy odpovídala čtyřem dobám, představuje to, co je
jakákoli délka taktu v příslušném druhu taktu.
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Pro vytvoření celotaktové pomlky vyberte takt a stiskněte Del. Všechny noty a pomlky v tomto taktu
jsou odstraněny a nahrazeny celotaktovou pomlkou.

Vícetaktová pomlka

Pomlky, které se roztahují přes vícetaktů, se obvykle používají u jednotlivých hlasů, kde ukazují delší
odmlku nástroje, a často se používají v orchestrální hudbě
Jsou automaticky přerušeny na důležitých místech, jako jsou dvojité taktové čáry, zkušební značky,
předznamenání nebo taktová označení atd.
Číslo nad vícetaktovou pomlkou ukazuje, kolik taktů vícetaktová pomlka zahrnuje.

Poučení

1. V nabídce vyberte Styl → Obecné...
2. Na levé straně klepněte na kartu Notový zápis, pokud již není vybrána
3. Zaškrtněte Vytvořit vícetaktové pomlky

Omezení

Tato volba stylu v celém notovém zápisu automaticky spojuje po sobě následující prázdné takty do
vícetaktových pomlk. Proto se doporučuje nejprve zadat všechny noty, a teprve potom zapnout tento
přepínač k vytvoření vícetaktových pomlk.

Zalomení vícetaktových pomlk

Podívejte se také na: Measure operation: Break multi-measure rest

Případně můžete chtít mít jednu dlouhou vícetaktovou pomlku rozdělenu do dvou kratších
vícetaktových pomlk.

Tato volba by se měla zaškrtnout před zapnutím volby Vytvořit vícetaktové pomlky přes Styl →
Obecné..., na kartě Notový zápis.
Vyberte první takt, jímž má začínat druhá vícetaktová pomlka, a pak klepněte pravým tlačítkem myši
na Vlastnosti taktu → Zalomit vícetaktovou pomlku.

Všimněte si, že vícetaktové pomlky jsou automaticky přerušeny, když se uvnitř nachází zkušební
značka (ne jednoduchý text), zalomení úseku, změna předznamenání nebo taktového označení, nebo
dvojitá taktová čára.

Do you have an unanswered question? Post it in the forum.

Opakování
Začátek a konec jednoduchých opakování lze určit nastavením příslušných taktových čar. Když má
být opakování napodruhé zahráno o něco jinak, je možné varianty označit voltou.

Přehrávání

Abyste během přehrávání opakování uslyšeli, ujistěte se, že je v nástrojovém panelu vybráno tlačítko

pro přehrávání opakování . Zrušením jeho výběru se při přehrávání opakování vypne.

V posledním taktu opakování můžete ve vlastnostech taktu nastavit počet opakování, který určí počet
přehraných opakování. Označte taktovou čáru opakování, klepněte na prázdné místo v taktu a po
klepnutí pravým tlačítkem myši otevřete nabídku Vlastnosti taktu. Vpravo dole se nachází Počet
opakování.

Symboly opakování a text

Texty a symboly vztahující se k opakování se nacházejí v paletě s opakováními.
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Tato paleta obsahuje symboly pro opakování taktu, Segno a Coda. Také obsahuje texty pro 'D.S.',
'D.C.', a Fine:

Pro přidání předmětu z palety s opakováními jej přetáhněte na (ne nad) takt, kde chcete, aby se
objevil. Předmět se v notovém zápisu objeví nad tím taktem.

Skoky

Skoky obecně sestávají ze tří kroků:

Skočit na značku
Přehrát po značku
Pokračovat od značky

Značky jsou názvy, které dáme nějaké poloze taktu. Dvě skokové značky (Začátek, Konec) označují
začátek a konec notového zápisu a není je třeba přidávat zvlášť.

Příklady:

Při příkazu pro skok Da Capo přehrávání skočí na začátek, a potom je celý notový zápis přehrán ještě
jednou znovu (až po značku pro konec).

Při příkazu pro skok Da Capo al Fine přehrávání skočí na začátek, a notový zápis je pak přehrán po
značku Fine.

Dal Segno al Fine (nebo D.S. al Fine) skočí na značku Segno, a notový zápis je pak přehrán po
značku Fine

Dal Segno al Coda skočí na značku Segno, a notový zápis je pak přehrán po první značku Coda.
Přehrávání potom pokračuje na druhé značce Coda. Vlastnosti skoků se nastavují klepnutím pravým
tlačítkem myši na značce D.S. al Coda.

Podívejte se také na

Volta
Jak oddělit codu od zbytku notového zápisu

Vnější odkazy

Videonávod: Cody

Do you have an unanswered question? Post it in the forum.

Legato
Legato je zahnutá čára mezi dvěma nebo více notami, která naznačuje, že se tyto noty mají přehrát
spojitě. Když byste chtěli spojit dvě noty s toutéž výškou tónu, podívejte se na ligaturu

První způsob

1. Opusťte režim vkládání not a vyberte první notu:
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2. Vytvořte oblouček legata stisknutím klávesy S:

3. Shift+Right posune konec obloučku legata k další notě:

4. X obrátí směr obloučku. Tak můžete vybrat, zda se oblouček objeví nad nebo pod notou:

5. Esc ukončí režim úprav legata:

Druhý způsob

1. Opusťte režim vkládání not a vyberte první notu:
2. Ctrl- vybrat (resp.⌘- vybrat na Mac) nebo Shift- vybrat poslední notu
3. Stiskněte S

Třetí způsob

1. V režimu vkládání not zadejte první notu části s legatem
2. Stiskněte S pro započetí části s legatem
3. Zadejte zbývající noty části s legatem
4. Stiskněte znovu klávesu S pro ukončení části s legatem

Úpravy

Pro dodatečné upravení již přítomného legata můžete dvojitým klepnutím na legato přejít do režimu
úprav. Čtverečky neboli úchopy spojené modrými čárami (zobrazené na obrázcích pro kroky 2-4 výše)
lze upravovat myší. Dva vnější úchopy upravují začátek a konec obloučku legata. Dva vnitřní úchopy
upravují obrys (výšku) popřípadě polohu obloučku legata.

Oblouček může překlenout více osnov nebo dokonce stran. Začátek a konec obloučku je ukotven k
notě/akordu nebo pomlce. Pokud noty změní polohu kvůli změnám v rozvržení, protažení nebo stylu,
oblouček legata se také posune a jeho velikost se přizpůsobí.

Tento příklad ukazuje oblouček legata, který sahá od basového k houslovému klíči. Pomocí myši
vyberte první notu legatového obloučku, podržte klávesu Ctrl (případně klávesu ⌘ u Mac) a vyberte
poslední notu pro legatový oblouček, a stiskněte S pro přidání obloučku legata.
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Poznámka: Není možné změnit začáteční a koncový kotevní bod pomocí myši. Použijte Shift⇑ + ←
nebo → pro úpravu začátečního a koncového bodu obloučku legata.

Tečkovaná/čárkovaná čára

Tečkované nebo čárkované legatové obloučky se často používají v písních s více slokami, kvůli
zobrazení rozdílů v rozdělení slabik jednotlivých slok. Tečkované nebo čárkované legatové obloučky
se také používají, aby vyjádřily vydavatelův návrh (aby umožnily rozdílné zobrazení oproti
skladatelově původnímu značení obloučků legat). Pro změnu stávajícího legatového obloučku na
tečkovaný nebo čárkovaný oblouček na něj klepněte pravým tlačítkem myši, a potom ve správci,
kterého spustíte stisknutím klávesy (F8), změňte Typ linky ze Spojitá na Tečkovaná nebo Čárkovaná.

X změní směr vybraného legatového obloučku.

Podívejte se také na

Ligatura
Režim úprav
Vkládání not

Do you have an unanswered question? Post it in the forum.

Ligatura
Ligatura je zahnutá čára mezi dvěma nebo více notami o stejné výšce tónu. Pokud chcete zahnutou
čáru, která se klene přes více výšek tónů, podívejte se na legato.

První způsob

Vyberte první notu:

+ vytvoří ligaturu:

(klávesa + nebo pomocí tlačítka pro ligaturu  umístěné v nástrojovém panelu pro vkládání not
nahoře napravo od notových hodnot)

Druhý způsob

Pro vytvoření ligatury během vkládání not stiskněte + nebo tlačítko pro ligaturu  po první notě
ligatury.

Spojené akordy
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Pro přidání ligatury mezi dva akordy vyberte nožičku prvního akordu, nebo stiskněte Shift + klepněte

na první akord, a pak stiskněte + nebo tlačítko pro ligaturu . Režim vkládání not přitom nesmí být
zapnut.

Obrácení ligatury

X obrátí (svislý) směr vybrané ligatury.

Do you have an unanswered question? Post it in the forum.

Taktová označení
Taktová označení jsou dostupná v postranním panelu s paletami. Taktová označení můžete
přetáhnout na notový zápis (viz palety pro obecné informace o práci s paletami v MuseScore).

Vytvoření vlastního taktového označení

Pokud potřebujte druh taktu, které není v paletě odpovídající pracovní plochy, otevřete hlavní paletu
přímo v části s taktovými označeními (ShiftT) a vytvořte si svůj vlastní. Čitatele a jmenovatele můžete
upravit v panelu Vytvořit taktové označení stisknutím tlačítka Přidat. Jakmile je vytvořeno, taktové
označení jednoduše přetáhněte z okna, kde jste je vytvořil, na notový zápis, kde je upusťte. Všimněte
si, že nové taktové označení se v paletě pracovní plochy neobjeví. Pokud je do palety chcete přidat,
přečtěte si o vlastních paletách.

Změna výchozích trámců

Pro upravení trámců z automatické nabídky můžete klepnout na noty, jež chcete změnit.

Například: Ve výchozím nastavení má 5/8 trámce ve složení 3+2. Můžete klepnout na třetí a pak na
čtvrtou notu, aby to bylo 2+3. Nezapomeňte to udělat i pro jiná dvě pododdělení. Pro upravení třetího

přetáhněte ikonu z  na správnou notu. V tomto příkladu byla ikona pro začátek trámce
přetažena na devátou notu a ikona pro šestnáctinový trámec byla přetažena na třináctou notu.

76

https://musescore.org/cs/forum


Smazání taktového označení

Taktová označení, která už dál nepotřebujete, lze odstranit v dialogovém okně popsaném výše
klepnutím pravým tlačítkem myši → Smazat obsah.

Úpravy součtových meter

Ve většině případů potřebujete upravit jen první z horních čísel. Sčítaná horní čísla jsou pro součtová
metra, která obsahují více horních čísel oddělených znaménkem plus.

Doby trvání rozdílné od taktového označení: Předtaktí a kadence

Jsou případy, kdy se skutečná doba trvání taktu liší od doby trvání určené taktovým označením.
Častým příkladem takové situace je předtaktí. Jak změníte skutečnou dobu trvání taktu, aniž by se
zobrazilo jiné taktové označení, se dočtete v operacích s takty: vlastnosti, doba trvání taktu.

Místní taktová označení

Taktová označení mohou být různá pro různé notové osnovy. Příkladem zde jsou 26. Goldbergovy
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variace od Johanna Sebastiana Bacha:

MuseScore má pojetí celkového taktového označení a skutečného (místního) taktového označení. Pro
změnu celkového taktového označení předmět z palety táhněte a upusťte na notovou osnovu. Celkové
taktové označení se používá na počítání dob (jak je to ukázáno ve stavovém řádku) a odkazuje na
značky tempa. Celkové taktové označení je stejné pro všechny osnovy a obyčejně se shoduje se
skutečným taktovým označením.

Skutečné taktové označení je nastaveno v dialogu vlastností taktového označení a může se pro
každou osnovu odchýlit od skutečného taktového označení (v příkladu je to vidět u levé ruky 18/16).

NOT FOUND: Time_Signature_Properties_en.png

Text taktového označení lze nastavit nezávisle na skutečných hodnotách.

Místní taktové označení se nastaví upuštěním symbolu pro taktové označení při podržení klávesy Ctrl.
Místní taktové označení je nastaveno pouze pro jednu osnovu. Celkové taktové označení je
zkopírováno pro všechny osnovy.

Změny taktového označení a jiné předměty

Zalomení více taktů jsou přerušena, když se vyskytne změna taktového označení.
Takže zalomení úseku zabrání ukázání upozornění na změnu taktového označení na konci
předchozího taktu.

Podívejte se také na

Celotaktová pomlka
Zalomení a odstup

Do you have an unanswered question? Post it in the forum.

Transpozice
Transpozice je přesun vybraných tónů v osnově výše nebo níže. MuseScore podporuje několik druhů
transpozice.

Chromatická transpozice k tónině

Chromatická transpozice přesune jednu nebo více not nahoru nebo dolů po půltónech. Jděte do
hlavní nabídky Noty → Transponovat... a vyberte, do které nejbližší vyšší nebo nižší tóniny se má
převod provést.

Chromatická transpozice o interval

Chromatická transpozice přesune jednu nebo více not nahoru nebo dolů po půltónech. Jděte do
hlavní nabídky Noty → Transponovat.... Tam klepněte na O interval, a potom z vyskakovací nabídky
vyberte interval, o který se má nahoru nebo dolů převést.
Výběr not také můžete převést pomocí kláves směrových šipek (↑ nebo ↓).

Stupnicová (diatonická) transpozice
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Diatonická transpozice přesouvá noty v nynější stupnici nahoru nebo dolů podle předznamenání.
Můžete přesunout jednu notu jejím táhnutím myší nahoru nebo dolů. Můžete přesunout výběr více not
pomocí Ctrl + klepnutí a tažení.

Transponující nástroje

Některé nástroje, jako je například B trubka nebo altový saxofon, jsou známy jako transponující
nástroje. Tyto nástroje zní níže nebo výše, než jak jsou zapsány. MuseScore má vestavěnou podporu
pro transponující nástroje.

Tlačítko pro koncertní ladění a v hlavní nabídce Noty → Koncertní ladění umožňují přepínání mezi
koncertním laděním (znějícím notovým zápisem) a transponujícím notovým zápisem (transponováním
výšek tónů). Koncertní ladění pomáhá skladatelům a aranžérům, protože všechny nástroje zobrazuje
ve stejném klíči, takže v notové osnově zobrazené noty představují svůj skutečný zvuk. Když je
koncertní ladění vypnuto, může se stát, že noty některých notových osnov neukazují skutečný zvuk
nástrojů. Hráč transponujícího nástroje ovšem může z takového zápisu nástroje ihned hrát. Pokud
máte během vkládání not zapnuto koncertní ladění, nezapomeňte je před tiskem jednotlivých hlasů
opět vypnout.

Transpozice pro transponující nástroje jsou v MuseScore již přednastaveny. Pokud je však potřeba
ojedinělý nástroj nebo transpozice, která v MuseScore není dostupná, můžete se pustit i do ruční
úpravy tohoto nastavení. Klepněte pravým tlačítkem myši na prázdné místo v notové osnově a vyberte
Vlastnosti notové osnovy.... Při dolním konci okna můžete vybrat interval, o který se provede
převod, všechny posuny oktáv a směr:

Nahoru: Zvuk zní výše, než jak je zapsán
Dolů: Zvuk zní níže, než jak je zapsán

Podívejte se také na

Jak transponovat

Do you have an unanswered question? Post it in the forum.

Tremolo
Tremolo je rychlé opakování jedné noty nebo rychlé střídání dvou či více not. Znázorňuje se jedním až
třemi šikmými tahy jdoucími přes nožičky not. Pokud je tremolo mezi dvěma nebo více notami, jsou
proužky kresleny mezi nimi.

Paleta s tremoly obsahuje samostatné symboly pro

jednonotová tremola (značky tremol s notovými nožičkami) a pro
dvounotová tremola (značky tremol bez notových nožiček).

Pro přidání tremola nožičce jedné noty vyberte její notovou hlavičku a dvakrát klepněte na
požadovanou značku tremola v paletě s tremoly.

Ve dvounotovém tremolu má každá nota hodnotu celé doby trvání tremola. Pro zadání tremola s
dobou trvání půlové noty nejprve zadejte dvě čtvrťové noty. Po přetažení symbolu tremola na první
notu se hodnoty not automaticky zdvojí na půlové noty.

Do you have an unanswered question? Post it in the forum.

Nepravidelné rytmické skupiny
Nepravidelné rytmické skupiny (n-toly) se používají pro psaní rytmů jdoucích mimo rozdělení dob,
jak je běžně dovoluje taktové označení. Například nepravidelná rytmická skupina osminových not v 4-
4 taktu rozděluje dobu čtvrťové noty na tři místo na dvě. Nepravidelné rytmické skupiny se zapisují
jako malá čísla pod nebo nad skupinou not, podle volby se označují hranatými závorkami. Příklady
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nepravidelných rytmických skupin jsou duola, triola a kvintola.

Pokyny

Když chcete vytvořit triolu, vytvořte nebo vyberte v notovém zápisu nejprve notu, která stanovuje
celkovou dobu trvání trioly. Například triolová skupina osminových not má celkovou dobu trvání jedné
čtvrťové noty.

V hlavní nabídce vyberte Noty → Nepravidelné rytmické skupiny → Triola. Vybraná nota je
proměněna na triolu rozdělením celkové doby trvání na tři stejné části.

Tyto části lze dále upravovat.

Režim vkládání not

Zadávání nepravidelných rytmických skupin pracuje lehce odlišně v režimu vkládání not než postup
popsaný výše. Musíte nejprve vybrat dobu trvání, a potom zadat výšky tónů. Níže je krok za krokem
popsán postup, jakým uděláte triolové osminové noty.

1. Přepněte do režimu vkládání not a stiskněte N
2. Ujistěte se, že se značka pro vkládání nachází na místě, kde chcete, aby triola začínala (v

případě potřeby použijte pro pohyb značky směrové šipky doprava a doleva)
3. Vyberte dobu trvání celé triolové skupiny v nástrojovém panelu pro vkládání not. Pro tento

příklad klepněte na čtvrťovou notu (nebo stiskněte 5 na klávesnici)
4. V hlavní nabídce vyberte Noty → Nepravidelné rytmické skupiny → Triola, nebo stiskněte

Ctrl+3 (Mac: ⌘+3)
5. Všimněte si, že pro vkládání byly automaticky vybrány osminové noty. Nyní noty zadejte.

Klepněte na osnovu pro přidání výšek tónů, nebo je zadejte pomocí klávesnice počítače nebo
zařízení MIDI

Vlastnosti

Pro změnu vlastnosti zobrazení trioly klepněte pravým tlačítkem myši na číslo nepravidelné rytmické
skupiny nebo na závorku a použijte správce (F8).
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Pokud není ukázáno ani číslo ani závorka, vyberte notu v nepravidelné rytmické skupině, a potom
použijte tlačítko pro nepravidelnou rytmickou skupinu ve správci, abyste viděli dialog výše.

Pro Směr zvolte Automaticky pro umístění závorky na stejnou stranu notové hlavičky, jako je nožička
nebo trámec. Vyberte Nahoru nebo Dolů pro výslovné umístění závorky nad nebo pod notovou
hlavičku, v tomto pořadí, bez ohledu na polohu nožičky nebo trámce.

Pro Typ čísla zvolte Číslo pro ukázání celého čísla, Poměr pro ukázání poměru dvou celých čísel,
nebo Nic, aby se neukazovalo vůbec žádné číslo.

Pro Typ závorky zvolte Automaticky pro skrytí závorky pro noty opatřené trámcem a pro ukázání
závorky, pokud nepravidelná rytmická skupina zahrnuje noty nebo pomlky bez trámců. Zvolte Závorka
nebo Nic pro výslovné ukázání nebo skrytí závorky, v uvedeném pořadí.

Pokud přesunete závorku nebo číslo nepravidelné rytmické skupiny, uvidíte, že je aktualizován svislý
a vodorovný posun (výchozí posuny 0sp pro oba).

NOT FOUND: insepector2.png

Výchozí nastavení můžete obnovit pomocí tlačítka šipky pro navrácení napravo.

NOT FOUND: insepector_restoredafaultsettings.png

Styl

Jděte do Styl → Obecné... a vyberte Nepravidelné rytmické skupiny. To vám umožní měnit veškeré
vlastnosti nepravidelných rytmických skupin.
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Jsou možné dvě úpravy: svislá a vodorovná

Svislá úprava má tři volby s hodnotami v jednotkách mezery (sp) a jednu (ne)zaškrtnutou volbu
Největší sklon: Výchozí hodnota je 0.50; rozsah je od 0.10 do 1.00
Svislá vzdálenost od nožičky (viz (2) níže): Výchozí hodnota je 0.25; rozsah je od -5.00 do
5.00
Svislá vzdálenost od notové hlavičky (viz (3) níže): Výchozí hodnota je 0.50; rozsah je od -
5.00 do 5.00
Vyhnout se osnovám: Ve výchozím nastavení odfajfknuto

Vodorovná úprava má čtyři volby s hodnotami v jednotkách mezery (sp)
Vzdálenost před nožičkou první noty (viz (5) níže): Výchozí hodnota je 0.50; rozsah je od -
5.00 do 5.00
Vzdálenost před hlavičkou první noty: Výchozí hodnota je 0.00; rozsah je od -5.00 do 5.00
Vzdálenost po nožičce poslední noty (viz (6) níže): Výchozí hodnota je 0.50; rozsah je od -
5.00 do 5.00
Vzdálenost po hlavičce poslední noty: Výchozí hodnota je 0.00; rozsah je od -5.00 do 5.00

Podívejte se také na

Jak vytvořit trioly a další n-toly

Vnější odkazy
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Nepravidelná rytmická skupina na Wikipedii
Jak vytvořit trioly v MuseScore [video]
Průvodce uživatele triolami v MuseScore [video]

Do you have an unanswered question? Post it in the forum.

Hlasy

This translation is outdated, see the English version for a reference: Voices

Hlasy vám umožňují mít v jedné notové osnově noty, které začínají ve stejnou dobu, ale mají odlišné
doby trvání. V jedné osnově lze zapsat až čtyři hlasy v nezávislých rytmech. V jiných notačních
programech se hlasům někdy říká vrstvy.

Ve vícehlasém taktu bere hlas 1 obvykle noty s nožičkami nahoru a hlas 2 bere noty s nožičkami dolů.

Kdy jsou potřeba hlasy

Když potřebujete mít v jedné notové osnově nožičky not v akordu v opačných směrech.
Když potřebujete mít v jedné notové osnově noty o různé době trvání přehrávány současně.

Pokyny

Začněte nejprve zadáním horního hlasu (to jsou všechny noty, jejichž nožičky později mají směřovat
nahoru, jak vidíte v obrázku výše). Při zadávání ještě jejich nožičky mohou směřovat dolů. V tomto
okamžiku se o směr nožiček nemusíte starat, protože se jejich směr změní automaticky, až přidáte
druhý hlas.

Pokud místo myši pro zadávání not používáte klávesnici počítače nebo zařízení MIDI (keyboard),
použijte pro posunutí značky pro zadávání zpět na začátek klávesu ←). Pokud na umísťování not v
osnově používáte myš, toto není nutné.

Klepněte na tlačítko Hlas 2  (v nástrojovém panelu napravo).

Zadejte všechny noty dolního hlasu (všechny noty, jejichž nožičky mají jít dolů). Když jste se
zadáváním hotovi, měl by notový zápis vypadat podobně jako tento:

Všimněte si, že musíte být, abyste mohl vybrat další hlas, v režimu vkládání not.

Skryté pomlky (držitel místa)

Pouze pomlky hlasů 2, 3 a 4 lze smazat, ale pomlky v hlavním hlasu (1 - modrá) je možné skrýt.

Pro skrytí pomlky klepněte na pomlku pravým tlačítkem myši a vyberte ji nebo stiskněte V nebo ve
správci zrušte zaškrtnutí Viditelná, což lze povolit v hlavní nabídce Pohled nebo klávesovou zkratkou
F8 (Mac: fn+F8). Pokud máte zaškrtnuto Ukázat neviditelné v hlavní nabídce Pohled, pak se na vaší
obrazovce pomlka stále ještě ukazuje jako neviditelná. Skryté pomlky vidíte zbarveny šedě. Skrytá
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pomlka se při tisku nebo vyvádění do formátů, jako jsou PDF, PNG, SVG a další, neobjevuje.

Výměna hlasů not

1. Vybrat rozsah not
2. Úpravy → Hlasy
3. Vyměnit kterékoli dva hlasy

Poznámka: Výběr může zahrnout obsah všech hlasů, ale najednou budou zpracovány pouze dva.

Podívejte se také na

Jak slučovat/spojovat/hroutit dvě osnovy do jedné se dvěma hlasy
Jak zadávat více not v notové osnově s různými dobami trvání
Jak dělat noty v překrytí primy

Vnější odkazy

Videonávod: Jak psát dva hlasy v jedné osnově: Hlasy

Do you have an unanswered question? Post it in the forum.

Volta
Závorky Volta nebo závorky pro první a druhé zakončení se používají pro označení různých
zakončení opakování.

Pro umístění závorky volty do notového zápisu ji přetáhněte z palety s linkami.

Závorky mohou překlenovat více než jeden takt. Dvakrát na voltu klepněte pro vstup do režimu úprav,
a úchopy posuňte klávesovými zkratkami:

Shift+→ o jeden takt doprava
Shift+← o jeden takt doleva

Tyto příkazy posunou logický začátek nebo konec závorky volty, což v MuseScore určuje přehrávání a
rozvržení přes více osnov. Posunutí úchopů pouze pomocí kláves šipek doprava a doleva nebo
použití myši umožňuje jemnější úpravy, ale nemění způsob, jakým je opakování přehráváno.

Pokud pohybujete úchopy, ukazuje se čárkovaná čára jdoucí z logické polohy ke skutečné poloze

Text

Můžete změnit text a mnohé další vlastnosti závorky volty pomocí dialogu Vlastnosti linky. Klepněte na
závorku volty pravým tlačítkem myši a vyberte Vlastnosti linky.... Obrázek níže ukazuje text volty
jako 1.-5.
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Také na voltu můžete klepnout pravým tlačítkem myši a vyvolat dialog Vlastnosti volty. Zde můžete
změnit jak text volty (tentýž jako v dialogu Vlastnosti linky, který byl popsán výše) tak seznam
opakování. Pokud chcete, aby byla jedna volta přehrávána pouze při určitých opakováních a jiná volta
zase při jiných opakováních, zadejte požadovaná opakování do seznamu odděleného čárkou. V
příkladu níže bude tato volta přehrávána během opakování 1, 2, 4, 5 a 7. Další volta pak bude mít jiná
zakončení jako 3, 6, a možná jiná vyšší čísla jako 8, 9 atd.

Přehrávání

Někdy se opakování přehrává více než dvakrát. V obrázku výše ukazuje text volty, že se má přehrát
pětkrát, než se bude pokračovat. Pokud chcete změnit počet opakování, která MuseScore přehraje,
jděte na takt, který obsahuje konec opakování a změňte jeho počet opakování (na podrobnosti se
podívejte v kapitole popisující operace s takty: Jiné).
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Vnější odkazy

Videonávod: Opakování, první a druhé zakončení
Přidání alternativních opakování v MuseScore

Do you have an unanswered question? Post it in the forum.

Zvuk a přehrávání
MuseScore má vestavěnu schopnost přehrávat zvuk. Tato kapitola se zabývá ovládáním přehrávání a
způsoby, jak rozšířit zvuky nástrojů za vestavěný zvuk klavíru.

Zavedení MIDI
Zavádění MIDI se dá doladit přes panel pro zavádění MIDI, který se objeví pokaždé, když jsou v
MuseScore otevřeny soubory .mid/.midi/.kar. S tímto panelem uživatel získává citlivější řízení
zpracování výběrem stop a použitím činností na ně (např. kvantizace, použití teček/ligatur atd.).
Tlačítkem Použít (nahoře) se všechny změny odešlou, s okamžitým účinkem. Tlačítkem Zrušit se
všechny neuložené změny okamžitě zruší.

Použijte Shift+kolečko myši nebo Ctrl+kolečko myši k vodorovnému projíždění voleb pro stopu; bez
těchto modifikátorů projíždíte stopy svisle.

Výsledkem má být lepší jakost rozmnoženiny notového zápisu ze souboru.

Panel pro zavádění MIDI ukazuje seznam stop (jsou ukázány pouze stopy s událostmi not) a pro
každou stopu dostupné činnosti.

Pokud je stop více, potom je na začátek seznamu přidána jedna další stopa pro vybrání všech stop
zároveň.

V panelu lze vybrat stopy k zavedení a přeuspořádat je. Jsou zde zobrazeny také popisné informace
(zvuk, název notové osnovy a text písně - je-li jaký). Přítomnost sloupce se slovy písně je známkou
toho, že soubor obsahuje stopu s textem písně - přiřaditelnou k různým stopám přes rozbalovací
seznam, který je dostupný po klepnutí.

Činnosti (napravo) jsou přítomny ve dvojicích: název - hodnota. Na každou hodnotu se dá klepnout a
změnit ji. Může to být vysouvací seznam nebo zaškrtávací okénko (seznam dostupných voleb).
Soubor dostupných voleb se může měnit skladbu od skladby, v závislosti na jejím typu (stopa s
notami, které představují výšku tónu, nebo stopa bicích).

Panel pro zavádění MIDI obnovuje náležité údaje každého znázorněného souboru, pokud jich má
uživatel otevřeno několik. Pokud není panel pro zavádění MIDI nadále potřebný, je možné jej zavřít
klepnutím na zavírací tlačítko v levém horním rohu. Panel se znovu objeví po klepnutí na tlačítko
Ukázat panel pro zavedení MIDI, které se objeví hned po zavření panelu.

Dostupné činnosti

Nástroj MuseScore
Přiřadit nástroj MuseScore (uvedený v instruments.xml nebo v zadaném vlastním souboru xml v
Nastavení), který vymezuje název osnovy, klíč, transpozici, artikulace atd.

Kvantizace

Kvantizovat noty MIDI podle pravidelné mřížky. NEJVĚTŠÍ rozlišení mřížky lze nastavit přes
vysouvací nabídku:

Hodnota z nastavení (výchozí) - Hodnota kvantizace je vzata z hlavního dialogu Nastavení
MuseScore (na kartě Zavedení)
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Čtvrtina, osmina, šestnáctina, dvaatřicetina, čtyřiašedesátina, stoosmadvacetina -
uživatelem stanovené hodnoty
Skutečná velikost mřížky kvantizace je přizpůsobující se a zmenšuje, když je délka noty
malá.

Nejvíce hlasů
Nastaví největší počet v notách dovolených hlasů.

Hledat rytmické notové skupiny
Když je povolena, pokusí se tato volba o zjištění rytmických notových skupin a použije
odpovídající mřížku kvantizace na akordy rytmických notových skupin.

Je lidské provedení
Je-li povolena, tato volba zmenšuje přesnost převedení MIDI do notového zápisu conversion ve
prospěch čitelnosti. Je to užitečné pro nezarovnané soubory MIDI, když není poskytnuta žádná
pravidelná mřížka kvantizace. Na takové soubory se používá automatický algoritmus pro
sledování rytmu, který se pokouší o zjištění poloh taktů v celé skladbě.

2x menší počet taktů
Volba je činná pro nezarovnané soubory MIDI (když "Je lidské provedení" je zaškrtnuto ve
výchozím nastavení). Zkrátí na polovinu počet taktů obdržený při vnitřní operaci sledování
rytmu. Může to být vhodné, když dává sledování rytmu 2 krát častěji rozdělení na takty, než je
nutné.

Taktové označení
Volba je činná pro nezarovnané soubory MIDI. Uživatel může zvolit vhodné taktové označení
pro celou skladbu, pokud je výchozí zjištěná hodnota nesprávná. Volba je užitečná, protože si
správně poradí se zavedenými rytmickými notovými skupinami na rozdíl od přímého nastavení
taktového označení z palety.

Rozdělit notovou osnovu
Tato volba se hodí hlavně na klavírní stopy - k přiřazení not levé a pravé ruce účinkujícího.
Používá rozdělení stálých výšek tónů (uživatel může výšku tónu vybrat prostřednictvím
podvoleb) nebo rozdělení pohyblivých výšek tónů (závisí na šířce ruky - tak trochu dohad z
hlediska programu).
U stop bubnů (Zvuk bicích v seznamu stop) rozdělí notovou osnovu na více notových osnov,
přičemž každá dostane jen jednu výšku tónu bicích (to jest zvuk bubnu). Je tu i podvolba, která
programu povolí/zakáže hranaté závorky pro nově vytvořený soubor stop bubnů.

Změny klíče
Malé klíče mohou být vloženy uvnitř notové osnovy, aby akordy držely blíže k pěti linkám
osnovy. Změny klíče závisí na průměrné výšce tónu akordu. Svázané skupiny not nejsou
vložením klíče porušeny (pokud se to stane, lze nahlásit chybu v algoritmu v
importmidi_clef.cpp). Tato volba je dostupná jen pro stopy, které nejsou bicí.

Zjednodušit doby trvání
Zmenší počet pomlk kvůli utvoření jednodušších dob trvání not. U stop bicích může tato volba
odstranit pomlky a také prodloužit noty.

Ukázat staccato
Volba na ukázání/skrytí značek pro staccato v notovém zápisu.

Tečkované noty
Řídí, zda bude MuseScore používat tečkované noty nebo ligatury.

Ukázat text tempa
Ukáže/Skryje v notovém zápisu textové označení tempa.

Ukázat značky akordů
Ukáže/Skryje v notovém zápisu značky akordů, jsou-li, pro souborový formát MIDI XF.

Rozpoznat předtaktí
Když je povolena, tato volba nemění taktové označení prvního taktu, který je kratší než druhý
takt. Tomuto se anglicky říká anacrusis. Tato volba je použitelná jen současně na všechny stopy.

Zjistit swing
MuseScore zkouší zjistit swing - nahradit triolu [4th + 8th] dvěma běžnými osminami (pro obvyklý
swing, 2:1) nebo tečkovanou osminu + šestnáctinu také dvěma běžnými osminami (pro
zamíchání, 3:1). Také na začátku osnovy se swingowanými notami zobrazuje text Swing nebo
Zamíchání.

Do you have an unanswered question? Post it in the forum.

Změna nástroje uprostřed notové osnovy
Ve srovnání s normálním standardním textem znázorňuje Změna nástroje (pod Nástroje v paletě s
texty) rozdíly mezi různými nástroji lépe (včetně přehrávání).

V současnosti je nicméně omezením to, že na transpozice není brán zřetel.
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Vložení změny nástroje uprostřed notové osnovy

1. Vyberte počáteční bod změny

2. Použijte Nástroj z textové palety

3. Dvakrát klepněte na nově přidaný text pro jeho upravení

Všimněte si, že text samozřejmě můžete formátovat,

nebo po opuštění režimu úprav textu upravte Vlastnosti textu klepnětím pravým tlačítkem myši (text by
měl být černý a ne jasně modrý), nebo použijte Styl textu, čímž se změní vzhled označení všech
nástrojů v celém notovém zápisu.

1. Klepněte na text pravým tlačítkem myši a vyberte Změna nástroje…

2. Změňte nástroj a klepněte na OK

88



Do you have an unanswered question? Post it in the forum.

Režim přehrávání
MuseScore v sobě má sekvencer a syntetizátor pro přehrání vašeho notového zápisu.

Stisknutím tlačítka Přehrát  vstoupíte do režimu přehrávání. V režimu přehrávání jsou dostupné
následující příkazy:

K předchozímu akordu ←
K dalšímu akordu →
K předchozímu taktu Ctrl+← (Mac: Cmd+←)
K dalšímu taktu Ctrl+→ (Mac: Cmd+→)
Přetočit zpět na začátek Home (Mac: ⌘+Home)
Přepnout zobrazení přehrávacího panelu F11 (Mac: ⌥+⌘+P)

Stiskněte tlačítko pro přehrávání znovu pro zastavení a ukončení režimu přehrávání.

MuseScore začne přehrávání od místa, kde naposledy skončilo. Pokud vyberete notu, potom
MuseScore příště začne přehrávat od této nově vybrané noty. Nástrojový panel má i tlačítko pro
přetočení, které je určeno pro rychlý návrat na začátek notového zápisu, odkud se zase začne
přehrávání.

Pro zahrnutí přehrávání opakování zapněte tlačítko, activate the  pro povolení/zakázání
opakování.

Přehrávací panel

Přehrávací panel nabízí větší kontrolu nad přehráváním včetně tempa, začáteční a koncové polohy a
celkové hlasitosti. (Nic z toho se neukládá do notového zápisu.) V hlavní nabídce vyberte Pohled →
Přehrávací panel pro ukázání přehrávacího panelu.
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Poznámka: Výchozí hlasitost můžete nastavit přes syntetizátor (Pohled → Syntetizátor).

Počítání

Můžete zapnout a vypnout počítání, aby se přehrávalo pokaždé, když přehrávání začne. Počítání
přehrává doby pro celý takt (podle jmenovitého taktového označení v počátečním bodě přehrávání;
pokud je počáteční bod uprostřed taktu nebo v předtaktí, přehrává se dost dob pro vyplnění toho
taktu. Ikona sbormistrovy ruky v přehrávacím panelu povolí nebo zakáže počítání.

Přehrávání metronomu

Také můžete, když je notový zápis přehráván, zapnout a vypnout doprovázející metronom (podívejte
se na ikonu metronomu v přehrávacím panelu).

Smyčka

Můžete opakovat přehrávání úryvku. Nejprve použijte tři tlačítka ve spodní části přehrávacího panelu k
nastavení bodů začátku a konce, potom přehrávejte ve smyčce. Smyčku lze také přepínat pomocí
tlačítka v hlavním nástrojovém panelu MuseScore.
Začátek a konec smyčky je vyznačen modrou vlaječkou ukazující vpravo a vlevo.

Do you have an unanswered question? Post it in the forum.

Zvuková banka
MuseScore přichází se zvláštním typem souboru nazývaného zvuková banka (SoundFont), která
MuseScore říká, jak má zvuk toho kterého nástroje přehrávat. Některé zvukové banky jsou navrženy
pro přehrávání klasické hudby, jiné pro jazz, lidovou neboli populární hudbu atd. Ve velikosti souborů
zvukových bank jsou velké rozdíly. Některé mohou být dost velké a vyžádat si mnoho paměti
počítače, jiné jsou velmi malé a zabírají v paměti počítače málo místa. MuseScore mělo od verze
0.9.6 do 1.3 v paměti poměrně málo místa zabírající, všeúčelovou celkem malou zvukovou banku
pojmenovanou TimGM6mb.sf2, zatímco verze 2.0 má mnohem lepší FluidR3Mono_GM.sf3

Přehled

Soubor se zvukovou bankou může obsahovat jakýkoli počet zvuků nástrojů. Mnoho zvukových bank
je dostupných na internetu. Pokud si některou z nich chcete vyzkoušet, doporučuje se použít takovou,
která podle standardu General MIDI (GM) pokrývá 128 nástrojů. Pokud použijete zvukovou banku,
která nevyhovuje standardu General MIDI, pak ostatní podle okolností na jiném počítači neuslyší
správné nástroje, když budete notový zápis sdílet nebo jej uložíte jako MIDI.

Velikost a zvuková kvalita zvukových bank, které najdete na internetu, je velmi rozdílná. Vetší zvukové
banky často zní lépe, ale mohou být příliš velké na to, abyste je mohli provozovat na svém počítači.
Pokud vám po instalaci nové zvukové banky bude MuseScore připadat pomalé, nebo když váš počítač
při přehrávání neběží bez zadrhávání, zkuste to s menší zvukovou bankou.

Seznam zvukových bank
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Níže jsou popsány některé oblíbené zvukové banky s různou velikostí.

Fluid R3 GM (141 MB, nekomprimováno)
Licence: vydáno pod licencí MIT (zahrnuta v archivu)
GeneralUser GS (29.8 MB, nekomprimováno)
S laskavým svolením S. Christiana Collinse
Magic Sound Font, verze 2.0 (67.8 MB, nekomprimováno)
Arachno SoundFont, verze 1.0 (148 MB, nekomprimováno)
S laskavým svolením Maximea Abbeye
MuseScore verze 1.x dodávána s TimGM6mb (5.7 MB, nekomprimováno)
Licence: GNU GPL, verze 2
S laskavým svolením Tima Brechbilla
MuseScore ve verzi 2.0 je dodáváno se zvukovou bankou FluidR3Mono_GM.sf3 (12.6 MB).
Licence: vydáno pod licencí MIT
Timbres of Heaven, verze 3.1 (369 MB, nekomprimováno)
s laskavým svolením Dona Allena

Kromě souborů se zvukovými bankami SoundFont MuseScore podporuje díky novému syntetizátoru
Zerberus i formát SFZ. Zde jsou některé zvukové banky SFZ:

Sonatina Symphonic Orchestra (503 MB, nekomprimováno)
Stažení: SoundFont | formát SFZ
Licence: Creative Commons Sampling Plus 1.0
Salamander Grand Piano, verze 3 (mezi 80 MB a 1.9 GB, nekomprimováno)
Licence: Creative Commons Attribution 3.0
Salamander Grand Piano, version 2 (mezi 80 MB a 1.9 GB, nekomprimováno)
Licence: Creative Commons Attribution 3.0
Detuned Piano (244 MB, nekomprimováno)
Licence: Creative Commons Attribution-ShareAlike 3.0
Plucked Piano Strings (168 MB, nekomprimováno)
Licence: Creative Commons Attribution-ShareAlike 3.0

Specializované zvukové banky

Acoustic grand piano, vydání 2008-09-10 (132 MB, nekomprimováno)
Popis: Yamaha Disklavier Pro piano, formát sf2, 116 vzorků, 44100 Hz, 16 bit
Další informace: http://zenvoid.org/audio/
Licence: Creative Commons Attribution 3.0
S laskavým svolením Roberto Gordo Saez
Acoustic grand piano, old version (37.5 MB, nekomprimováno)
Popis: Steinway & Sons, formát sf2, 13 vzorků, stereo, 44100 Hz, 16 bit (založeno na University
of Iowa Musical Instrument Samples)
Další informace: http://zenvoid.org/audio/
Licence: Public domain
S laskavým svolením Roberta Gorda Saeze

Komprese

Soubory se zvukovými bankami mohou být velmi velké, jsou proto běžně nabízeny ke stažení v
komprimované podobě včetně formátů .zip, .sfArk, a .tar.gz. Předtím než tyto soubory budete moci
použít, je třeba je rozbalit.

ZIP je standardní kompresní formát podporovaný většinou operačních systémů.

sfArk je kompresní formát navržení speciálně pro kompresi souborů se zvukovými bankami. Na
rozbalení použijte zvláštní program sfArk software.

.tar.gz je oblíbený kompresní formát pro Linux. Uživatelé Windows mohou zdarma použít 7-Zip,
který podporuje většinu běžných kompresních formátů; Uživatelé OS X (Mac) mohou použít The
Unarchiver, nebo do Mac OS X vestavěný archivovací program. Povšimněte si, že používáte 7-
Zip, je potřeba jej rozbalit dvakrát: jednou pro GZip a jednou pro TAR.

Nastavení MuseScore

Po nalezení a rozbalení zvukové banky na ni dvakrát klepněte, čímž ji otevřete. Spustí se MuseScore
a objeví se dialog, který se vás zeptá na to, zda ji chcete nainstalovat. Po klepnutí na Ano bude kopie
souboru se zvukovou bankou umístěna do adresáře MuseScore se zvukovými bankami, na jehož
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obsah si můžete podívat nebo jej změnit v nastavení MuseScore.

Pro výběr zvukové banky používané pro přehrávání jděte do Pohled → Syntetizátor. Klepněte na
tlačítko přidat pro přidání další zvukové banky z adresáře se zvukovými bankami do seznamu.
Zvuková banka na čele seznamu je ta, která se bude používat při přehrávání.

Počáteční přednastavená zvuková banka MuseScore je umístěna v:

Windows (32-bit): C:\Program Files\MuseScore 2\sound\FluidR3Mono_GM.sf3
(actually %ProgramFiles%\MuseScore 2\sound\FluidR3Mono_GM.sf3)

Windows (64-bit): C:\Program Files (x86)\MuseScore 2\sound\FluidR3Mono_GM.sf3
(actually %ProgramFiles(x86)%\MuseScore 2\sound\FluidR3Mono_GM.sf3)

Mac OS X: /Applications/MuseScore 2.app/Contents/Resources/sound/FluidR3Mono_GM.sf3

Linux (Ubuntu): /usr/share/sounds/sf2/FluidR3Mono_GM.sf3

Řešení potíží

Pokud je panel pro přehrávání v nástrojovém pruhu šedivý, nebo není vidět, následujte pokyny níže,
abyste přehrávání zvuku opět zprovoznili:

Ujistěte se, že v nabídce Pohled → Přehrávání je položka Přehrávání zaškrtnuta. Pokud tomu
tak není, klepněte na odpovídající položku v nabídce, takže se zaškrtnutí objeví. Pokud potíže s
nástrojovým panelem pro přehrávání přetrvávají, vyzkoušejte další krok.
Pokud nástrojový panel pro přehrávání po změně zvukové banky zmizí, jděte do nabídky Úpravy
→ Nastavení... → karta Vstup/Výstup a klepněte na OK, aniž byste udělali další změny. Po
novém spuštění MuseScore by se měl nástrojový panel pro přehrávání znovu objevit.

Pokud měníte zvukovou banku poprvé, použijte, prosím, jednu ze zvukových bank uvedených výše.

Pokud se přehrávání zadrhává, váš počítač není sto používat vámi vybranou zvukovou banku. Má to
dvě řešení:

1. Zmenšete množství paměti (RAM) používané MuseScore použitím menší zvukové banky.
Návrhy hledejte v seznamu výše.

2. Zvětšete množství paměti (RAM) dostupné pro MuseScore ukončením všech programů kromě
MuseScore. Pokud stále ještě máte potíže a velká zvuková banka je pro vás důležitá, měli byste
do svého počítače vestavět více paměti.

Podívejte se také na

How to change the SoundFont or add another

Do you have an unanswered question? Post it in the forum.

Swing
Scores are capable of incorporating swing into playback.

Zřízení swingu

1. Klepněte na první notu

2. Dvakrát klepněte na text Swing v paletě Text

Nastavení swingu
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Obecná nastavení swingu (základní nastavení pro celý notový zápis) jsou dostupná v Styl →
Obecné... → Noty.

Ve výchozím nastavení je swing vypnut. Můžete zde vybrat poměr swingu (beat frequency).

Jednotlivá nastavení swingu jsou dostupná přes klepnutí pravým tlačítkem myši → Vlastnosti textu
osnovy → Nastavení swingu.

Vypnutí swingu

Pokud máte notový zápis jak se swingem tak s "even" zvukem, a chcete, aby se toto odráželo při
přehrávání:

1.Vložte text pro swing, jak je to vysvětleno výše
2. Změňte text na "Even" (dvojité klepnutí na právě vložený text)
3. Pomocí klepnutí pravým tlačítkem myši nastavte přehrávání swingu vypnuto → Vlastnosti textu
osnovy → Nastavení swingu → vypnuto

Vlastnosti textu

Vlastnosti textu se zde vztahují na označení tempa.

Do you have an unanswered question? Post it in the forum.

Tempo

This translation is outdated, see the English version for a reference: Tempo

Označení tempa lze do notového zápisu přidat v podobě textu tempa. Tempo přehrávání je také
možné dočasně potlačit pomocí přehrávacího panelu.

Označení tempa

Označení tempa jsou používána k vyjádření rychlosti notového zápisu a odráží se na přehrávání. Je
možné mít více označení tempa na různých místech notového zápisu (výchozí hodnota, pokud není
udáno, je 120 ÚZM).

Přidání označení tempa:

1. Vyberte notu nebo pomlku, nad kterou se má nastavení/změna (označení) tempa objevit
2. Otevřete paletu s tempy a dvakrát klepněte na styl označení tempa pro jeho přidání k vybrané

notě nebo pomlce. Popřípadě můžete tempo z palety na notu nebo pomlku přetáhnout přímo.
Také je můžete přidat přes hlavní nabídku: Přidání → Text... → Tempo, ale nebudete si moci
vybrat, s jakou hodnotou noty bude tempo vytvořeno.

Přidané označení tempo může být pozměněno dvojitým poklepáním na text pro vstoupení do režimu
upravování textu.

Rychlost přehrávání v počtu úderů za minutu (počet čtvrťových not za minutu: BPM → ÚZM) u
stávajícího označení tempa lze upravit přímo klepnutím pravým tlačítkem myši na text a jeho
upravením, pokud je ve správci povoleno Sledovat text a text tempa je vyjádřen ve tvaru "doba trvání
noty = číslo", jako je tomu v tomto příkladu, který obsahuje informace "čtvrťová nota = 75":

Pokud bylo označení tempa upraveno a už tyto údaje neobsahuje (například slovo "Andante" bez
čísla, jež by s ním bylo spojeno), jednou klepněte na označení pro jeho výběr. Zrušte zaškrtnutí v
okénku "Sledovat text" ve správci, a budete moci počet úderů za minutu o délce čtvrťové noty, které
představuje označení tempa, nastavit ručně.

93

https://musescore.org/cs/forum
https://musescore.org/cs/node/36066


Poznámka: Přehrávání označení tempa může být rychlejší nebo pomalejší než stanovený počet ÚZM,
pokud není nastavení tempa v přehrávacím panelu nastaveno na 100 procent.

Pozvolné změny tempa jako ritardando ("rit.") a accelerando ("accel.") lze do notového zápisu přidat
jako text osnovy, ale v současnosti to na přehrávání nemá žádný účinek.

Tempo přehrávání lze změnit pomocí přehrávacího panelu nebo pomocí textu tempa v notovém
zápisu.

Účinku ritardanda lze nicméně dosáhnout postupným snížením rychlosti (tempa) pomocí skrytého
označení tempa. Například v tomto kousku s obecným tempem čtveťové noty = 110 lze poslední tři
takty ritardanda zpomalit o 10 na první notě každého taktu stanovením efektu ritardanda. Text značky
pro tempo se ve správci skryje zrušením zaškrtnutí v okénku 'viditelný', takže se ve vytištěném
notovém zápisu objeví pouze ritardando.

Přehrávací panel

Zobrazit přehrávací panel: Pohled → Přehrávací panel nebo F11 (Mac: fn+F11)

Změnit počet úderů za minutu (BPM → ÚZM) pomocí posuvníku tempa

Toto nastavení v notovém zápisu není uloženo a používá se na přepsání všech označení tempa
nastavených v notovém zápisu.
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Podívejte se také na

How to create a tempo text

Do you have an unanswered question? Post it in the forum.

Dynamika
Hlasitost přehrávání lze změnit pro celý notový zápis v přehrávacím panelu, nebo místně označením
dynamiky v notovém zápisu.

Označení dynamiky

Z palety s dynamikou přetáhněte označení dynamiky na notu v notovém zápisu. (Popřípadě
můžete vybrat notu v notovém zápisu a dvakrát klepnout na označení dynamiky.)

Na to, jak označit crescendo a decrescendo, se podívejte ve svorkách

Na další značení dynamiky použijte hlavní paletu (ShiftF9). Také je můžete přidat do palety
přetažením; podívejte se také na palety

Upravení hlasitosti přehrávání pro označení dynamiky

1. Klepněte pro vybrání označení dynamiky
2. Pohled → Správce (nebo stiskněte F8)
3. Upravte číslo pro sílu tónu při přehrávání: vyšší pro hlasitější tón, nižší pro tišší tón

Přehrávací panel

Přehrávací panel: Pohled → Přehrávací panel

Změňte hlasitost pomocí posuvníku

Vnější odkazy

Video tutorial: Lyrics, Copying & Dynamics
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Do you have an unanswered question? Post it in the forum.

Změna a úpravy zvuku

Směšovač

Směšovač vám dovolí změnu zvuků nástrojů a úpravu hlasitosti, pravolevé vyvážení, ozvěnu a
znásobení tónu (sbor) pro každou osnovu. V hlavní nabídce vyberte Pohled → Směšovač nebo
stiskněte F10 (Mac: fn+F10) pro ukázání směšovače.

Ztlumení a sólo

Použijte zaškrtávací okénko Ztlumit na rychlé ztišení určitých osnov. Obráceně slouží zaškrtávací
okénko Sólo ke ztišení všech osnov, kromě osnovy, která byla označena jako sólo.

Kruhové stupnice

Klepněte na kruhovou stupnici a táhněte myší nahoru pro otáčení stupnice po směru hodinových
ručiček. Klepněte na kruhovou stupnici a táhněte myší dolů pro otáčení stupnice proti směru
hodinových ručiček.

Zvuk

Rozbalovací nabídka uvádí každý nástroj podporovaný vaší současnou zvukovou bankou.

Změna nástroje

Můžete změnit osnovu, aby byla jiným nástrojem. Následující postup mění zvuk nástroje, název
osnovy a transpozici osnovy.

1. Klepněte pravým tlačítkem myši na prázdné místo v taktu a vyberte Vlastnosti osnovy...
2. Klepněte pro změnu nástroje
3. Vyberte nový nástroj a klepněte na OK pro návrat do dialogu Vlastnosti osnovy
4. Klepněte znovu na OK pro návrat do notového zápisu

Změna tónu v díle

Některé nástroje mohou změnit zvuk uprostřed notového zápisu. Například smyčce se mohou
přepnout do pizzicata nebo tremola a trubku lze přepnout na ztlumenou trubku. Následující pokyny
používají jako příklad pizzicato, ale stejné principy se vztahují na ztlumenou trubku nebo tremolo u
smyčců.
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1. Vyberte notu, na níž má začínat pizzicato
2. V hlavní nabídce vyberte Přidání → Text → Text osnovy
3. Napiště Pizz. V tomto bodě je text osnovy viditelným odkazem, je jen textem a nemá účinek na

přehrávání
4. Klepněte pravým tlačítkem myši na text osnovy a vyberte Vlastnosti textu osnovy...
5. V dialogu Vlastnosti textu osnovy vyberte jeden nebo více hlasů nalevo (na kartě pro změnu

kanálu)

6. Ve vysouvací nabídce vyberte pizzicato

NOT FOUND: Staff text properties.png

7. Klepněte na OK pro návrat do notového zápisu

Každá nota, která je zadána po takto upravené notě, je v MuseScore přehrávána pizzicato. Pro
pozdější návrat ke zvuku smyčců v notovém zápisu, následujte tytéž pokyny, jak jsou uvedeny výše,
ale napište Arco v kroku 3 a vyberte normal v kroku 6.

Podívejte se také na

Zvuková banka
How to change instrument sound (e.g. pizz., con sordino) midway through score

Do you have an unanswered question? Post it in the forum.

Text
Předchozí kapitola se zabývá texty, jež ovlivňují tempo přehrávání, ale v MuseScore je spousta
dalších dostupných textů: text písně, značky akordů, značky dynamiky, prstoklad, nadpis, zkušební
značky a mnohé další. Tyto všechny jsou přístupné z hlavní nabídky přes Přidat → Text.

Na krátký obecný text použijte text osnovy nebo systému. Rozdíl mezi těmito dvěma texty je v tom,
zda chcete, aby se použil na jednu osnovu, nebo na celou velkou osnovu. Toto rozlišení bude jasné
při vytahování hlasů skladby.

Pohyb značek a textu osnovy založený na mřížce
Při výběru a tažení prvku stisknutí buď Shift nebo Ctrl vybraným prvkem pohne jen v jednom směru.
Stisknutí Ctrl pohne prvkem vodorovně, zatímco Shift jím pohne svisle.

Ve správci můžete přepnout tlačítka Povolit přichytávat do mřížky, čehož výsledkem bude pohyb
prováděný v krocích zlomku určitého místa (stejné kroky jako při používání kolečka myši ve správci)

Do you have an unanswered question? Post it in the forum.

Orientační značky
Orientační značky se často používají v notových zápisech, zvláště v těch nových. Starají se o to, aby
všichni hudebníci začínali na stejném místě, aniž by kvůli tomu museli počítat takty. (Orientační
značky však mohou odkazovat na čísla taktů). Orientační značky jsou zřetelnější, obecně viditelnější.
Obvykle sestávají z po sobě jdoucích písmen nebo čísel: A, B, C, nebo 1, 2, 3...

Vytvoření orientačních značek

1. Klepněte na první notu nebo pomlku na začátku zkušebního úseku, obyčejně v horní notové
osnově

2. Přidání → Text → Orientační značka nebo Ctrl+M nebo paleta → Text → Orientační značky
3. Napište text vaší orientační značky
4. Klepněte někde jinde

Vlastnosti

Orientační značky jsou ve výchozím nastavení textem systému. Objeví se v každém hlase a notovém
zápisu.
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Také automaticky zalomí vícetaktové pomlky před a po orientačních značkách.
Styl textu je ve výchozím nastavení přesně stanovený (Orientační značky), a jsou ve výchozím
nastavení orámovány.

Automatická další orientační značka

Orientační značka přidaná z palety pro text bude automaticky označena dalším písmenem nebo
číslem.

Hledání orientační značky

Na danou orientační značku se dostanete pomocí Ctrl+F a názvu orientační značky.

Podívejte se také na

Vlastnosti textu

Do you have an unanswered question? Post it in the forum.

Úpravy textu

This translation is outdated, see the English version for a reference: Text editing

Dvakrát klepněte na text pro vstup do režimu úprav:

V režimu úprav textu jsou dostupné následující příkazy:

Ctrl+B (Mac: ⌘+B) zapnout/vypnout tučné písmo
Ctrl+I (Mac: ⌘+I) zapnout/vypnout kurzívu
Ctrl+U (Mac: ⌘+U) zapnout/vypnout podtržení
Posunout ukazatel: Home End Left Right
Backspace odstraní znak nalevo od značky pro vkládání znaků
Delete odstraní znak napravo od značky pro vkládání znaků
Return začít nový řádek
F2 ukáže paletu s textovými symboly (viz níže)

Symboly a zvláštní znaky

Můžete do svého textu vložit čtvrťové noty, zlomky a další zvláštní znaky jako textové symboly.
Dvakrát klepněte levým tlačítkem myši na text, a pak v panelu pro úpravy textu klepněte na ikonu

klávesnice , nebo stiskněte F2. Otevře se paleta s textovými symboly
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Podívejte se také na

Název akordu
Text písně
Rámečky
Režim úprav

Příloha Velikost
Special_Characters_en.png 22.47 KB
Do you have an unanswered question? Post it in the forum.

Styl textu
Každý typ textu má svůj základní styl. A tak je například text názvu zarovnán na střed a používá
velkou velikost písma, Text skladatele je menší a je zarovnán vpravo. Pro změnu textových stylů jděte
do nabídky Styl → Text... nebo klepněte pravým tlačítkem myši na text a vyberte Styl textu...

Během úprav textu můžete udělat změny tohoto základního stylu.

Vlastnosti textu:
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Jsou rozděleny do skupin

Text :
Písmo: název písma, například Times New Roman nebo Arial
Velikost: velikost písma v bodech
Styl: styl písma, kurzíva, tučné, podtržení
Barva: klepnutí na barvu ukáže změnu
Nastavení Velikost sleduje mezeru osnovy: zda velikost sleduje vzdálenost mezi dvěma
linkami v pětilinkové standardní osnově
System flag: text se použije na všechny osnovy systému.

Posun
Vodorovný
Svislý
Jednotka posunu: v mm nebo jednotkách mezery osnovy

Zarovnání
Vodorovné: levé, pravé, na střed;
Svislé: align top edge of text to reference point, center text vertical to reference point,
center text vertical to text baseline or align bottom edge of text to reference point

Rámeček
Rámeček: přidat rámeček okolo textu
Typ rámečku: kruh nebo čtyřúhelník
Tloušťka okraje: tloušťka čáry rámečku v jednotkách mezery
Poloměr okraje: pro rámeček čtyřúhelníku, poloměr kulatého okraje
Okraj textu : vnitřní okraj rámečku v jednotkách mezery
Barva: rámečku (popředí) a pozadí textu (pozadí)

Typy textu:

Název, podnázev, skladatel, básník: ukotven ke straně
Prstoklad: Prstoklady jsou ukotveny k hlavičkám not.
Text písně: Slova písně jsou ukotvena k časové poloze (nota/akord, ale ne pomlka).
Značka akordu: Názvy akordů jsou také ukotveny k časové poloze.
Text systému: Vztahuje se ke všem notovým osnovám v systému osnov.1 Ukotven k časové
poloze.
Text osnovy: Vztahuje se k jedné notové osnově.1 Ukotven k časové poloze.
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Vytvoření nového stylu textu

1. Jděte do Styl → Text..., nebo klepněte pravým tlačítkem myši na nějaký text a vyberte Styl
textu...

2. Klepnout na nový
3. Nastavit název
4. Nastavit všechny vlastnosti

Toto bude uloženo společně s notovým zápisem, což také znamená, že to nebude dostupné v dalším
notovém zápisu

Volby pro použití

Vlastnosti můžete použít buď na notový zápis nebo na výtah hlasu, když klepnete na Použít a potom
na OK.
Když se nacházíte v jednom výtahu hlasu vašeho notového listu, máte, předtím než klepnete na OK,
také možnost Použít na všechny hlasy, takže nemusíte zpracovávat jednotlivě všechny hlasy.

Volba pro opětovné nastavení stylu

Pokud jste již změnili styl s jinou verzí Musescore a chcete, aby styl odpovídal stylu textu ve verzi 2.0,
může být potřeba styl nastavit znovu.
Pro opětovné nastavení stylu otevřete správce. Vyberte text, u něhož chcete znovunastavit styl, a
klepněte na Nastavit text znovu na styl. Pokud musíte nastavit znovu všechny texty jednoho style,
klepněte na jeden pravým tlačítkem myši, a dejte Vybrat, a pak volbu Vybrat všechny podobné prvky.

Podívejte se také na

Správce
Výběr

1. Na rozlišení mezi textem systému a jedné notové osnovy záleží v notových zápisech s více hlasy
pro sbor. Text systému se nachází ve všech jednotlivých hlasech. Text jedné notové osnovy se
nachází jen v hlase, ke kterému je ukotven. ↩ ↩

Do you have an unanswered question? Post it in the forum.

Značky akordů
Značky akordů lze zadat tak, že se nejprve vybere nota nebo pomlka, a pak se stiskne Ctrl+K (Mac:
⌘+K). To vytvoří značku akordu pro vybraný akord.

Stiskněte:
* mezerník pro přesun na další notu nebo dobu
* Shift+mezerník pro přesun na předchozí notu nebo dobu
* Ctrl+mezerník (Mac: ⌘+mezerník) pro přidání mezery do názvu akordu
* ; pro přesun na další dobu
* Shift+; pro přesun na předchozí dobu
* Tab pro přesun na další takt
* Shift+Tab pro přesun na předchozí takt
* Esc pro ukončení režimu úprav značek akordů

Názvy akordů lze upravovat jako normální text. Pro přidání křížku stiskněte # a pro přidání béčka
stiskněte b. Pro přidání dvojitého křížku stiskněte x nebo ##, a pro přidání dvojitého béčka stiskněte bb.
Tyto znaky budou automaticky proměněny na správné značky křížku a béčka, jakmile dokončíte
zadávání. Nepokoušejte se zadat skutečné znaky pro křížek a béčko, MuseScore tyto nebude
vykládat správně.
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Skladba značek akordů

MuseScore rozumí většině zkratek používaných pro značky akordů:

Dur: M, Ma, Maj, ma, maj, Δ (napište t nebo ˆ
Moll: m, mi, min, -
Zmenšený: dim, o (malé písmeno)
Napůl zmenšený: ø (napište číslici 0)
Zvětšený: aug, +

Všimněte si, že pro napůl zmenšené akordy samozřejmě můžete zadat i zkratky, jako like mi7b5 a
budou nakresleny také, takže nemusíte používat ø.

Můžete používat i rozšíření a změny jako b9 nebo #5, sus, alt a no3. Lze ukázat obrácení a lomítkové
akordy pomocí zápisu jako C7/E. Ve značkách akordů můžete používat kulaté závorky a čárky , a
také můžete celou značku akordu uzavřít do závorek.

Styl značek akordů

Značky akordů používají styl textu pro značky akordů, takže můžete pomocí ovládání popsaného ve
Styl textu změnit písmo. Nastavení stylu jsou i v Styl → Obecné... → Značky akordů, nákresy
hmatníků. Tyto volby jsou popsány v této části.

Vzhled

MuseScore podporuje dva základní styly značek akordů: standardní a jazzový. Můžete mezi nimi
vybírat pomocí kulatých přepínačů.

Ve standardním stylu jsou akordy kresleny jednoduše, písmo je určeno stylem textu značky akordu.

V jazzovém stylu se používá písmo MuseJazz se vzhledem, který vypadá jako psaný rukou, a používá
se i horní index a jiné formátovací techniky.

Jazzový styl je vybrán standardně, pokud použijete kteroukoli z jazzových předloh.

Třetí kulaté tlačítko je tu většinou kvůli slučitelnosti se staršími motovými zápisy. Můžete je také použít
na vytvoření vašich vlastních souborů s popisy akordů. Tyto lze vytvořit tak, že zkopírujete jeden ze
standardních souborů a přečtete si dokumentaci v nich o jejich stavbě. Toto je ovšem zamýšleno pro
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pokročilé uživatele, a není žádná záruka, že budou tyto soubory podporovány v budoucnosti.

Psaní not

Ve výchozím nastavení MuseScore používá pro značky akordů názvy písmen. Uživatelům v zemích,
kde se používají jiná schémata pro pojmenovávání not, MuseScore poskytuje následující ovládání:

Standardní: A, Bb, B, C, C#, ...
Německé: A, Bb, H, C, C#, ...
Plně německé: A, B, H, C, Cis, ...
Solfeggio: Do, Do#, Reb, Re, ...
Francouzské: Do, Do#, Réb, Ré, ...

Dodatečně tu jsou volby na řízení psaní velkých písmen. Ve výchozím nastavení MuseScore píše
automaticky, jak je to ukázáno výše. Všechny názvy not jsou velkými písmeny, a je jedno, jestli
písmena zadáváte velká nebo malá. Nicméně můžete zvolit jiné možnosti automatického psaní
písmen:

Mollové akordy malými písmeny: c, cm, cm7, ...
Basové noty malými písmeny: C/e, ...
Názvy not velkými písmeny: DO, RE, MI, ...

Také můžete úplně vypnout psaní velkými písmeny, takže jsou názvy not vytvářeny tak, jak je píšete.

Umísťování

S informací o umístění ve stylu textu se zachází normálně, takže můžete používat zarovnání textu a
vodorovný/svislý posun, když si to přejete. V tomto dialogu je však i ovládání umístění:

Výchozí svislá poloha: Výška nad notovou osnovou (použít záporné hodnoty)
Vzdálenost k nákresu hmatníku: Pokud je přítomen nákres hmatníku, výška nad nákresem
Nejmenší odstup akordu: Prázdné místo mezi značkami akordů
Největší vzdálenost taktové čáry: Povolit prázdné místo před taktovou čárou
Kapodastr: Určuje nastavení kapodastru; použité akordy jsou automaticky zobrazeny v kulatých
závorkách

Podívejte se také na

Jak vytvořit značky akordů položené na sobě

Do you have an unanswered question? Post it in the forum.

Prstoklad
Prstoklad lze k notám přidat přetažením odpovídajícího znaku z palety pro prstoklad na notovou
hlavičku v notovém zápisu. Když nejprve vyberete hlavičku noty, lze znak pro prstoklad přidat dvojím
klepnutím levým tlačítkem myši na symbol v paletě. Prstoklady jsou normální text, který lze upravovat
jako jakýkoli jiný text.

Podívejte se také na

Jak umístit prstoklad
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Do you have an unanswered question? Post it in the forum.

Text písně
1. Nejprve zadejte noty
2. Vyberte první notu
3. V hlavní nabídce vyberte Přidání → Text → Text písně nebo stiskněte Ctrl+L (Mac: ⌘+L) a

napište slabiku pro první notu
4. Pokračujte v zadávání slov:

Stiskněte mezerník na konci slova pro přechod na další notu
Stiskněte spojovník - na konci slabiky pro přechod na další notu. Slabiky jsou spojeny
spojovací čárkou
Shift+mezerník přesune na předchozí slabiku
↵ přesune dolů na další řádek textu s další slokou (Poznámka: Ne klávesa Enter na
číselné klávesnici!)
Stiskněte šipku nahoru pro návrat na řádek textu výše

5. Stisknutí Esc ukončí zadávání textu písně
6. Pro napsání druhého nebo dalších řádků textu písně zopakujte kroky 2 a 3 výše, nebo dvakrát

klepněte na první slabiku, stiskněte ↵ a napište slabiku pro první notu, potom pokračujte krokem
4

Některé příklady:

Poslední slabiku slova lze rozšířit podtržítky Shift+_ pro zapsání melismy (řada tónů zpívaných na
jednu slabiku textu):

Zadáno pomocí: soul, Shift+___ až po stisknutí Esc.
Pro rozšíření slabik, jež nejsou na konci, jednoduše použijte další spojovníky -, ukáže se jen jeden z
nich, a slabika bude zarovnána doprava k první notě. Podobá se to posledním slabikám, které se píší
melismou. Podívejte se výše.

Dvě slabiky pod notou lze spojit znakem elize (vypouštění samohlásky na konci slova, pokud další
slovo začíná též samohláskou), také známé jako lyrický legatový oblouček.

104

https://musescore.org/cs/forum


V nástrojovém panelu pro text klepněte na ikonu klávesnice , nebo stiskněte F2 k otevření palety
s textovými značkami. Elize je čtvrtá od konce (U+203F ‿ "undertie"). Elize bude rovnoměrně
vystředěna odděluje slabiky dvěma mezerami a jejím vložením po první. Pro příklad e ͜A ukázaný
výše:

1. Stiskněte e
2. Vložte pomocí palety F2 elizi
3. Stiskněte Ctrl+mezerník (Mac: ⌥+mezerník)
4. Stiskněte A

Ne všechna písma obsahují znak elize. K tomu, abyste zjistili, která písma ve vašem počítači
podporují elizi, se podívejte na seznam písem (hledejte všechna písma, která namísto prázdného
obdélníku ukazují mezi písmenem e a písmenem A ligaturu). Zarovnáníznaku se mezi jednotlivými
písmi různí.

Zvláštní znaky

Text písně lze s výjimkou několika znaků upravovat jako normální text. Pokud chcete přidat mezeru,
spojovací pomlčku nebo podtržení v jedné slabice, použijte následující zkratky:

Ctrl+mezerník (Mac: ⌥+mezerník) vloží do textu písně mezeru ( )
Ctrl+- (Mac: ⌥+-) nebo AltGr+- vloží do textu písně spojovník (-)
Ctrl+Shift+_ (Mac: ⌥+_) vloží do textu písně podtržení (_)
Ctrl+↵ (Mac: ⌥+Enter) nebo Enter (z číselné klávesnice) vloží do textu písně posun na nový
řádek

Podívejte se také na

Text
Značky akordů
Jak vložit text písně
Jak přesunout text písně
Jak do notového zápisu přidat blok textu

Vnější odkazy

Videonávod: MuseScore ve chvilce: Lekce 6 - Text, slova písně a akordy

Do you have an unanswered question? Post it in the forum.

Formátování
Rozvržení a formátování
Dokončil jste svůj notový zápis a chcete jej vytisknout. Chcete ale vylepšit jeho vzhled. Tato stránka
příručky popisuje mnoho různých způsobů a to, jak pracují dohromady.

Cesty, jak ovlivnit rozvržení

Rozvržení → Nastavení strany...: Mění celková nastavení, jako je velikost strany, jak velká je
mezera osnovy (jednotka spatium (sp), v části tohoto dialogu nazvané Měřítko), a jak velké jsou
okraje strany. Mezera se používá v jiných nastaveních jako jednotka (příklad: 5.0sp), takže
změna mezery ovlivní mnoho jiných nastavení.
Rozvržení → Zvětšit natažení, Zmenšit natažení: Natahuje nebo stahuje vámi vybrané takty.
Styl → Obecné... → Strana: Mění celková nastavení, která ovlivňují, jak blízko si jsou notové
osnovy, jak blízko si jsou systémy, jak velký okraj dostanou texty písní atd.
Styl → Obecné... → Osnova: Stanovuje počet taktů na osnovu, nebo šířku taktů.
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Styl → Obecné... → Notový zápis: Ovlivňuje podrobnosti notového zápisu jako například, zda
se použijí vícetaktové pomlky, nebo zda se mají skrýt prázdné notové osnovy.
Styl → Obecné... → Takt: Nastavuje napevno odstup mezi takty. Je to klíč k ovlivnění počtu
taktů v notové osnově na řádku.
Paleta → Zalomení a odstup: Zalomuje notovou osnovu na určitém taktu, stranu na určité notové
osnově, nebo zvětšuje odstup dvou notových osnov.
Styl → Obecné... → Velikosti: Nastavuje poměrnou velikost malých not a ozdob. Změny zde by
byly neobvyklé.

Poznámka: Volby zde se téměř vždy použijí na všechny předměty, na které se odkazuje v notovém
zápisu. Některé volby mohou být udělány jednotlivě pomocí správce a vlastností předmětů pro jeden
nebo výběr předmětů...

Rozvržení → Nastavení strany...

Budete moci nastavit jednotku velikosti a okraje. To je hlavní způsob, jak ovlivnit rozvržení, protože
touto jednotkou lze stanovit mnoho věcí.
Může být v mm nebo palcích.

Měřítko → Mezera
Toto je velikost mezery mezi dvěma linkami osnovy. Protože se noty umísťují do tohoto prostoru,
určuje se takto i velikost notových hlaviček. Protože jsou noty proporční k notám, má to také vliv na
nožičky not, posuvky, klíče atd. Ukazuje se to také jako sp v mnoha dalších nastaveních (příklad:
vzdálenost osnov "9.2sp"). Takže, když změníte parametr pro "mezeru (spatium)", dojde k proporční
změně u mnoha dalších nastavení. Z toho důvodu se tomu někdy říká "měřítko".

Změna měřítka nemusí změnit počet osnov na straně, to pak záleží na "míře naplnění strany" (viz
níže). Abyste viděli účinek změn na měřítko bez rušení, nastavte "míru naplnění strany" na 100 %.

Tisknutelná oblast → Okraje
Zde se dají nastavit okraje strany. Pro zobrazení okrajů strany ve vašem notovém zápisu na
obrazovce jděte do Pohled → Okraj strany a vyberte jej.
Poznámka: Není možné, aby měly liché a sudé strany různé okraje. Můžete se na ně podívat pomocí
Pohybu v notách na pravé straně okna.

Velikost strany
Můžete vybrat formát papíru, který se použije, buď podle názvu (Letter, A4...) nebo podle výšky a
šířky v mm nebo palcích. Výchozí nastavení závisí na zemi.
Můžete také zaškrtnout volbu formátu Na šířku (není-li zaškrtnuto, použije se formát na výšku) a
Dvoustránkový (dvě strany: sudá a lichá). Všimněte si, že v případě že není zaškrtnut dvoustránkový
formát, budete moci měnit pouze okraj lichých stran, ale ten se potom použije na všechny strany.
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Číslo první strany
Nastaví číslo první strany jednotlivého notového zápisu.
Čísla stran nižší než 1 se nevytisknou, takže např. -1 povede k tomu, že na první a druhé straně se
neukáže žádné číslo strany, a na třetí straně se ukáže 1.

Použít na všechny hlasy
Při upravování hlasu notového zápisu (znamená to, že jste při přistoupení k tomuto dialogu na kartě
hlasu, spíše než na kartě notového zápisu), toto tlačítko umožňuje použití změny na všechny hlasy v
jednom kroku.

Rozvržení → Zvětšit natažení, Zmenšit natažení

Můžete vybrat takty, a tyto potom rozšířit (natáhnout), takže se jich na řádek notové osnovy vejde
méně (Zvětšit natažení), nebo je zmáčknout (stáhnout), aby se jich na řádek notové osnovy vešlo více
(Zmenšit natažení).

Styl → Obecné... → Notový zápis
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Here you can cause the creation of multi-measure rests and hide empty staves. This can affect score
size greatly. You can also affect size and minimal duration for multimeasure rests.
"Hide instrument name if there is only 1" can also be a good space saver in your parts (or in solo
score), as it won't write the instrument name at the beginning of the line.

You can also change the musical font for text and symbols. There are 3 musical fonts available (for
symbols used in the staves): Emmentaler, Gonville, and Bravura. There are 4 musical text fonts
available (for use in texts like dynamics, tempo markings, etc.): Emmentaler, Gonville, Bravura and
MuseJazz. Of these Emmentaler is the default and Bravura the most complete one.

(To change text font and properties see Text style)

Some options are specific to early music, and swing playback.

Styl → Obecné... → Strana

Here are a lot of options that may affect your layout. Tick-boxes that may affect your layout are about
whether to show or not courtesy elements (key signatures, time signature and clef). You can also
influence the presence of these three elements in each system.

Music interaction with Pages Margin

Music top margin / Music bottom margin: Margin between the music (the top line of the top staff
of the top system and the bottom line of the bottom staff of the bottom system, respectively) and
the corresponding margins set in →Layout → Page settings.

Other music distance

Staff distance: Space between staves within a system
Grand staff distance: Space between the staves of a multi-staff instrument like piano and organ
Min. and max. system distance: Allows you to set the minimal and maximal distance from one
system to another. If both are the same, system distance will be set to that.
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Lyrics Margin

Top and Bottom margin: Distance between staff and lyrics and between lyrics and next staff.
Lyrics height: this is a proportion from lyrics text style.

Vertical frame margin

Top and bottom vertical frame margin: Space above and below vertical frames.

Last system fill threshold

If the last system is longer than this percentage of the page width, it gets stretched to fill that
width.

Styl → Obecné... → Záhlaví, zápatí, čísla

You can show the content of a score's meta tags (see Score information) in a header or footer for your
score. To create a header or footer for a score with linked parts, make sure the score is in the active
tab. To create a header or footer for an individual part, that part needs to be the active tab.

If you hover with your mouse over the Header or Footer text region, a list of macros will appear,
showing their meaning, as well as the existing meta tags and their content.

You can edit Headers and Footers on even and odd pages.

You can also edit whether and how often measure numbers appear.
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Note: You can have different texts on odd and even pages.

Styl → Obecné... → Osnova

Bracket and Braces
See Bracket

Vzdálenosti
You can set distance between the system and the Brackets and Brace
Šířka
You can set the width of Bracket and Brace.

Styl → Obecné... → Takt
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Sets measure spacing as well as margins. The measure spacing and minimum measure width are
keys to controlling the number of measures per line. Changing the other settings would be unusual.

Styl → Obecné... → Taktové čáry
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To change the bar lines at the beginning of the staff or multiple staves.
Scale barlines to staff size: See Barline adjustment possibilities

Proportion of thickness and distance are also available, but modifying these would be unusual.

Paleta → Breaks & Spacers

Using this palette, you can choose where you want page breaks, line or section breaks or increase the
distance between 2 individual staves or systems using the spacers. Some people do this first, and
some save it until the end, after modifying the global settings.

To insert a page break, drag and drop it to a measure. To insert a line break, drag and drop it to the
last measure you want on a line. If you want the same number of measures for several systems,
select them and use Edit → Tools → Add/Remove line breaks. If some measures end up alone on the
line or page, reduce the scaling, or use Layout → Add More Stretch, Add Less Stretch.

See also Break or spacer.

Styl → Obecné... → Noty
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Distance and thickness of note relative objects (stem, ledger line, accidental dot). Changing this would
be unusual.

Styl → Obecné.. → Klíče
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You can choose between Serif and Standard clef for your tablature sheet.

Styl → Obecné... → Arpeggia
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Distance to note, line thickness and hook height proportions are here.
Changing this would be unusual.

Styl → Obecné... → Trámce
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Styl → Obecné... → Legata/Ligatury
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Styl → Obecné... → Velikosti
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Sets the proportional size of "small" and grace notes, as well as small staves and clefs. Changing this
would be unusual.

Styl → Obecné... → Svorky, volta, oktáva
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The  button returns the setting to the original value.

Styl → Obecné... → Pedál, trylek

119

https://musescore.org/sites/musescore.org/files/Style-General-Hairpins%2CVolta%2COttava_en.png


Styl → Obecné... → Značky akordů, nákresy hmatníku
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Enables you to change appearance and other features.
See also Fretboard diagrams

Styl → Obecné... → Číslovaný bas
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Options about figured bass font, style and alignment.
See also Figured bass

Styl → Obecné... → Artikulace, ozdoby
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Position of articulation with respect to the notes and staves

Styl → Obecné... → Posuvky
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Options about naturals at key signature changes

Styl → Obecné... → Rytmické notové skupiny
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Edit spacing between individual notes

You can edit the spacing between notes in your score by the following steps.

1. Double click on the note head for the note you wish to nudge
2. Press the arrow key in the direction (left or right) that you wish to nudge the note
3. Press the Esc key to finalize the process (this will re-draw the note stem).

Note: you may need to delete and then re-enter ties, as they sometimes fail to re-draw.

Tlačítko Použít a OK

With the Apply button you can see (without closing the window) what the changes you make are like.
OK will save the changes you made in your sheet and close the window.

Apply to all parts in one go

When in a part tab while changing layout and formatting, you can use the Apply to all Parts button
to apply all changes (either in Layout → Page Settings.... or Style → General...) to apply the new
settings to all parts in just one click.

Save and Load style

You can save a customized style, to apply it easily to all your scores.

1. Go to Style / Save Style
2. Select a folder and name it (the default folder will be the one set in your preferences)

Styles are stored in *.mss format

Note: you can also define a preferred style for scores and parts in Preferences score section
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See also

A tutorial by Nicolas Froment
A post by Marc Sabatella
Upgrading from MuseScore 1.x, local relayout

External links

A video tutorial, part 1
A video tutorial, part 2

Do you have an unanswered question? Post it in the forum.

Zalomení a odstup
Zalomení stran, zalomení řádků (zalomení osnov) nebo zalomení úseků lze vynutit přetažením
odpovídajícího symbolu z palety se zalomeními na prázdné místo taktu nebo na vodorovný rámeček v
notovém zápisu. Zalomení se provede po vybraném taktu nebo rámečku. Modré značky pro zalomení
jsou viditelné na obrazovce, ale neobjevují se v tisku.

Někdy je potřeba zalomit osnovu uvnitř taktu místo na taktové čáře (obzvláště ve chvalozpěvech se
slokami nebo v písních). Když například chcete tři doby na jedné osnově a jednu dobu předtaktí na
další osnově, potřebujete vytvořit dva takty s odpovídající zkrácenou skutečnou dobou trvání. Na
podrobnosti se podívejte do částí Doba trvání a Nepravidelný kapitoly, ve které jsou popsány v
Operace s takty: Rozdělení a spojení.

Vymezení odstupu se používá pro zvětšení odstupu mezi dvěma sousedními osnovami. Přetáhněte
vymezovač odstupu na takt nad oblastí, která potřebuje více svislého prostoru. Na značku pro
vymezení odstupu dvakrát klepněte a pomocí myši úchopem táhněte pro úpravu výšky odstupu.

Pokud chcete změnit základní nastavení pro odstup mezi osnovami v celém notovém zápisu, použijte
nastavení stylu. Vymezení odstupu je navrženo pro místní úpravy. Mění jen notové řádky, v nichž se
vymezovače odstupu nacházejí.

Přidání zalomení nebo vymezení odstupu

Pro přidání zalomení nebo vymezení odstupu:

1. Použijte paletu pro zalomení a vymezení odstupu (viz výše)
2. Odtud přetáhněte požadované zalomení nebo vymezení odstupu
3. Upusťte zalomení nebo vymezení odstupu na takt, který si přejete ovlivnit

Smazání zalomení nebo vymezení odstupu

Někdy se stane, že chcete zalomení nebo vymezení odstupu odstranit. Pro smazání zalomení nebo
vymezení odstupu:

1. Jednou klepněte na zalomení nebo vymezení odstupu (změní se na tmavě modré, aby ukázalo,
že je vybráno)

2. Stiskněte klávesu Del (Mac: Fn+Delete)

Zalomení úseku

Zalomení úseku lze například použít na rozdělení vět koncertu.
Dá se použít buď se zalomením řádku nebo strany. Také znovunastaví číslo taktu na 1. Tudíž se na
prvním taktu, zrovna tak jako na prvním taktu notového zápisu, neobjeví po zalomení žádné číslo,
pokud je tak nastaven (viz Vlastnosti taktu).

Pokud na začátku nového úseku změníte taktové označení nebo předznamenání, nebude předtím na
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konci posledního taktu žádné upozornění na změnu označení. Viz příklad níže:

Podívejte se také na

Nástroj na přidání/odstranění zalomení notových řádků

Příloha Velikost
section_break.png 8.47 KB
Do you have an unanswered question? Post it in the forum.

Rámečky

This translation is outdated, see the English version for a reference: Frames

Rámečky poskytují prázdné místo vně normálních taktů. Mohou obsahovat text nebo obrázky.
MuseScore zná dva druhy rámečků:

Vodorovný

Vodorovné rámečky zalamují notovou osnovu. Šířka je nastavitelná a výška odpovídá aktuální výšce
osnovy. Vodorovné rámečky je například možné použít na odsazení cody.

Svislý

Svislé rámečky poskytují prázdné místo mezi nebo před notovými osnovami. Výška je nastavitelná a
šířka odpovídá aktuální šířce osnovy. Svislé rámečky se používají na umístění názvu, podnázvu nebo
skladatele. Při vytvoření názvu se automaticky, pokud už není přítomen, vytvoří před prvním taktem
svislý rámeček.

Vytvoření rámečku
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Nejprve vyberte takt, před který se má rámeček vložit. Příkaz pro vložení rámečku se nachází v
nabídce Přidání → Rámečky. Rámeček je vložen před vybraný takt.

Rámeček lze přidat i do textu. Podívejte se na Styl textu.

Smazání rámečku

Vyberte rámeček a stiskněte Del.

Upravení rámečku

Dvakrát uvnitř rámečku klepněte pro vstup do režimu úprav. Objeví se úchop, jenž se dá použít na
změnu velikosti rámečku..

Rámeček názvu v režimu úprav:

Podívejte se také na

Jak do notového zápisu přidat blok textu

Vnější odkazy

Formátování strany v MuseScore 1.1 - 1. Rámečky, text a zalomení řádků [video]

Do you have an unanswered question? Post it in the forum.

Obrázky
Můžete do svého notového zápisu pro ilustraci vložit obrázky, nebo přidat symboly, jež nejsou
přítomny ve standardní paletě.

Pro přidání obrázku soubor s obrázkem přetáhněte na notový zápis, buď do rámečku nebo na notu
nebo na pomlku v notovém zápisu.
Případně do rámečku klepněte pravým tlačítkem myši, vyberte Přidat → Obrázek, potom obrázek
vezměte z voliče souborů.

MuseScore podporuje následující obrázkové formáty:

PNG (*.png)
Soubory JPEG (*.jpg a *.jpeg)
Soubory SVG (*.svg) (MuseScore v současnosti nepodporuje SVG shading, blurring, clipping
nebo masking.)

Podívejte se také na

Zachytávání obrázků
Vytvořit ossia pomocí zachytávání obrázků

Do you have an unanswered question? Post it in the forum.

Zachytávání obrázků
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Zachytávání obrázků umožňuje vytvořit výstřižky obrázků notových zápisů. Lze je zapnout/vypnout

tlačítkem pro zachytávání obrázků .

V režimu zachytávání obrázků se udělá výběrový obdélník pomocí Shift + tažení myší.

Výběrový obdélník lze přesouvat myší, nebo se dá změnit jeho velikost posunutím některého z jeho
osmi úchopů.

Jakmile stanovíte ohraničující okénko obrázkového výstřižku, jejž hodláte vytvořit, klepněte pravým
tlačítkem myši do obdélníku, aby se objevila související nabídka:

Uložení obrázku ve formátu PNG má za následek tento soubor:
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Pokud svůj výstřižek uložíte v režimu tisku, objeví se jako výřez notového zápisu v podobě, jak by byl
vytištěn. V režimu zachytávání obrázků bude obrázek vypadat jako notový zápis na vaší obrazovce
(včetně značek pro zalomení řádků atd., které nejsou tištěny; příklad 100 dpi):

Podívejte se také na

Obrázky
Vytvořit ossia pomocí zachytávání obrázků

Do you have an unanswered question? Post it in the forum.

Pokročilá témata
Album

This translation is outdated, see the English version for a reference: Albums

The album manager allows to prepare a list of scores. The list can then be saved as an album file
("*.album").

Print Album

The scores are printed in the selected order with the correct page numbers, overriding the page
number offset values in Layout → Page Settings.... The album is printed in one print job, so double-
sided printing (duplex printing) also works as expected.

Join Scores

The scores are combined in the selected order into one single score.
If not already present, line- and section breaks are added to the last measure or frame of each score.
It is required that all scores have the same number of parts and staves, or less than the first score,
any part, or staff that isn't in the first score will be lost in the joined score.
These should represent the same instruments in the same order, otherwise, the ones from the first
score overwrite ones from subsequent scores.
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Do you have an unanswered question? Post it in the forum.

Funkce pro starou hudbu
MuseScore 2.0 offers several new functions to create engravings of early music (particularly medieval
and renaissance) akin to commercial editions from the 20th century onwards.

Unbarred notation

Since most renaissance music was unbarred (i.e. not divided into measures), having long notes
divided up and tied over barlines significantly changes the look of the score. Recognizing large
melodic lines and repeated motives could become more difficult. Therefore, MuseScore provides an
experimental display method where the note values stay intact. This method can be activated by
ticking a checkbox in the Score section of the Style dialog, found under Style → General...

Apply and the display is adjusted immediately.

Original notation (De Profundis Clamavi for 4 voices by Nicolas Champion)
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Before style Change

After style Change

Note that the feature is still experimental and may contain bugs. The longest supported note value is
the longa (a dotted longa is still broken up and tied over).
To get rid of the barlines, just untick the “Show barlines” box in the Staff properties dialog. However,
there is another option.

Mensurstrich

Since a complete lack of barlines could make performing the music more difficult for current
musicians, many modern engravers settled on a compromise called Mensurstrich, where barlines are
drawn between, but not across, staves. This is also possible now: double click a barline, drag the
lower end to the top of the staff below it, and drag the upper end to the bottom of the current staff. Do
this in precision mode (hold down Shift). Then deselect the barline and the changes should be
applied to the entire staff.

It may be easier to use the Inspector to change the numbers manually. To open the Inspector, press
F8 and select a barline. The correct values are:

 Default Mensurstrich
Spanned
staves 1 2

Span from 0 8
Span to 8 0

You may want to set the barlines back to the default values at the end of the score or a section, but
remember to hold down Ctrl, or else the entire staff will be reset.

Ambitus

Before there was the concept of an absolute pitch, performers were required to transpose vocal music
to a singable range for their ensemble on the fly. To aid them, an ambitus was sometimes included,
marking the entire range of a voice at the beginning of the piece. The ambitus is located in the palette
at the bottom of the Lines section, from there drag it onto a clef. It will automatically detect the range.
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The ambitus will consider all measures of music up until the next section break, beyond which a new
ambitus may be applied. It can be adjusted manually or automatically in the Inspector. First select the
ambitus to adjust. For manual adjustments edit the top and bottom note values. For automatic
adjustment click the Update Range button in the inspector.

Mensural time signatures

In the mensural notation system, time signatures did not define the length of a measure, but the length
of breves and semibreves. MuseScore supports mensural time symbols as a display method in the
Time signature properties dialog rather than as symbols, but they are just for show, as the proportion
of e.g. half notes per whole notes cannot be modified.
One way to make use of these symbols is to replicate when composers of the renaissance had
multiple voices in different time signatures simultaneously without using tuplets. Edit the time
signature on a per-staff basis, as long as the beginning and end of a measure in all staves match up. If
they do not, then consider increasing the size of the measures to the lowest common denominator.

De Profundis Clamavi for 5 voices by Josquin Des Prez

See also

Measure Operations: Split and join

Do you have an unanswered question? Post it in the forum.

Hlavní paleta
The master palette enables you to access all the possible elements that could be added to custom
palettes, and, in the case of Time Signatures and Key Signatures, make your own.

Go to View → Master Palette or use the shortcut Shift+F9 (Mac: fn+Shift+F9).
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Hovering over an item with the mouse shows a tool tip (a short definition in black on yellow
background).

See also

Palette
Custom Palette
Nonexistent node nid: 39841.

Do you have an unanswered question? Post it in the forum.

Informace o notovém zápisu
Several meta tags are generated automatically on creation of a score, and more may be created later.
These may be used in the Footer / Header of your score.

File → Info shows the values of the existing meta tags (some may be empty).

NOT FOUND: Score_information.png

Preexisting meta tags

Every score has the following meta tags. Some are automatically filled in on score creation, as the
following list details:

MuseScore Version: The version of MuseScore the score was last saved with.
Revision: The revision of MuseScore the score was last saved with.
API-Level: The file format version.
arranger: (empty)
composer: As entered in the New Score Wizard (which is also used to fill the composer text in
the top vertical frame—be aware that later changes to one are not reflected in the other).
copyright: As entered in the New Score Wizard. Copyright info appears as seemingly uneditable
text at the bottom of every page of a score, but it can be edited or removed by changing the
value here.
creationDate: Date of the score creation. This could be empty, if the score was saved in test
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mode (see Command line options).
lyricist: As entered in the New Score Wizard (which is also used to fill the corresponding lyricist
text in the top vertical frame—be aware that later changes to one are not reflected in the other).
movementNumber: (empty)
movementTitle: (empty)
platform: The platform the score was created on: "Microsoft Windows", "Apple Macintosh",
"Linux" or "Unknown". Might be empty, when the score got saved in test mode
poet: (empty)
source: (empty)
translator: (empty)
workNumber: (empty)
workTitle: As entered in the New Score Wizard (which is also used to fill the corresponding title
text in the top vertical frame—be aware that later changes to one are not reflected in the other).

Every part has the following meta tags, generated and partly filled on part creation:

MuseScore Version: (empty for linked parts, otherwise same as for score above)
Revision: (same as for score above)
API-Level: (same as for score above)
partName: Name of the part as given on part creation (which is also used to fill the
corresponding part name text in the top vertical frame—be aware that later changes to one are
not reflected in the other).

The first three meta tags in the above lists cannot be used in the Header or Footer.

Modify a meta tag

To modify a meta tag of a score with linked parts, make sure the score is in the active tab. To modify
a meta tag for an individual part, that part needs to be the active tab.
Go to File → Info and change the current text or fill in the empty field for any of the tags listed.

Add a new meta tag

To add a meta tag to a score with linked parts, make sure the score is in the active tab. To add a meta
tag to an individual part, that part needs to be the active tab.

Go to File → Info → New

Fill in the name of your new meta tag and click OK (or Cancel). The meta tag will be added to your tag
list. You can then fill in the content of the tag.

Header/Footer

You can show the content of meta tags in a header or footer for your score. To create a header or
footer for a score with linked parts, make sure the score is in the active tab. To create a header or
footer for an individual part, that part needs to be the active tab.

Go to Style → General... to open the Edit Style window and choose Header, Footer, Numbers  from
the sidebar on the left.

If you hover with your mouse over the Header or Footer text region, a list of macros will appear,
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showing their meaning, as well as the existing meta tags and their content.

You can use the tags with $:NameOfTheTag: in the appropriate boxes to create headers or footers.

Click Apply to see how the header or footer looks in the score. Click OK to assign the header or footer
to the score or the active part. If a part is in the active tab, you can also click Apply to all parts if you
want that and then OK to leave the dialog. Cancel allows you to exit without applying the changes.

See also

Layout and formatting: Header and footer
Command line options: Test mode

Do you have an unanswered question? Post it in the forum.

Nahrazení výšek tónů bez změny rytmů
If you have a passage where you want a change in notes but not in rhythm, but that is more
complicated than a simple transposition of notes, re-pitch mode is highly useful. In essence, when in
re-pitch mode, new pitches will replace the old ones, following the original rhythm.

Not to be confused with Accidental: Respell pitches

To activate re-pitch mode, use the re-pitch button, , next to the Note input button, , or use the
shortcut Shift+Ctrl+I (Mac: Shift+Cmd+I).

To reproduce a rhythmical passage with different pitches, select the passage, copy it, and paste it
where you want. (If you are in a situation of having written the wrong notes but correct rhythm, no
copy and paste is necessary.)

Then click on the first note you want to re-pitch, enter note input mode, and activate re-pitch mode.
Begin typing the new pitches. Unlike normal circumstances, where the length of the notes you are
entering are based on what length you have selected in the toolbar, in re-pitch mode the rhythm (the
notes' length) will stay the same.
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See also

Note input
Copy and paste
Transposition
Introduction to the new re-pitch mode

Do you have an unanswered question? Post it in the forum.

Nákres hmatníku

Adding a Fretboard diagram, with barré

1. Drag and drop on the score the fretboard diagram from symbols palette (in the advanced
workspace)

2. Right-click on the diagram → Fretboard Diagram Properties...

3. For example, to get an F chord, first set up this configuration (you may see the number 6 for
strings in the spinbox at the bottom of this window)

4. Press the Shift, then click on the first fret of the 6th string, like this:

First result:

Final result on the score for the F chord:
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You can change the width of the barré line at your convenience by going to Style → General... →
Chords symbols → Barré line thickness

Note that the principle is the same if you want a four strings barré (or other). In this case of an A7
chord: Press Shift, then click on the 4th string, second fret. This then results in:

Do you have an unanswered question? Post it in the forum.

Pomůcky

This translation is outdated, see the English version for a reference: Tools

Byly vyvinuty některé nástroje. Nalézají se v Úpravy → Pomůcky

Přidat/Odstranit zalomení notových systémů

Tento nástroj automaticky přidá nebo odstraní zalomení notových systémů:

Přidat zalomení notových systémů
každých X taktů
přímo na konci každého nynějšího notového systému

Odstranit
všechna nynější zalomení notových systémů

Tento příkaz pracuje s vybranými takty, nebo s celým notovým zápisem (ve výchozím nastavení, není-
li nic vybráno).

Volitelně vybrat takty, na něž se má použít

Úpravy → Pomůcky → Přidat/Odstranit zalomení notových systémů

Stisknout OK.

Rozdělit hlasy/Sloučit hlasy
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Tyto příkazy vám umožňují rozdělení obsahu notové osnovy obsahující řady akordů do samostatných
melodických linek na navazujících osnovách, nebo sloučit notové osnovy obsahující samostatné
melodické linky do řad akordů v jedné notové osnově.

Rozdělit hlasy

Vyberte ve zdrojové notové osnově rozsah obsahijící akordy s více notami. Nechte provést Úpravy →
Pomůcky → Rozdělit hlasy. Akordy budou "rozděleny" do cílových notových osnov níže (jedna nota na
osnovu). Pokud začnete výběrem rozsahu pouze v jedné osnově, MuseScore použije tolik cílových
osnov, kolik je potřeba - pokud má největší akord čtyři noty, použijí se čtyři notové osnovy. Pokud
však začnete rozsah vybírat ve více osnovách, MuseScore zastaví s naposledy vybranou osnovou.

Sloučit hlasy

Vyberte rozsah taktů napříč osnovami, jež mají v zásadě stejný rytmus. Nechte provést Úpravy →
Pomůcky → Sloučit hlasy. MuseScore sloučí obsah osnov do akordů v horní osnově - opak rozdělení.
Zvláštní případ představuje výběr jen jedné osnovy - MuseScore udělá v podstatě to samé, ale spojí
obsah více hlasů v té osnově do akordů v hlase 1.

Vyplnit lomítky

Tento příkaz vyplní výběr lomítky, jedno na každou dobu. Lomítka budou vystředěna na prostřední
lince notové osnovy a jsou nastavena tak, že se netransponují ani nepřehrávají.

Zapnout/Vypnout rytmickou notaci

This command converts selected notes into rhythmic slash notation: notes with slash heads, set to not
transpose or playback. For notes in voices one or two, the notes are fixed to the middle staff line.

For notes in voices three or four, the notes are fixed above or below the staff and are also marked
small (also known as "accent" notation). You may find it helpful to use the selection filter to exclude
voices one and two from your selection before running this command, so only the notes in voices
three and four are affected.
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Seřadit orientační značky

Tento příkaz seřadí orientační značky ve vybraném rozsahu:

1. Přidat orientační značky
2. Vybrat rozsah
3. Úpravy → Pomůcky → Seřadit orientační značky

MuseScore automatically detects the sequence based on the first rehearsal mark in the selection - all
rehearsal marks in the selection are then altered accordingly.

Pořadí může být:

a, b, c,
A, B, C,
jednoduchá posloupnost čísel - 1, 2, 3,
posloupnost číselně odpovídající číslům taktů

Podívejte se také na

Orientační značky
Přídavné moduly

Do you have an unanswered question? Post it in the forum.

Přídavné moduly
Plugins are small pieces of code that add a particular feature to MuseScore. By adding a plugin, a new
menu will be appended to the Plugins menu in MuseScore to accomplish a given action on the score
or a part of it. Plugins are a way to let users with minimal programming skills add features to the
software.

Some plugins are already delivered with MuseScore, see →below. You can find more plugins in the
plugin repository. Some plugins there work with MuseScore 2; others will only work with older versions
of MuseScore.

Installation

Note that some plugins may require the installation of other components (fonts, e.g.) to work. Check
the plugin's documentation for more information.

Most plugins are provided as ZIP archives, so download the plugin's .zip file and uncompress it to one
of the directories mentioned below.
Some may be provided directly as a .qml file, download and place into one of these directories.

Windows

MuseScore looks for plugins in %ProgramFiles%\MuseScore 2\Plugins (or
%ProgramFiles(x86)%\MuseScore 2\Plugins for the 64-bit versions) and in
%LOCALAPPDATA%\MuseScore\MuseScore 2\plugins on Vista and Seven or C:\Documents and
Settings\USERNAME\Local Settings\Application Data\MuseScore\MuseScore 2\plugins (adjusted to
your language version) on XP.
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Mac OS X

On Mac OS X, MuseScore looks for plugins in the MuseScore bundle in /Applications/MuseScore
2.app/Contents/Resources/plugins and in ~/Library/Application Support/MuseScore/MuseScore
2/plugins. To be able to move files in the app bundle, right click (Control-click) on MuseScore.app and
choose "Show package contents" to reveal the Contents directory. Be careful to use
Contents/Resources/plugins and not Contents/plugins.

Linux

In Linux, MuseScore looks for plugins in /usr/share/mscore-2.0/plugins and in
~/.local/share/data/MuseScore/MuseScore 2/plugins.

Enable/disable plugins

To be able to access the installed plugins from the Plugins menu, they need to be enabled in the
Plugin Manager:

Create/edit/run plugins

It is possible to create new or edit existing plugins and run them via the Plugin Creator:
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Here also the documentation of all available elements can be found

Plugins installed by default

Some plugins come pre-installed with MuseScore, but they are not enabled by default. See →above
to enable plugins.

ABC Import

This plugin imports ABC text from a file or the clipboard. Internet connection is required, because it
uses an external web-service for the conversion, which uses abc2xml and gets send the ABC data,
returns MusicXML and imports that into MuseScore.

Break Every X Measures

This plugin enters line breaks in the interval you select on the selected measures or, if no measures
are selected, the entire score. It is no longer being distributed and has been replaced by Edit → Tools
→ Add/Remove Line Breaks. If you ever used an early beta version of MuseScore 2, though, you may
still see the plugin left over.

Notes → Color Notes

This demo plugin colors notes in the selection depending on pitch. It colors the note head of all notes
in all staves and voices according to the BoomWhackers convention. Each pitch has a different color.
C and C♯ have a different color. C♯ and D♭ have the same color.
To color all the notes in black, just run that plugin again (on the same selection). You could also use
the 'Remove Notes Color' plugin for this.

Create Score

This demo plugin creates a new score. It creates a new piano score with 4 quarters C D E F. It's a
good start to learn how to make a new score and add notes from a plugin.
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helloQml

This demo plugin shows some basic tasks.

Notes → Note Names

This plugin names notes. It displays the English names of the notes (as a staff text), for voice 1 and 3
above, for voice 2 and 4 below the staff, chords in a comma separated list, starting with the top note.
A translated version, which uses note names as per your language settings, is available from the
plugin repository.

panel

This demo plugin creates a GUI panel.

random

Creates a random score.

random2

Creates a random score too

run

This demo plugin runs an external command. Probably this will only work on Linux.

scorelist

This test plugin iterates through the score list.

ScoreView

Demo plugin to demonstrate the use of a ScoreView

Walk

This test plugin walks through all elements in a score

Tools

Some tools act as plugin as they "automate" some things, see Tools, actually some of those
mentioned there used to be plugins.

Příloha Velikost
Plugin_Creator_en.png 37.56 KB
Plugin_Manager_en.png 45.1 KB
Do you have an unanswered question? Post it in the forum.

Správce a vlastnosti předmětů
Most elements have advanced options available via right-click (also known as secondary-click), and
properties that can be viewed and changed in the Inspector.

Inspector
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To enable or disable the Inspector, go to View → Inspector or use the shortcut F8 (Mac: fn+F8). The
Inspector will be shown by default on the right of your screen.

When an element is selected, its properties will be shown in the Inspector.

Categories

There are different options in each of the categories in the Inspector.

Element offers the following controls: Visible, Color, and Horizontal/Vertical offset.

If the box for "Visible" is deselected, the element will turn gray in MuseScore and will not be printed
out or shown when exported as a PDF or image.

"Color" lets you choose the color of the element. The element will remain in this color when the score
is printed or exported.

"Horizontal offset" and "Vertical offset" allows you to fine tune the placement of an individual element
by inputting exact values for its offset from default position on an X/Y coordinate plane.

Other categories may be only shown in specific targeted cases, such as Barline, which is only present
when a barline is selected.
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Some elements may be related to other types of elements. An example would be to select a note that
has a dot and a beam, such as the E selected here:
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You have several categories of options related to the note, including Chord, Note, and Segment. But
notice that at the bottom, you also have access to options for related elements, including Stem, and in
this example Beam and Dot.

If you select a measure, the Inspector will only show those options common to each note in the
measure: Visible/Invisible and Color. To edit the properties of the measure itself, right-click an empty
part of the measure and select "Measure Properties" as shown below.

When several elements are selected, if they have a different value for a given property, the property
will be displayed in blue. If you change this property, it will change for all selected elements.

Properties (accessed via right-click)

Measure properties

To edit the properties of a measure, right-click an empty part of the measure and select "Measure
Properties."
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From within an open Measure Properties window, you can move to edit the previous or next measure
via these buttons, at the bottom left of the window:  (note that while the window changes,
the measure shown as selected in your score does not. Be careful).

Staff properties

Staff Properties are also accessed by right-clicking a measure, or by right-clicking the name of an
instrument.

Staff Properties actually includes both a Staff Properties section and a Part Properties section:
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Staff options include color, number of lines, space between lines, hiding options, staff size and so on.

Part options include instrument name, part name (used for part extraction), playback transposition,
and pitch range.

See also

Measure operations
Note input
Layout and formatting
Staff type properties
Part extraction

Do you have an unanswered question? Post it in the forum.

Tabulatura

Creation

With the 'New Score' wizard

In many cases, it is possible to have a tablature staff simply by choosing the 'right' instrument while
creating a new score with the 'New Score' wizard. Any instrument which is internally configured to use
tablature will generate a tablature staff by default; examples are Classical Guitar [Tablature], Bass
Guitar [Tablature], and Lute [Tablature].

By changing staff type

It is also possible to convert any standard type staff to a tablature-type and vice versa:

1. Right-click an empty spot of a measure of the staff you want to change to see the staff
contextual menu

2. Select Staff Properties... (if this item is not present in the menu, the clicked spot was not
empty and the contextual menu for some other object is shown)
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3. Press the Advanced Style Properties... button
4. In the Edit Staff Type dialog box, select one of the Tablature templates in the Templates drop

list and press the < Reset to Template button and/or customize the tablature as needed (this
dialog box is documented here)

5. Press OK to close the Edit Staff Type dialog box
6. Press OK to close the Edit Staff Properties dialog box

The selected staff will be converted to a tablature staff. Select "Standard" in step 4) to convert a
tablature to a standard staff.

It is then possible to enter a part in a standard staff and convert it to a tablature, and vice versa.

Changing instrument string data (tuning)

Tablatures 'notes' do not refer to pitches but to strings and fret positions. It is mandatory that your
tablature 'knows' which string tuning you refer to, or the note pitches generated from fret marks (for
instance, in linked staves, in playback or in generated audio files) will be wrong. It is important to do
this before starting entering any note, or the music will sound wrong.

Most built-in string instruments already contain 'standard' string tuning data. Occasionally, it is
necessary to adjust this data - such examples include when working with a non-standard tuning
(scordatura), if the specific instrument does not exist and a similar one was been selected when the
score was initially created, or when using an instrument without 'standard' tuning. It is also good
practice to always review the actual tuning, even for 'standard' situations.

To view / edit the string tuning:

1. Right-click on an empty spot of a measure of the staff you want to change to get the staff
contextual menu

2. Select Staff Properties...
3. Press the Edit String Data... button at the bottom of the dialog box (this button is only shown

if the instrument has been defined as a stringed instrument)
4. The "String Data" dialog box opens: review the current string data and make any needed

change via the New String..., Edit String..., Delete String buttons
5. Check the Number of frets" is correct or adjust it (if not)
6. Press OK to close the "Edit String Data" dialog box
7. Press OK to close the "Staff/Part Edit Properties" dialog box

Note: The check boxes in the Open column are used to mark individual strings as always open
(unfretted), as in the lute. Proper notations of lute bass strings is not yet implemented, but proper
indication of string properties is already possible to support future developments.

If tuning is changed when the tablature for that instrument already contains some notes, fret marks
will be adjusted to produce the same notes with the new tuning (if possible).

The number of frets (either physical frets or 'virtual' positions) determines the maximum fret number a
string can receive.

Any change you make to the string tuning will only affect that particular instrument for that particular
score, and will not alter any program default or built-in definition.

Configuring a tablature

The default properties of a tablature are suitable in a modern guitar tablature score. For other
instruments and/or other genres, it can be useful to change these properties.

Properties of a tablature, as well as of other types of staves, can be changed with the Staff Type
editor. The editor can be accessed as described above and is documented here.

Multiple staves

Sometimes it is useful to show a pitched staff along with a tablature staff. MuseScore allows to "link"
staves so that changes in one staff are also applied to the linked one. If a pitched staff is linked to a
tablature you may use either staff for note input indifferently.

To create a linked staff:
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1. Open the instrument editor (menu Create → Instruments... or I key)
2. Select the staff you want to link to
3. Press the Add linked Staff button to create a new staff linked to the selected one
4. Press OK

Once the new linked staff is created, you will usually want to change its type (e.g. to tablature) and/or
change its type properties, as described above.

If chords are entered in the pitched staff (or copied from another staff with Ctrl+C / Ctrl+V), in the
tablature MuseScore tries to distribute the note across the strings to avoid fretting conflicts (multiple
notes on the same string); if this is not possible, conflicting notes are drawn in the tablature with a red
background and have to be adjusted by hand (see below Editing Notes).

Inputting new notes

Keyboard:

Switch to note input mode (N): a short 'blue rectangle' appears around one tablature string: this is
the current string
Select note/rest duration (see below)
Press ↑ or ↓ to select the needed string
Press 0 to 9 to enter a fret mark from 0 to 9 on the current string; to enter numbers with several
digits press each digit in sequence (the program will anyway refuse to enter a number higher
than the maximum fret defined for the instrument). Keys A to L (skipping I) can also be used,
which is convenient when working on a French tablature
It is also possible to correct the fret number with Shift+↑ or Shift+↓

Mouse:

Enter note input mode and select the note duration (see below)
Click on a string to create a note there
Notes are initially created on fret 0 (or a for French tablatures): press Shift+↑ several times until
the right fret is reached

MuseScore refuses to place a second note on a string which already contains one; for this reason, it is
usually better to fill chords from the highest string to the lowest.

Selecting the note value to enter
While in TAB entry mode, the default shortcuts for selecting note values (0 to 9) are re-used to enter
fret numbers. To select the value for the next entered notes, four different methods can be used:

Shift+1 to Shift+9 (availability of these shortcuts may depend on platforms and/or keyboard
layout)
NumPad 1 to Numpad 9 (if a numeric keypad exists and NumLock is on)
the input tool bar at the top of the screen
Q to decrease the selected value and W to increase it

Editing existing notes

While NOT in entry mode, three key combinations can be used to change a fret mark:

Shift+↑ / ↓ changes the note pitch. MuseScore selects the string and the fret: always the highest
possible string is selected.
↑ / ↓ changes the fret up/down without changing the string (ranging from 0 to the number of frets
defined in the "Edit String Data" dialog box).
Ctrl+↑ / ↓ moves the selected note to upper/lower string (if the string is free and can produce
that note).
Shift+X toggles the ghost note head on/off.

Summary of keys

Note input mode

Type: to get:
↑ Select above string as current.
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↓ Select below string as current.
Shift+1 to Shift+9 Select a duration
NumPad 1 to NumPad
9

Select a duration

Q Decrease current input duration.
W Increase current input duration.
0 to 9 Enter a fret digit / letter.

A to K Enter a fret digit / letter (I
excluded).

Shift+↑ Increase current fret mark.
Shift+↓ Decrease current fret mark.

Type: to get:

Normal mode

Type: to get:
Shift+↑ Increase the pitch of the selected note (MuseScore chooses the string).
↑ Increase the pitch without changing string.

Shift+↓ Decrease the pitch of the selected note (MuseScore chooses the
string).

↓ Decrease the pitch without changing string.
Ctrl+↑ Move note to above string, keeping the pitch.
Ctrl+↓ Move note to below string, keeping the pitch.
Shift+X Toggle the ghost note head on/off.

External links

Video tutorial: MuseScore in Minutes: Lesson 7 - Tablature and Drum Notation

Do you have an unanswered question? Post it in the forum.

Trámce přes osnovy
V notách pro klavír je pro zápis hudební fráze běžné používat obě osnovy (basový a houslový klíč).

Toto se v MuseScore dá zadat takto:

Zadejte všechny noty do jedné osnovy:

Ctrl+Shift+↓ přesune vybranou notu nebo akord na další osnovu (Mac: ⌘+Shift+↓.)
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Pokud chcete trámec posunout, klepněte na něj dvakrát, až se ukážou úchopy. Táhněte úchopy a
upravte rozvržení.

Podívejte se také na

kapitolu o taktových čarách, kde jsou vysvětleny taktové čáry jdoucí přes osnovy (to jest velká
osnova).

Do you have an unanswered question? Post it in the forum.

Vlastnosti notových osnov

Background

In MuseScore, each instrument’s staff has a number of properties which can be modified. Each staff
belongs to one of 3 groups:

Standard (the classic, ‘regular’, kind of staff)
Tablature
Percussion

Some of the properties of a staff depends on the group it belongs to. The general properties can be
examined and modified with the Edit Staff/Part Properties dialog box; this dialog box allows to
review and modify the group-specific properties.

The staff groups to which an instrument staff can belong depend on the instrument: any staff can be a
standard staff, but only staves of percussion instruments can be (or be turned into) percussion staves
and only staves of stringed instrument can be (or be turned into) tablature staves.

Each score is initially created with 17 built-in staff templates - one standard, three percussion and 13
tablature templates. Each template addresses a specific need, common enough or standardized
enough to deserve a specific template; each template can be modified (independently for each score
staff) and new templates can be created to accommodate specialized needs.

How to get there

This dialog box is accessed by right-clicking on an empty spot of a staff, selecting Staff
Properties...
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and then pressing the Advanced Style Properties... button, which for a normal staff looks like this:

For a percussion staff it looks like this:
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For a tablature staff it looks like this
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and this

Common items

The dialog box shows different items depending on the group of the selected staff type: standard,
tablature or percussion.
Some dialog items, however, are common to all types:

Name
A human-readable name

Lines
The number of lines making up the staff

Line Distance
The distance between two staff lines, expressed in spaces (abbr.: sp), i.e. the default distance
between two staff lines; 1.0 is (rather obviously) the default, a higher value will generate lines
spaced more widely apart, a lower value generates then more tightly spaced. It is not
recommended to change this value for the standard group (although it is possible); other groups
may have different default values, for instance tablatures usually have a line distance of 1.5 sp.

Show clef
Whether the staff clef will be shown.

Show time signature
Whether the staff time signature(s) will be shown or not.

Show barlines
Whether the staff bar lines will be shown.

There are also some buttons:

Template

Displays the list of all the staff templates available in the score and which can be applied to the
current staff.

< Reset to Template
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Resets all the staff properties to the properties of the selected template.

Add to Templates

Adds the current property set to the score as a new template (not yet implemented).

OK

Closes the dialog box, accepting the changes.

Cancel

Closes the dialog box, rejecting the changes.

Standard and Percussion staff specific items

Show key signature
Whether the staff key signature will be shown.

Show ledger lines
Whether the staff ledger lines will be shown.

Stemless
If checked, staff notes will have no stem, hook or beam.

Tablature staff specific items

Upside down
If not checked, the top tablature line will refer to the highest string and the bottom tablature line
will refer to the lowest string (most common case). If checked, the top tablature line will refer to
the lowest string and the bottom tablature line will refer to the highest line (used in Italian style
lute tablatures).

Fret marks

This group of properties defines the appearance of fret marks.

Font
The font used to draw the marks. Currently 4 fonts are provided supporting all the necessary
symbols in 4 different styles (modern serif, modern sans, Renaissance, Late Renaissance).
More fonts (or the possibility to use custom fonts) may be available in the future.

Size
The font size to use, in typographic points. Built-in fonts look usually good at a size of 9-10pt.

Vertical offset
MuseScore tries to place symbols in a sensible way and this value is usually not needed (set to
0) for built-in fonts. If the font has symbols not aligned on the base line (or in some other way
MuseScore does not expect), this value allows to move mark symbols up (negative offsets) or
down (positive offsets) for better vertical positioning. Values are in sp.

Numbers / Letters
Whether to use numbers (‘1’, ‘2’...) or letters (‘a’, ‘b’...) as fret marks. When letters are used, ‘j’ is
skipped and ‘k’ is used for the 9th fret.

On lines / Above lines
Whether marks should be placed on the string lines or above them.

Continuous / Broken

Whether string lines should pass ‘through’ fret marks or should stop at them.
Example of numbers on broken lines:

Example of letters above continuous lines:
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Example of 'upside down' tablature (same contents as number example above):

Note values

This group of properties defines the appearance of the symbols indicating note values.

Font
The font used to draw the value symbols. Currently 3 fonts are provided supporting all the
necessary symbols in 3 different styles (modern, Italian tablature, French tablature). More fonts
(or the possibility to use custom fonts) may be available in the future. Used only with the Note
symbols option.

Size
The font size to use, in typographic points. Built-in fonts look usually good at a size of 15pt.
Used only with the Note symbols option.

Vertical offset
As for Fret Marks above, but referring to value symbols instead. Used only with the Note
symbols option.

Shown as: None
No note value will be drawn (as in the examples above)

Shown as: Note symbols

Symbols in the shape of notes will be drawn above the staff. When this option is selected,
symbols are drawn only when the note value changes, without being repeated (by default) for a
sequence of notes all of the same value.
Example of values indicated by note symbols:

Shown as: Stems and beams

Note stems and beams (or hooks) will be drawn. Values are indicated for each note, using the
same typographic devices as for a regular staff; all commands of the standard Beam Palette can
be applied to these beams too.
Example of values indicated by note stems:

Repeat: Never / At new system / At new measure / Always
Whether and when to repeat the same note symbol, if several notes in sequence have the same
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value (only available with the Note symbols option).
Beside staff / Through staff

Whether stems are drawn as fixed height lines above/below the staff or run through the staff to
reach the fret marks each refers to (only available with the Stems and Beams option).

Above / Below staff
Whether stems and beams are drawn above or below the staff (only available with the Stems
and Beams option / Beside staff sub-option).

None / As short stems / As slashed stems
To select three different styles to draw stems for half notes (only available with the Stems and
Beams option / Beside staff sub-option).

Show rests
Whether note symbols should be used to indicate also the rests; when used for rests, note
symbols are drawn at a slightly lower position. Used only with the Note symbols option.

Preview

Displays a short score in tablature format with all the current parameters applied.

Do you have an unanswered question? Post it in the forum.

Vlastní paleta
Palettes are highly customizable. You can create/delete single palettes and populate them with
arbitrary elements from the master palette or from elements of a score. A set of palettes is called a
"workspace". You can maintain several

Nonexistent node nid: 39841.
and easily switch between them.
Only palettes in a custom workspace allow access to their context menu. So first you must create your
own workspace.

Palette menu

Right-clicking on a palette title shows the palette menu.

The menu offers the following operations:

Palette Properties: Selecting this entry opens the palette property dialog:

You also have a 'Show more elements' tick box there.

Insert New Palette: Creates a new empty palette which can be filled with elements from the
master palette, other palettes, or with elements from the score.

Move Palette Up: Moves the palette up in the list of palettes.
Move Palette Down: Moves the palette down in the list of palettes.
Enable Editing: Tick this to change the content of a palette. To avoid accidental changes,
editing is off by default.
Save Palette: Opens a file dialog and saves the palette into a file.
Load Palette: Opens a file dialog and reads a palette from a file.
Delete Palette

Right-clicking below the list of palettes opens the palette context menu. The menu allows you to
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change the palette behavior and to reset all palettes to default.

Single Palette Mode: If ticked allows only one palette to be open.
Reset to factory defaults: Replaces all palettes with the default version. Warning: this may
destroy all changes you make to the current set of palettes.

You can also right-click on an empty field in a palette and be able to add one with "Show More...".

(Enabled if the corresponding item is ticked in the palette's properties)

See also

Palette
Hlavní paleta

Do you have an unanswered question? Post it in the forum.

Vytažení hlasů skladby
If you have written a full ensemble score, MuseScore can create sheet music that shows only the
individual part for each musician in the ensemble.

Setting up the parts

You can define the parts at any point after creating a new score. You only need to define the parts
once for each score, but you can make changes if needed. The following instructions use a string
quartet as an example, but the same principles apply for any other ensemble.

1. From the main menu, choose File → Parts...

2. In the Parts window click New to create a "part definition"
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3. In the right pane, type the words you want to use for the "Part title" (this also serves for the
corresponding part of the filename when exporting)

4. Pick the instrument that you want to appear in your part by marking the relevant box in the right-
hand pane. Usually, you only want one instrument per part, but sometimes you might need a
part that includes more than one instrument (such as multiple percussion staves). MuseScore
allows you to mark as many instruments per part as you need

5. Repeat steps two through four (above) for each part as needed

6. Once you're done, press OK to dismiss the Parts window

You have now finished setting up the parts. You do not need to do this again, unless you add or
remove an instrument from your full score. In the current version of MuseScore, it is not possible to
split a single staff (that contains two or more voices) into separate parts. So, any instrument that you
want to print out a separate part for also needs to have its own staff in the full score.

Setup all parts in one go

If you have an orchestral score in which each instrument should be extracted, you can create the parts
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more easily:

1. Go to File → Parts...

2. Press the New All button (parts are named with the instrument name, and if needed with an
appended "-<number>")

3. Hit OK

Now you will see a tab for each part with your score.

Exporting the parts

1. Go to File → Export Parts...

2. Navigate to the place you want them to be exported to and select the file format (PDF is the
default)

3. For filename just enter whatever prefix is useful for all parts, or leave the default (the filename of
your score)

4. Hit OK

This will generate files with the names "<prefix>" + "-" + "<part name>.<extension>". In addition, when
exporting as PDF, this will also generate "<prefix>" + "-Score_And_Parts.pdf".

Saving

Parts and score are "linked", which means that any change to the content in one will affect the other,
but changes to the layout will not. When you have the parts created, they are saved along with the
score (if you open the score you have tabs for the score and every part you created).
You can, however, save each part individually by selecting its tab and use File → Save As...

Do you have an unanswered question? Post it in the forum.

Zpřístupnění
MuseScore comes with support for the free and open source NVDA screen reader for Windows. There
is no support at the moment for other screen readers such as Jaws for Windows, or VoiceOver for
Mac OS X.

Introduction

This document is written for blind and visually impaired users of MuseScore 2.0. It is not intended to
provide a full description of all of the features of MuseScore; you should read this in conjunction with
the regular MuseScore documentation. However, it should be noted that MuseScore 2.0 is not yet
released, so documentation is still very incomplete.

This document applies to any recent nightly builds (since November 1, 2014). The accessibility
features were introduced with the Beta 1 release from August 2014, but there have been a large
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number of fixes and improvements since then, both in accessibility and core functionality. The features
in this document have been tested on Windows with NVDA. Other screen readers and other operating
systems may work differently, or not at all.

At this point in time, MuseScore 2.0 is mostly accessible as a score reader, not so much as a score
editor. This document will focus on the score reading features, with only a brief description of score
editing.

Initial setup

When you run MuseScore for the first time, you may want to permanently disable the Start Center
window. To do so, go close the Start Center window first, then the Edit menu (Alt+E), choose
Preferences, and in there, uncheck Show Start Center. Save and close the preferences window.

Finding your way around

The user interface in MuseScore works much like other notation programs, or other document-
oriented programs in general. It has a single main document window in which you can work with a
score. MuseScore supports multiple document tabs within this window. It also supports a split-screen
view to let you work with two documents at once, and you can have multiple tabs in each window.
In addition to the score window, MuseScore has a menu bar that you can access via the shortcuts for
the individual menus:

File: Alt+F
Edit: Alt+E
View: Alt+V
Add: Alt+A
Notes: Alt+N
Layout: Alt+L
Style: Alt+S
Plugins: Alt+P
Help: Alt+H

Of these, only the File menu is of much interest when using MuseScore as a score reader. Once
opening a menu, it may take several presses of the Up or Down keys before everything is read properly.

There are also a number of toolbars, palettes, and subwindows within MuseScore, and you can cycle
through the controls in these using Tab (or Shift+Tab to move backwards through this same cycle).
When you first start MuseScore, or load a score, focus should be in the main score window. Pressing
Tab takes you to a toolbar containing a series of buttons for operations like New, Open, Play, and so
forth. Tab will skip any buttons that aren't currently active. The names and shortcuts (where
applicable) for these buttons should be read by your screen reader.

Once you have cycled through the buttons on the toolbar, the next window Tab will visit is the Palette.
This would be used to add various elements to a score, but it is not currently accessible except for two
buttons that are visited by Tab: a drop down to select between different workspaces (a saved
arrangement of palettes), and a button to create a new workspace.

If you have opened one of the optional windows, such as the Inspector, or the Selection Filter, the Tab
key will also visit these. You can close windows you do not need by going to the View menu and
making sure none of the first set of checkboxes are selected (the windows that appear before the
Zoom settings). By default, only the Palette, Navigator and MuseScore Connect should be selected,
and the latter two are not included in the Tab order.

To return focus to the score window after visiting the toolbar, or a subwindow, press Esc. This also
clears any selection you may have made in the score window.

The score window

When you first start MuseScore 2.0, an empty example score entitled “My First Score” is loaded by
default. If you wish to experiment with editing features, this would be a good place to begin.
Otherwise, you will probably want to start by loading a score. MuseScore uses the standard shortcuts
to access system commands like Ctrl+O (Mac: Cmd+O) to open a file, Ctrl+S (Mac: Cmd+S) to save,
Ctrl+W (Mac: Cmd+W) to close, etc.

If you press Ctrl+O (Mac: Cmd+O) to load a score, you are presented with a fairly standard file dialog
(actually provided by Qt). MuseScore can open scores in its own format (MSCZ or MSCX) as well as
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import scores in the standard MusicXML format, in MIDI format, or from a few other programs such as
Guitar Pro, Capella, and Band-in-a-Box. Once you have loaded a score, it is displayed in a new tab
within the score window. You can move between the tabs in the score window using Ctrl+Tab (does
not apply for Mac).

There are a few interesting things you can do with a loaded score besides reading it note by note. You
can press Space to have MuseScore play the score for you. You can use File / Export to convert to
another format, including PDF, PNG, WAV, MP3, MIDI, MusicXML, etc. And of course, you can print it
via File / Print or Ctrl+P (Mac: Cmd+P).

If a score contains multiple instruments, it may already have linked parts generated. Linked parts are
presented as part tabs within score tabs, but currently, there is no way to navigate these part tabs
using the keyboard. The parts would not normally contain information different from the score; they
would just be displayed differently (each part on its own page). If a score does not already have parts
generated, you can do so through File / Parts, and that dialog is accessible. If you wish to print the
parts, you can work around the inability of accessing part tabs individually by using the File / Export
Parts dialog, which automatically exports PDF’s (or other formats) for all parts in one step.

Score reading

When you first load a score, the score window has the keyboard focus, but there will be nothing
selected. The first step to reading a score is to select something, and the most natural place to begin
is with the first element of the score. Ctrl+Home (Mac: Cmd+Home) will do this. You will probably also
want to use this, should you ever clear your selection by pressing Esc.

As you navigate between elements, your screen reader should give the name of the selected element
(most likely the clef at the beginning of the top staff of your score). You will hear it read the name of
the element (for example, “Treble clef”) and also give position information (for example, “Measure 1;
Beat 1; Staff 1”). The amount of information read is not currently customizable, but we tried to place
the most important first so you can quickly move on to the next element before it has finished reading,
or just ignore the rest of what is read. Pressing Shift currently interrupts the reading, which might also
be useful.

Most navigation in MuseScore is centered around notes and rests only – it will skip clefs, key
signatures, time signatures, barlines, and other elements. So if you just use the standard Right and
Left keys to move through your score, you will only hear about notes and rests (and the elements
attached to them). However, there are two special navigation commands that you will find useful to
gain a more complete summarization of the score:

Next element: Ctrl+Alt+Shift+Right (Mac: Cmd+Option+Shift+Right)
Previous element: Ctrl+Alt+Shift+Left (Mac: Cmd+Option+Shift+Left

These commands include clefs and other elements that the other navigation commands skip, and also
navigate through all voices within the current staff, whereas other navigation commands such as Right
and Left only navigate through the currently selected voice until you explicitly change voices. For
instance, if you are on a quarter note on beat 1 of measure 1, and there are two voices in that
measure, then pressing Right will move on to the next note of voice 1—which will be on beat 2—
whereas pressing Ctrl+Alt+Shift+Right (Mac: Cmd+Option+Shift+Right) will stay on beat 1 but move
to the note on voice 2. Only once you have moved through all notes on the current beat on the current
staff will the shortcut move you on to the next beat. The intent is that this shortcut should be useful for
navigating through a score if you don’t already know what the contents are.

When you navigate to an element, your screen reader should read information about it. For notes and
rests, it will also read information about elements attached to them, such as lyrics, articulations, chord
symbols, etc. For the time being, there is no way to navigate directly to these elements.
One important note: Up and Down by themselves, with Shift, or with Ctrl / Cmd are not useful shortcuts
for navigation! Instead, they change the pitch of the currently selected note or notes. Be careful not to
inadvertently edit a score you are trying to read. Up and Down should only be used with Alt/Option if
your intent is navigation only. See the list of navigation shortcuts below.

Moving forwards or backwards in time

The following shortcuts are useful for moving “horizontally” through a score:

Next element: Ctrl+Alt+Shift+Right
Previous element: Ctrl+Alt+Shift+Left
Next chord or rest: Right
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Previous chord or rest: Left
Next measure: Ctrl+Right
Previous measure: Ctrl+Left
Go to measure: Ctrl+F
First element: Ctrl+Home
Last element: Ctrl+End

Moving between notes at a given point in time

The following shortcuts are useful for moving “vertically” through a score:

Next element: Ctrl+Alt+Shift+Right

Previous element: Ctrl+Alt+Shift+Left
Next higher note in voice, previous voice, or staff above: Alt+Up
Next lower note in voice, next voice, or staff below: Alt+Down
Top note in chord: Ctrl+Alt+Up
Bottom note in chord: Ctrl+Alt+Down

The Alt+Up and Alt+Down commands are similar to the Ctrl+Alt+Shift+Right and
Ctrl+Alt+Shift+Left commands in that they are designed to help you discover the content of a score.
You do not need to know how many notes are in a chord, how many voices are in a staff, or how
many staves are in a score in order to move vertically through the score using these commands.

Filtering score reading

Excluding certain elements like lyrics, or chord names while reading the score is possible by using the
Selection filter (F6). Uncheck those elements you don't want to read.

Score playback

The Space bar serves both to start and stop playback. Playback will start with the currently selected
note if one is selected; where playback was last stopped if no note is selected; or at the beginning of
the score on first playback.

MuseScore supports looped playback so you can repeat a section of a piece for practice purposes. To
set the “in” and “out” points for the loop playback via the Play Panel (F11):

1. First select the note in the score window where the loop should start
2. Go to the Play Panel and press the Set loop In position toggle button
3. Back to the score window, navigate to the note where you want the loop to end
4. Switch again to Play Panel, and press the Set loop Out position toggle button
5. To enable or disable the loop, press the Loop Playback toggle button

You can also control the loop playback and control other playback parameters, such as overriding the
basic tempo of a score, using the View / Play Panel (F11).

Score editing

Score editing is currently not very accessible – too many score elements require intervention of the
mouse in order to place objects onto a score. Additionally, visual reference and manual adjustment of
the position of various elements is sometimes necessary due to MuseScore's limited support for
conflict avoidance of elements.

In contrast, MuseScore does often provide ample default, and a platform to experiment with the basics
of note input.
To enter note input mode, first navigate to the measure in which you would like to enter notes, then
press “N”. Almost everything about note input is designed to be keyboard accessible, and the standard
documentation should be good to help you through the process. Bear in mind that MuseScore can
either be in note input or normal mode, and it won’t always be clear which mode of these you are in.
When in doubt, press Esc. If you were in note input mode, this will take you out. If you were in normal
mode, you will stay there, although you will also lose your selection.

Customization

You can customize the keyboard shortcuts using Edit / Preferences / Shortcuts. At some point, we
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may provide a set of special accessibility-optimized shortcuts and/or a way of saving and loading sets
of shortcut definitions.

Do you have an unanswered question? Post it in the forum.

Číslovaný bas

Adding a new figured bass indication

1. Select the note to which the figured bass applies
2. Press the Figured Bass shortcut (default Ctrl+G; can be changed in Preferences)
3. Enter the text in the editor 'blue box' as required (see below)
4. Press Space to move to the next note ready for another figured bass indication (or click outside

the editor box to exit it)

With Space, the editor advances to the next note, or rest of the staff to which figured bass is being
added. To move to a point in between, or to extend a figured bass group for a longer duration, see
below Group Duration.

Tab advances the editing box to the beginning of the next measure.

Shift+Space moves the editing box to the previous staff note or rest.

Shift+Tab moves the editing box to the beginning of the previous measure.

Text format

Digits

Digits are entered directly. Groups of several digits stacked one above the other are also entered
directly in a single text, stacking them with Enter:

Accidentals

Accidentals can be entered using regular keys:

To enter: type:
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double flat bb
flat b
natural h
sharp #
double sharp ##

To enter: type:

These characters will automatically turn into the proper signs when you leave the editor. Accidentals
can be entered before, or after a digit (and of course, in place of a digit, for altered thirds), according to
the required style; both styles are properly aligned, with the accidental 'hanging' at the left, or the right.

Combined shapes

Slashed digits or digits with a cross can be entered by adding \, / or + after the digit (combining
suffixes); the proper combined shape will be substituted when leaving the editor:

The built-in font can manage combination equivalence, favoring the more common substitution:

1+, 2+, 3+, 4+ result in  (or )

and 5\, 6\, 7\, 8\, 9\ result in  (or )

Please remember that / can only by combined with 5; any other 'slashed' figure is rendered with a
question mark.

+ can also be used before a digit; in this case it is not combined, but it is properly aligned ('+' hanging
at the left side).

Parentheses

Open and closed parentheses, both round: '(', ')' and square: '[', ']', can be inserted before and after
accidentals, before and after a digit, before and after a continuation line; added parentheses will not
disturb the proper alignment of the main character.

Notes:

The editor does not check that parentheses, open and closed, round or square, are properly
balanced.
Several parentheses in a row are non-syntactical and prevent proper recognition of the entered
text.
A parenthesis between a digit and a combining suffix ('+', '\', '/') is accepted, but prevents shape
combination.

Continuation lines

Continuation lines are input by adding an '_' (underscore) at the end of the line. Each digit of a group
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can have its own continuation line:

Continuation lines are drawn for the whole duration of the figured bass group (but currently are not
continued on following systems, the same as for lyric continuation lines).

'Extended' continuation lines

Occasionally, a continuation line has to connect with the continuation line of a following group, when a
chord degree has to be kept across two groups. Examples (both from J. Boismortier, Pièces de viole,
op. 31, Paris 1730):

In the first case, each group has its own continuation line; in the second, the continuation line of the
first group is carried 'into' the second.

This can be obtained by entering several (two or more) underscores "__" at the end of the text line of
the first group.

Duration

Each figured bass group has a duration, which is indicated by a light gray line above it (of course, this
line is for information only and it is not printed or exported to PDF).

Initially, a group has the same duration of the note to which it is attached. A different duration may be
required to fit several groups under a single note or to extend a group to span several notes.

To achieve this, the key combinations listed below can be used; each of them

advances the editing box by the indicated duration
AND
sets the duration of the previous group up to the new editing box position.

Pressing several of them in sequence without entering any figured bass text repeatedly extends the
previous group.

Type: to get:
Ctrl+1 1/64
Ctrl+2 1/32
Ctrl+3 1/16
Ctrl+4 1/8 (quaver)
Ctrl+5 1/4 (crochet)
Ctrl+6 half note (minim)

Ctrl+7
whole note
(semibreve)

Ctrl+8 2 whole notes (breve)

(The digits are the same as are used to set the note durations)

Setting the exact figured bass group duration is only mandatory in two cases:
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1. When several groups are fit under a single staff note (there is no other way).
2. When continuation lines are used, as line length depends on the group duration.

However, it is a good practice to always set the duration to the intended value for the purposes of
plugins and MusicXML.

Editing existing figured basses

To edit a figured bass indication already entered:

Select it, or the note it belongs to and press the same Figured Bass shortcut used to create a
new one
or
Double-click it

The usual text editor box will open with the text converted back to plain characters ('b', '#' and 'h' for
accidentals, separate combining suffixes, underscores, etc.) for simpler editing.

Once done, press Space to move to a next note, or click outside the editor box to exit it, as for newly
created figured basses.

Style

The Style → General... menu command allows to configure how figured bass is rendered. Select
"Figured Bass" in the list on the left side to display the following dialogue box:

The Font drop list contains all the fonts which have been configured for figured bass. A standard
installation contains only one font, "MuseScore Figured Bass", which is also the default font.

The Size is the size of the font (in points). It is linked to the spatium value: for the default spatium, the
entered value is used; for smaller or larger spatium values, a size value proportionally smaller or larger
is used.

Vertical Position is the distance (in spatia) from the top of the staff to the top margin of the figured
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bass text. Negative values go up (figured bass above the staff) and positive values go down (figured
bass below the staff: a value greater than 4 is needed to step over the staff itself).

Line Height is the distance between the base line of each figured bass line; it is expressed in percent
of the font size.

The following picture visualizes each numeric parameter:

The Top / Bottom radio buttons select the vertical alignment: with Top, the top line of each group is
aligned with the main vertical position and the group 'hangs' from it (this is normally used with figured
bass notation and is the default); with Bottom, the bottom line is aligned with the main vertical position
and the group 'sits' on it (this is sometimes used in some kinds of harmonic analysis notations):

The Modern / Historic radio buttons select the typographic style of the combined shapes. The
difference between the two styles is shown below:

Proper syntax

For the relevant substitutions and shape combinations to take effect and for proper alignment, the
figured bass mechanism expects input texts to follow some rules (which are in any case, the rules for
a syntactical figured bass indication):

There can be only one accidental (before or after), or only one combining suffix per figure;
There cannot be both an accidental and a combining suffix;
There can be an accidental without a digit (altered third), but not a combining suffix without a
digit.
Any other character not listed above is not expected.

If a text entered does not follow these rules, it will not be processed: it will be stored and displayed as
it is, without any layout.

Summary of keys

Type: to get:
Ctrl+G Adds a new figured bass group to the selected note.
Space Advances the editing box to the next note.
Shift+Space Moves the editing box to the previous note.
Tab Advances the editing box to the next measure.
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Shift+Tab Moves the editing box to the previous measure.
Ctrl+1 Advances the editing box by 1/64, setting the duration of the previous group.
Ctrl+2 Advances the editing box by 1/32, setting the duration of the previous group.
Ctrl+3 Advances the editing box by 1/16, setting the duration of the previous group.
Ctrl+4 Advances the editing box by 1/8 (quaver), setting the duration of the previous group.
Ctrl+5 Advances the editing box by 1/4 (crochet), setting the duration of the previous group.

Ctrl+6
Advances the editing box by a half note (minim), setting the duration of the previous
group.

Ctrl+7
Advances the editing box by a whole note (semibreve), setting the duration of the
previous group.

Ctrl+8
Advances the editing box by two whole notes (breve), setting the duration of the
previous group.

B B Enters a double flat.
B Enters a flat.
H Enters a natural.
# Enters a sharp.
# # Enters a double sharp.
_ Enters a continuation line.
_ _ Enters an extended continuation line.

Type: to get:

Do you have an unanswered question? Post it in the forum.

Nové vlastnosti v MuseScore 2.0
Na přehled nových vlastností se podívejte v článku Novinky MuseScore 2, Poznámky k vydání
MuseScore 2.0, Poznámky k vydání MuseScore 2.0.1, and Změny v MuseScore 2.0.
Dokumentace nových funkcí je dostupná v kapitole, ke které logicky náleží (kromě té, která odkazuje
na povýšení z 1.3 na 2.0) , ale pro uživatele přicházející z 1.x je zde sbírka odkazů, aby hned viděli, co
se teď dá dělat...

Podívejte se také na

Album (→Advanced topics)
View modes: Continuous view and Navigator (→Basics)
Copy and paste: Selection filter (→Basics)
Custom palette (→Advanced topics)
Early music features (→Advanced topics)
Figured bass (→Advanced topics)
Grid-based movement of symbols and staff text (→Text)
Image capture (→Formatting)
Inspector and object properties (→Advanced topics)
Measure operations: Split and join (→Basics)
MIDI import (→Sound and playback)
Mid-staff instrument change (→Sound and playback)
Part extraction (new options available) (→Advanced Topic)
Rehearsal marks: Automatic next rehearsal mark and Search for a rehearsal mark (→Text)
Save/Export (→Basics)
Staff type properties (→Advanced topics)
Swing (→Sound and playback)
Tablature (→Advanced topics)
Nonexistent node nid: 39841.
(→Advanced topics)
Master palette (→Advanced topics)
Layout and formatting (some options have changed, and there is a new "apply to all parts"
feature) (→Formatting)
Break and spacer: Section break (→Formatting)
Selection modes: Select all similar new options (same subtype) (→Basics)
Create a new score: start center (→Basics)
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Languages settings and translation updates (→Basics)
Helping and improve translation (→Support)
Accidentals: Respell pitches (→Notation)
Re-pitch mode (→Advanced topics)
Tools (→Advanced topics)
Meta tags (→Advanced topics)

Do you have an unanswered question? Post it in the forum.

Podpora
Tato kapitola popisuje, kde a jak najít pomoc pro MuseScore: nejlepší místo, kam se podívat, nejlepší
způsob, jak klást otázky ve fórech a rady ohledně hlášení chyb.

Nahlášení chyby nebo žádost o podporu
Please use the search function of the website to see if someone has already encountered the same
problem.

Before submitting your support request in the forum:

Look for a solution in the Příručka.
Check the How Tos, FAQs and Tutorials

If posting in either the issue tracker (for established reports), or forum (for enquiries/discussions):

Try to reproduce the issue with the latest nightly (not the 1.x series, as it won't receive further
maintenance). You may also view the older and new version history to check whether it has
been fixed/implemented already.

Please include as much of the following information as you know and limit each issue to one
report:

Version/revision of MuseScore you are using (e.g. version 2.0, revision 2902cf6). Check
Help → About... (Mac: MuseScore → About MuseScore...).
Operating system being used (e.g. Windows XP SP3, Mac OS 10.7.5 or Ubuntu 10.10)
If reporting a bug, describe the precise steps that lead to the problem (where do you click,
what keys do you press, what do you see, etc.).
If you are not able to reproduce the problem with the steps, it is probably not worth
reporting it as the developers will not be able to reproduce (and solve) it either. Remember
that the goal of a bug report is not only to show the problem, but to allow others to
reproduce it easily.

See also

How to write a good bug report: step-by-step instructions

Do you have an unanswered question? Post it in the forum.

Navrácení k továrnímu nastavení
Recent versions of MuseScore have the option to revert back to the standard built-in presets or
"factory-settings". This can be helpful if your settings are corrupted. This is not a normal occurrence,
so it is best to consult the forums first, as there may be a way to solve your problem without resetting
everything.

Warning: Reverting to "factory settings" removes any changes you have made to the preferences,
palettes, or window settings.

Instructions for Windows

1. If you have MuseScore open, you need to close it first (File → Quit)
2. Type Windows key+R to open the Run dialog. (The Windows key is the one with the logo for

Microsoft Windows.)
3. Click Browse...
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4. Look for MuseScore.exe on your computer. The location may vary depending on your
installation, but it is probably something similar to My Computer → Local Disk → Program Files
(or Program Files (x86)) → MuseScore2 → bin → MuseScore.exe

5. Click Open to leave the Browse dialog and return to the Run dialog. The following text (or
something similar) should display in the Run dialog

"C:\Program Files\MuseScore2\bin\MuseScore.exe"

For 64-bit Windows, the location is

"C:\Program Files (x86)\MuseScore2\bin\MuseScore.exe"

6. Click after the quote and add a space followed by a hyphen and a capital F: -F

7. Press OK

After a few seconds, MuseScore should start and all the settings reverted to "factory settings".

For advanced users, the main preference file is located at:

Windows Vista or later: C:\Users\<USERNAME>\AppData\Roaming\MuseScore\MuseScore2.ini
Windows XP or earlier: C:\Documents and Settings\USERNAME\Application
Data\MuseScore\MuseScore2.ini

The other preferences (palette, session...) are in:

Windows Vista or later: C:\Users\<USERNAME>\AppData\Local\MuseScore\MuseScore2\
Windows XP or earlier: C:\Documents and Settings\USERNAME\Local Settings\Application
Data\MuseScore\MuseScore2\

Instructions for Mac OS X

1. If you have MuseScore open, you need to quit the application first (File → Quit)
2. Open Terminal (in Applications/Utilities) and a session window should appear

3. Type (or copy/paste) the following command into your terminal line (include the '/' at the front):

/Applications/MuseScore\ 2.app/Contents/MacOS/mscore -F

This resets all MuseScore preferences to factory settings and immediately launches the MuseScore
application. You can now quit Terminal, and continue using MuseScore.

For advanced users, the main MuseScore preference file is located at
~/Library/Preferences/org.musescore.MuseScore2.plist.

The other preferences (palette, session...) are in ~/Library/Application\
Support/MuseScore/MuseScore2/

Instructions for Linux (please adapt for flavors other than Ubuntu)

1. If you have MuseScore open, you need to quit the application first (File → Quit)
2. From the Ubuntu main menu, choose Applications → Accessories → Terminal. A Terminal

session window should appear

3. Type, (or just copy/paste) the following command into your terminal line:

mscore -F

This resets all MuseScore preferences to factory settings and immediately launches the MuseScore
application. You can now quit Terminal, and continue using MuseScore.

For advanced users, the main MuseScore preference file is located at
~/.config/MuseScore/MuseScore2.ini. The other preferences (palette, session...) are in
~/.local/share/data/MuseScore/MuseScore2/

See also
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Command line options

Do you have an unanswered question? Post it in the forum.

Překlad
Do you have a translation to add? That can be done easily via the web, as mentioned in Development
/ Translating ...

Software translation

1. Ask in the forum to improve translation
2. Connect to Transifex/MuseScore http://translate.musescore.org, which will redirect you to

https://www.transifex.com/projects/p/musescore
3. Select the language and then the section you want to help with (musescore or instruments)
4. Click on the "translate" button (the button text will depend on your language...)
5. Search for "strings" (informational meaning) you want to translate (you could filter "already

translated items")

Here is a technical explanation: Continuous translation for MuseScore 2.0

Website and handbook translation

See Translation instructions

See also

Language Settings and Update Translation, Update Translation

Do you have an unanswered question? Post it in the forum.

Známé potíže s vybavením

Hardware incompatibilities

The following software is known to crash MuseScore on startup :

Samson USB Microphone, driver name "Samson ASIO Driver", samsonasiodriver.dll. More info
Digidesign MME Refresh Service. More info
Windows XP SP3 + Realtek Azalia Audio Driver. More info
Wacom tablet. More info and QTBUG-6127

Software incompatibilities

Maple virtual cable is known to prevent MuseScore from closing properly.
KDE (Linux) window settings can cause the whole window to move when dragging a note.
Changing the window settings of the operating system avoids the problem.

AVG Internet Security hangs MuseScore

MuseScore requires access to your internet connection with AVG. MuseScore doesn't need an
internet connection to function, but if AVG blocks it, MuseScore hangs.

If AVG prompts you, Allow MuseScore and check "Save my answer as a permanent rule and do not
ask me next time."

If it doesn't prompt you anymore,

1. Open the AVG user interface (right-click on the AVG icon, close to your clock -> Open AVG User
Interface

2. Click on Firewall
3. Click Advanced Settings
4. Click Applications
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5. Find MSCORE.EXE in the list and double click it
6. Change Application Action to Allow for All

Font problem on Mac OS X

MuseScore is known to display notes as square when some fonts are damaged on Mac OS X.
To troubleshoot this issue:

1. Go to Applications -> Font Book
2. Select a font and press ⌘+A to select them all
3. Go to File -> Validate Fonts
4. If any font is reported as damaged or with minor problems, select it and delete it
5. Restart MuseScore if necessary

In this forum article, a user believes to have found the font "Adobe Jenson Pro (ajenson)" to be the
culprit, regardless of not being reported as broken, or problematic as per the above validation, and
solved the problem by deleting that font, so this is worth checking too.

Font problem on Linux

If the default desktop environment application font is set to bold, MuseScore will not display the notes
properly.
To troubleshoot this issue (gnome 2.*/MATE users):

1. Right-click on your desktop and select Change Desktop background
2. Click on Fonts tab
3. Set Regular style for Application font
4. Restart MuseScore if necessary

For GNOME 3/SHELL users

1. Open the shell and open "Advanced Settings"
2. Click on the Fonts option in the list
3. Set the default font to something non-bold
4. Restart MuseScore if necessary

Save As dialog empty on Linux

Some users reported that the Save As dialog is empty on Debian 6.0 and Lubuntu 10.10.
To troubleshoot this issue:

1. Type the following in a terminal

which mscore

2. The command will answer with the path of mscore. Edit it with your preferred text editor and add
the following line at the beginning

export QT_NO_GLIB=1

Launch MuseScore and the problem should be solved.

Do you have an unanswered question? Post it in the forum.

Dodatek
Klávesové zkratky
Most keyboard shortcuts can be customized via Edit → Preferences... → Shortcuts tab (Mac:
MuseScore → Preferences... → Shortcuts tab). Below is a list of some of the initial shortcut settings.

Navigation

Beginning of score: Home
Last page of score: End
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Next score: Ctrl+Tab
Previous score: Shift+Ctrl+Tab

Zoom in: Ctrl++ or Ctrl + mouse wheel
Zoom out: Ctrl+- or Ctrl + mouse wheel

Next page: Pg Dn or Shift + mouse wheel
Previous page: Pg Up or Shift + mouse wheel

Next measure: Ctrl+→ (Mac: ⌘+→)
Previous measure: Ctrl+← (Mac: ⌘+←)

Next note: →
Previous note: ←

Note below (within a chord or on lower staff): Alt+↓
Note above (within a chord or on higher staff): Alt+↑

Top note in chord: Ctrl+Alt+↑ (Ubuntu uses this shortcut for Workspaces instead)
Bottom note in chord: Ctrl+Alt+↓ (Ubuntu uses this shortcut for Workspaces instead)

Note input

Begin note input mode: N
Leave note input mode: N or Esc

Duration

1 ... 9 selects a duration. See also Note input.

Half duration of previous note: Q
Double duration of previous note: W

Voices

Voice 1: Ctrl+I Ctrl+1 (Mac ⌘+I ⌘+1)
Voice 2: Ctrl+I Ctrl+2 (Mac ⌘+I ⌘+2)
Voice 3: Ctrl+I Ctrl+3 (Mac ⌘+I ⌘+3)
Voice 4: Ctrl+I Ctrl+4 (Mac ⌘+I ⌘+4)

Pitch

Pitches can be entered by their letter name (A-G), or via MIDI keyboard. See Note input for full details.

Repeat previous note: R

Raise pitch by octave: Ctrl+↑ (Mac: ⌘+↑)
Lower pitch by octave: Ctrl+↓ (Mac: ⌘+↓)

Raise pitch by semi-tone (prefer sharp): ↑
Lower pitch by semi-tone (prefer flat): ↓
Raise pitch diatonically: Alt+Shift+↑
Lower pitch diatonically: Alt+Shift+↓

Circle through enharmonic notes: J

Rest: 0 (zero)

Interval

Add interval above current note: Alt+[Number]

Direction

Flip direction (stem, slur, tie, tuplet bracket, etc.): X
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Mirror note head: Shift+X

Articulations

Staccato: Shift+S
Crescendo: <
Decrescendo: >

Text entry

Staff text: Ctrl+T
System text: Ctrl+Shift+T
Tempo text: Ctrl+Alt+T
Rehearsal Mark: Ctrl+M

Lyrics entry

Enter lyrics on a note: Ctrl+L
Previous lyric syllable: Shift+Space
Next lyric syllable: if the current and the next syllables are separated by a '-': -, else Space
Move lyric syllable left by 1sp: ←
Move lyric syllable right by 1sp: →
Move lyric syllable left by 0.1sp: Ctrl+←
Move lyric syllable right by 0.1sp: Ctrl+→
Move lyric syllable left by 0.01sp: Alt+←
Move lyric syllable right by 0.01sp: Alt+→

Up to previous stanza: Ctrl+↑ (Mac: ⌘+↑)
Down to next stanza: Ctrl+↓ (Mac: ⌘+↓)

For more lyric shortcuts, see Lyrics.

Display

Navigator: F12 (Mac: fn+F12)
Play Panel: F11 (Mac: fn+F11)
Mixer: F10 (Mac: fn+F10)
Palette: F9 (Mac: fn+F9)
Inspector: F8 (Mac: fn+F8)

See also

Preferences: Shortcuts

Do you have an unanswered question? Post it in the forum.

Známá omezení MuseScore 2.0
While all members of the development team did their best to make the software easy to use and bug-
free, there are some known issues and limitations in MuseScore 2.0.

Basics

Save Selection

'Save Selection...' is currently pretty limited: If the selection doesn't contain a clef, time or key
signature, the saved score will be in treble clef, 4/4 time signature, and C major key signature,
although all pitches are kept, accidentals added as needed, and even irregular measures are kept.

Local Time Signatures

The local time signature feature, which allows you to have different time signatures in different staves
at the same time, is very limited. You can only add a local time signature to measures that are empty,
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and only if there are no linked parts. When adding notes to measures with local time signatures, you
can enter notes normally via note input mode, but copy and paste does not work correctly and may
lead to corruption or even crashes. The join and split commands are disabled for measures with local
time signatures.

Note input

Tablature staff linked with Standard staff

With linked Standard and Tablature staves, if multiple note chords are entered in the Standard staff,
each chord should be entered from its top note to the bottom, otherwise the fretting automatically
assigned note by note in the Tablature staff may be unexpected (Note: This does not apply to a) note
input directly in the Tablature staff nor to b) note input in a Standard staff not linked to a Tablature: in
both cases entry order is indifferent).

Sound and playback

Instrument change

An instrument change does not change transposition, should any of the instruments involved require
that. If this is needed, it is necessary to use different staves and the 'Hide empty staves' option.
Actually there is no real instrument change, just a change of the sound, so not only transposition is not
taken into account but also the instrument's range, and the part's name is left unchanged.

Mixer

Changing values in the mixer does not mark the score 'dirty'. That means if you close a score you may
not get the warning "Save changes to the score before closing?". Changing mixer values are also not
undoable.

Layout

Header & Footer

There is no way to edit Header and Footer in a WYSIWYG manner. The fields in Style → General →
Header, Footer, Numbers are plain text. They can contain "HTML like" syntax, but the text style,
layout, etc. can't be edited with a WYSIWYG editor.

Do you have an unanswered question? Post it in the forum.

Slovníček
The glossary is a work in progress, please help if you can. You can discuss about this page on
the documentation forum
The list below is a glossary of frequently used terms in MuseScore as well as their meaning.
The differences between American English and British English are marked with "(AE)" and "(BE)",
respectively.

Acciaccatura
A short →grace note.

Accidental
Accidentals appear in front of notes and shift their pitch.
Accidentals are used to alter the pitch of a note within a piece. The same symbols as in the
→key signature are used, but they are placed before a particular note. Accidentals are for
example →sharps, →flats and →naturals. Accidentals affect all notes on the same →staff
position only for the remainder of the measure in which they occur, but they can be canceled by
another accidental. In notes tied across a →barline, the accidental continues across the
→barline to the tied note, but not to later untied notes on the same →staff position in that
measure.

Anacrusis (BE)
See →Pickup Measure

Appoggiatura
A long →grace note.

Bar (BE)
See →Measure
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Bar Line
Vertical line through a →staff or the →system that separates →measures.

Beam
Notes with a duration of an →eighth or shorter either carry a →flag or a beam. Beams are used
for grouping notes.

BPM
Beats Per Minute is the unit for measuring tempo. See →Metronome mark

Breve
Brevis

A double whole note or breve is a note that has the duration of two whole notes.
Chord

The minimal definition of a chord is a minimum of two different notes played together. Chords
are based on the choices made by a composer between harmonics of one, two or three (and
more) fundamental sounds. E.g. in the chord of C, G is the second harmonic, E the fourth of the
fundamental C. Now in C7, the B flat is the 6th harmonic of C and in C Maj7 B is the second
harmonic of E and the fourth harmonic of G...

Clef
Sign at the beginning of a →staff, used to tell which are the musical notes on the lines and
between the lines.
There are 2 F clefs, 4 C clefs and 2 G clefs: F third, F fourth, C first, C second, C third, C fourth,
G first, G second (known as treble clef too).
G first and F fourth are equivalent.
Clefs are very useful for →transposition.

Concert Pitch
Enables you to switch between concert pitch and transposing pitch (see Concert pitch and
Transposition)

Crotchet (BE)
A crotchet is the British English term for what is called a quarter note in American English. It's a
quarter of the duration of a whole note (semibreve).

Demisemiquaver (BE)
Thirty-second note

Duplet
See →Tuplet

Eighth note
A note whose duration is an eighth of a whole note (semibreve). Same as British →quaver.

Endings
See →Volta

Enharmonic notes
Notes that sound the same pitch but are written differently. Example: G# and Ab are enharmonic
notes.

Flag
See →Beam

Flat
Sign that indicates that the pitch of a note has to be lowered one semitone.

Grace note
Grace notes appear as small notes in front of a normal-sized main note. A short grace note
(→acciaccatura) has a stroke through the stem; a long grace note (→appoggiatura) does not.

Half Note
A note whose duration is half of a whole note (semibreve). Same as British →minim.

Hemidemisemiquaver (BE)
Sixty-fourth note

Key Signature
Set of →sharps or →flats at the beginning of the →staves. It gives an idea about the tonality and
avoids repeating those signs all along the →staff.
A key signature with B flat means F major or D minor tonality.

Koron
An Iranian →accidental which means lower in pitch and it lowers a note by a quarter tone (in
comparison to the →flat which lowers a note by a semitone). It is possible to use this accidental
in a →key signature.
See also →Sori

Longa
A longa is a quadruple whole note.

Ledger Line
Line(s) that are added above or below the staff

Measure (AE)
A segment of time defined by a given number of beats. Dividing music into bars provides regular
reference points to pinpoint locations within a piece of music.

Metronome mark
Metronome marks are usually given by a note length equaling a certain playback speed in
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→BPM. In MuseScore, metronome marks are used in tempo texts.
Minim (BE)

A minim is the British term for a half note. It has half the duration of a whole note
(→semibreve).

Natural
A natural is a sign that cancels a previous alteration on notes of the same pitch.

Operating System
OS

Set of programs written in the aim to set up a computer from a lot of electronic components.
Popular OSes are Microsoft Windows, Mac OS X, and GNU/Linux.
See also →System

Part
Music to be played or sung by one or a group of musicians. In a string quartet, 1st part = Violin
1, 2nd part = Violin 2, 3rd part = Viola, 4th part = Cello.

Pickup Measure (→Anacrusis)
Incomplete first measure of a piece or a section of a piece of music.
See also Create new score: Time Signature... and Measure operations: Exclude from measure
count

Quaver (BE)
The British quaver is what is called an →eighth note in American English. It has an eighth the
duration of a whole note.

Quadruplet
See →Tuplet

Quarter note
A note whose duration is a quarter of a whole note (semibreve). Same as British →crotchet.

Quintuplet
See →Tuplet

Respell Pitches
Tries to guess the right accidentals for the whole score (see Accidentals)

Rest
Interval of silence of a specified duration.

Re-pitch Mode
A way in MuseScore to rewrite a passage with note changes but no rhythm change (see Re-
pitch Mode)

Semibreve (BE)
A semibreve is the British term for a whole note. It lasts a whole measure in 4/4 time.

Semiquaver (BE)
Sixteenth note

Semihemidemisemiquaver (Quasihemidemisemiquaver) (BE)
Hundred twenty-eighth note.

Sextuplet
See →Tuplet

Sharp
Sign that indicates that the pitch of a note has to be raised one semitone.

Slur
→Tie and Slur are two words used to describe a curved line between two or more notes. Slur
means that the notes will be played without attack (legato). Tie is used between two or more
notes on the same pitch to indicate its duration:
Quarter note + Tie + Quarter note = Half note,
Quarter note + Tie + Eighth note = Dotted Quarter note
Quarter note + Tie + Eighth note + Tie + 16th note = Double Dotted Quarter note

Sori
An Iranian →accidental which means higher in pitch and it raises a note by a quarter tone (in
comparison to the sharp which raises a note by a semitone). It is possible to use this accidental
in a →key signature.
See also →Koron

Spatium (plural: Spatia)
Space
Staff Space
sp (abbr./unit)

The distance between two lines of a normal 5-line staff. In MuseScore this unit influences most
size settings. See also Layout and Formatting, Layout / Page Settings

Staff (AE)
Stave (BE)

Group of one to five horizontal lines used to lay on musical signs. In ancient music notation
(before 11th century) the staff/stave may have any number of lines. (The plural of staff is
staves.)

System
System: Set of staves to be read simultaneously in a score.
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See also →Operating System (OS)
Tie

See →Slur
Transposition

A tune can be played in any tonality. There are many reasons to change the tonality of a score:
1. The tune is too low or too high for a singer.
2. The score is written for a C instrument and has to be played by a B Flat one.
3. The score is written for an orchestra and you want to imagine what the horn, the flute and the
clarinet are playing.
4. A darker or a more brilliant sound is desired.
- In the first case all the orchestra will have to transpose, which is very difficult without
professional musicians. MuseScore can do it very easily for you.
- In the second case the musician must play D when a C is written. If the score is written with a
G 2nd Clef, he'll have to think that the staff begins with a C 3rd Clef.
- In the third case the conductor has to transpose all the staves which are not written for C
instruments.
- In all cases the key signature must be mentally changed.
- On some instruments (Horns and Tubas for instance) the musicians transpose using
alternative fingerings.

Triplet (BE)
See →Tuplet

Tuplet
A tuplet divides its next higher note value by a number of notes other than given by the time
signature. For example a →triplet divides the next higher note value into three parts, rather than
two. Tuplets may be: →triplets, →duplets, →quintuplets, and other.

Velocity
The velocity property of a note controls how loudly the note is played. This usage of the term
comes from MIDI synthesizers. On a keyboard instrument, it is the speed with which a key is
pressed that controls its volume. The usual scale for velocity is 0 (silent) to 127 (maximum).

Voice
Polyphonic instruments like Keyboards, Violins, or Drums need to write notes of different
duration at the same time on the same →staff. To write such things each horizontal succession
of notes has to be written on the →staff independently.

Volta
In a repeated section of music, it is common for the last few measures of the section to differ.
Markings called voltas are used to indicate how the section is to be ended each time. These
markings are often referred to simply as →endings.

External links

http://www.robertcarney.net/musical-terms-definitions.htm

Do you have an unanswered question? Post it in the forum.

Volby pro příkazový řádek

This translation is outdated, see the English version for a reference: Command line options

You can launch MuseScore from the command line by typing

mscore [options] [filename] (Mac and Linux)
MuseScore.exe [options] [filename] (Windows)

[options] and [filename] are optional.

See also Revert to factory settings for detailed instructions on how and where to find and execute the
MuseScore executable from the command line on the various supported platforms.

The following options are available

-v
Displays the current version and revision numbers for MuseScore

-d
Starts MuseScore in debug mode

-L
Starts MuseScore in layout debug mode

-s
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Disables the integrated software synthesizer
-m

Disables MIDI input
-a <driver>

Use audio driver: jack, alsa, pulse, portaudio
-n

Starts with the new score wizard regardless of preference setting for start mode
-I

Displays all MIDI input on the console
-O

Displays all MIDI output on the console
-o <filename>

Exports the currently opened file to the specified <filename>. The file type depends on the
filename extension. This option switches to the "converter" mode and avoids any graphical
interface. You can also add a filename before the -o if you want to import and export files from
the command line. For example mscore "My Score.mscz" -o "My Score.pdf"

-r <dpi>
Determines the output resolution for the output to "*.png" files in the converter mode. The default
resolution is 300 dpi.

-T <margin>
Trims exported PNG and SVG images to remove surrounding whitespace around the score. The
specified number of pixels of whitespace will be added as a margin; use 0 for a tightly cropped
image. For SVG, this option works only with single-page scores.

-x <factor>
Scales the score display and other GUI elements by the specified factor, for use with high
resolution displays.

-S <style>
Loads a style file; useful when you convert with the -o option

-p <name>
Execute the named plugin

-F
Use only the standard built-in presets or "factory-settings" and delete preferences. For details,
see Navrácení k továrnímu nastavení

-R
Use only the standard built-in presets or "factory-settings", but do not delete preferences

-i
Load icons from the file system. Useful if you want to edit the MuseScore icons and preview the
changes

-e
Enable experimental features. See e.g. Layer (experimental)

-c <pathname>
Set config path

-t
Enable Test Mode

-M <file>
Specify MIDI import operations file

-w
No web view in Start Center

Qt Toolkit Options

-style= <style>
-style <style>

Determines the style of the GUI application. Possible values are "motif", "windows" and
"platinum". Depending on the platform other styles may be available

-stylesheet= <stylesheet>
-stylesheet <stylesheet>

Sets the application stylesheet. The value of "stylesheet" is a path to a file that contains the
stylesheet

-platform <platformname[:options]>
Specifies the Qt Platform Abstraction (QPA) plugin.
Example: MuseScore.exe -platform windows:fontengine=freetype

See also

Revert to factory settings
Layer (experimental)
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External links

http://doc.qt.io/qt-5/qapplication.html#QApplication
http://doc.qt.io/qt-5/qguiapplication.html#QGuiApplication

Příloha Velikost
midi_import_options.xml 1.73 KB
Do you have an unanswered question? Post it in the forum.
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